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Matrix switch »ControlCenter-Compact«
Matrix switch »ControlCenter-Compact«
A KVM matrix system consists of at least one central module, one console module 
or DynamicWorkplace-CON (DWC) and one computer module.

The central module of the ControlCenter-Compact series is the central device of the 
KVM matrix system. Console modules, DWCs and computer modules, are 
connected to the dynamic ports of a matrix switch.

Operation
The following paragraphs provide you with various possibilities to operate the KVM 
matrix system.

On-screen display

The KVM matrix system can be operated through the system’s on-screen display 
(OSD). This display is provided at console modules.  

The OSD enables you to define additional select keys. The select keys provide the 
possibility to switch between the different computer modules by pressing a key com-
bination on the keyboard of the console module.

NOTE: You can use the KVM matrix system to access a computer module with a 
console module or with a DWC. By accessing the computer connected to the 
computer module, the video image is displayed at the console monitor or the 
DWC monitors. 

You can now operate the accessed computer with console/DWC keyboard and 
console/DWC mouse.

NOTE: The matrix switch is not compatible with devices of the KVM-over-IP 
series.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

NOTE: This manual describes how to operate the matrix switch using the OSD of a 
console module.
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Matrix switch »ControlCenter-Compact«
Configuration
The KVM matrix system can be configured in different ways.

On-screen display

If the logged-in user holds the required rights, they can use the OSD to access or edit 
the matrix system’s configuration settings.

The »Config Panel« web application

The web application offers a graphical user interface to configure the KVM matrix 
switches of the ControlCenter-Compact series. This application can be operated with 
any web browser.

The web application provides an alternative to configuring the matrix switch 
through the OSD at the console modules and can be applied independently from the 
console modules in the network.

Thanks to its enhanced possibilities, the graphical user interface provides the following
easy to operate features:

 clearly-arranged user interface
 easy operation through drag & drop function
 comprehensive computer module administration
 enhanced network functions (netfilter, syslog, …)
 backup and restore function

NOTE: This manual describes how to configure the matrix switches of the 
ControlCenter-Compact series via the OSD of a console module.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

NOTE: The Config Panel manual provides a detailed description of these functions.
ControlCenter-Compact · 2



Getting started
Getting started
This chapter describes the basic operation of the KVM matrix system.

User login at the matrix system
After the console module has been switched on, the KVM matrix system asks you to 
log in.

NOTE: The following chapters of this manual provide a detailed description of the 
functions and the configuration settings.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.
3 · ControlCenter-Compact



Getting started
How to log in at the KVM matrix system:

1. Enter the following data to the login box:      

2. Press Enter to log in and start the OSD.

Terms  
(of use):

Press Enter to display the terms of use.

Accept (of 
terms of use):

Press F8 to accept the terms of use.

Username: Enter your username.

Password: Enter your user account password.

2-Factor Auth 
Code (TOTP):

Enter the 2-Factor Auth Code (TOTP) from 
two-factor authentication.

IMPORTANT: Change the administrator account's default password.

The default access data is:

 Username: Admin
 Password: see login information on the label attached to the controller card

NOTE: The default admin password for devices manufactured before 
November 2020 is 4658.

NOTE: The Terms field and the Accept field only appear if Showing terms of use 
is activated (see Showing terms of use on page 9).

NOTE: The 2-Factor Auth Code (TOTP) field only appears if 2-factor-authentica-
tion is enabled. For detailed information, please refer to the separate manual of 
the web application.

NOTE: If a default action (see page 43) has been activated for the user account, it will 
be executed accordingly after the login.

In this case, restart the OSD (see page 15) to call up the Select menu.
ControlCenter-Compact · 4



Getting started
Configuring the password complexity
You can configure password complexity to comply with your individual password 
guidelines and improve security.

How to configure the minimum password length:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Password Complexity line and press Enter.

5. Select the Min. length line and press Enter.

6. Enter the desired minimum password lenght (Default: 3)

7. Press F2 to save your settings.

IMPORTANT: Changes in the section of password complexity have no effect on 
existing passwords, but are only taken into account when a password is changed 
(see Changing your password on page 10 and Changing the user account password on 
page 83) and a new user account is created (see Creating a new user account on 
page 81). You should therefore configure the password complexity as early as pos-
sible.

IMPORTANT: Changes in the section of password complexity have no effect on user 
authentication with external directory services. The directory services have their 
own configuration options.
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Getting started
How to configure the minimum number of capital letters within a password:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Password Complexity line and press Enter.

5. Select the Min. capital letters line and press Enter.

6. Enter the desired minimum number of capital letters within a password (Default: 0)

7. Press F2 to save your settings.

How to configure the minimum number of lowercases within a password:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Password Complexity line and press Enter.

5. Select the Min. lowercase line and press Enter.

6. Enter the desired minimum number of lowercases within a password (Default: 0)

7. Press F2 to save your settings.

How to configure the minimum number of digits within a password:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Password Complexity line and press Enter.

5. Select the Min. digits line and press Enter.

6. Enter the desired minimum number of digits within a password (Default: 0)

7. Press F2 to save your settings.
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Getting started
How to configure the minimum number of special characters within a password:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Password Complexity line and press Enter.

5. Select the Min. special characters line and press Enter.

6. Enter the desired minimum number of special characters within a password  
(Default: 0)

7. Press F2 to save your settings.

How to configure the minimum number of characters that must be different com-
pared with the previous password when changing the password:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Password Complexity line and press Enter.

5. Select the Min. different line and press Enter.

6. Enter the desired minimum number of characters that must be differnt compared 
with the previous password (Default: 0)

7. Press F2 to save your settings.

NOTE: The minimum number of different characters compared with the previ-
ous password must not be higher than the minimum password length.
7 · ControlCenter-Compact



Getting started
Configuring the login options
To improve security, further configuration options are available in the login options 
area.

You can specify how many failed attempts are accepted when entering a password 
and how long a user is locked out after exceeding the maximum number of failed 
attempts.

How to set the maximum number of failed password entry attempts:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Login options line and press Enter.

5. Select the Max. failed attempts line and press Enter.

6. Enter the desired maximum number of failed attempts when entering the pass-
word (Default: 0 = off/unlimited number of failed attempts, max. 1,000)

7. Press F2 to save your settings.

How to set the locking time if the maximum number of failed password entry 
attempts is exceeded:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Login options line and press Enter.

5. Select the Locking time line and press Enter.

6. Enter the desired locking time in minutes for which a user is locked after exceed-
ing the maximum number of failed password entry attempts (Default: 1 (if max. 
failed attempts > 0), max. 1,440 minutes)

7. Press F2 to save your settings.
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Getting started
Showing terms of use
If the terms of use are displayed, they must be accepted before each (new) device 
access.

How to configure the display of terms of use:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Terms Of Use Config line and press Enter.

5. Select the Terms of use entry and press F8 to select one of the following options:

6. If you selected User in the previous step, the individual terms of use must be 
entered in the next step. Select the Short text... entry and press Enter.

7. Now enter the text that a user is shown before accepting the terms of use 
(example: I have read the terms of use and hereby agree to them). This text field is limited 
to 70 characters.

8. Press F2 to save the text.

9. Press Esc to return to the previous screen.

10.Select the Long text... entry and press Enter.

11.Now enter the desired terms of use. This field is limited to 1,500 characters.

12.Press F2 to save the text.

13.Press Esc and then F2 to save your settings.

off: No terms of use are displayed during log in (default).

User: Individual terms of use are displayed during log in.
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Getting started
Changing your password

How to change the password of your user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Change password entry and press Enter.

4. Enter the new password into the Change own password menu:  

5. Press F2 to save your settings.

Accessing a computer module via OSD

How to access a computer module via OSD:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Use the arrow keys to select the computer module to be accessed.

3. Press Enter.

Current: Enter the current password.

2-Factor Auth 
Code (TOTP):

Enter the 2-Factor Auth Code (TOTP) from 
two-factor authentication.

New: Enter your new password.

Repeat: Repeat your new password.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: It is also possible to access a computer module via select keys (see 
page 50 ff.)

NOTE: No entry is required in this field for users with activated superuser 
rights (see page 93 ff.).

NOTE: The 2-Factor Auth Code (TOTP) field only appears if 2-factor-authenti-
cation is enabled. For detailed information, please refer to the separate 
manual of the web application.
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Getting started
Disconnecting the computer module
The Disconnect function disconnects the active connection to the computer module. 
After this function has been carried out, the Select menu is displayed.

How to disconnect a computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to open the Operation menu.

3. Press D or select the D - Disconnect entry and press Enter.

User logout at the KVM matrix system
Use the User logout function to log out of the KVM matrix system. If the logout was 
successful, the Login window opens.

How to log out of the KVM matrix system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to open the Operation menu.

3. Press E or select the E - User logout entry and press Enter.

NOTE: After the Disconnect function has been carried out, you are still logged in at 
the matrix system.

Use the User logout function (see below) to log out of the system.

ADVICE: After the OSD has been called up, you can activate the Disconnect
function by pressing Ctrl+D.

IMPORTANT: Always use the User logout function of the matrix system to protect 
the console module and the KVM matrix system against unauthorised access.

ADVICE: After the OSD has been called up, you can activate the User logout
function by pressing Ctrl+E. 
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Getting started
Starting the functions of the Operation menu 
via hotkeys
The Select menu is usually displayed after the OSD has been called up. To operate 
the system, press F9 to call up the Operation menu.

Through the use of hotkeys the functions of the Operation menu can also be carried 
out within the Select menu.

How to access a function in the Operation menu by using a hotkey:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press one of the hotkeys listed in the table below to call up the function:

Ctrl+A: Automatic switching of all computer modules (Autoscan)

Ctrl+B: Automatic switching of all activated computer modules (Autoskip)

Ctrl+C: Manual switching of the computer modules (Stepscan)

Ctrl+D: Disconnects the computer module (Disconnect)

Ctrl+E: User logout

Ctrl+G: Accesses the previously accessed computer module 
(Return to last target)

Ctrl+H: Shows an additional column in the list field of the Select menu 
(Target info) 

Pressing the key combination enables you to switch between the 
following options:

 off: hides additional column
 id: displays the physical ID of the computer modules
 select keys: displays the select keys of the computer modules
 comment: displays the comments of the computer modules

Ctrl+I: Switches the power outlets of a connected and configured power 
switch (Target power)

Pressing the key combination enables you to switch between the 
following options:

 off: switches off power outlets
 on: switches on power outlets

Ctrl+K: Show comment of selected computer module.

ADVICE: Press F5 to switch to the comment editor.

Ctrl+S: Synchronize the switching states.

NOTE: Detailed information on the Sync switching function can be 
found in the web application manual.
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Getting started
Ctrl+U If you grouped multiple channels (see page 193 f.), you can hold 
the USB signal (USB connection) on the currently accessed com-
puter.

 Pin: The hold function is enabled. If you access another computer, 
the KVM signals are switched to that computer. The USB signal 
is held on the computer you accessed first.
The Select menu shows the name of the computer that holds the 
USB signal.

 Unpin: The hold function is disabled. The USB signal of the  
currently active computer is accessed.

Ctrl+W If the Wake-on-LAN function is configured (see page 120), you can 
use this hotkey to send the WoL command to the defined computer.

Ctrl+X Select what information you want to show on the Select menu:

 select: The select menu shows the computer modules connected 
to the matrix system.

 script: The select menu shows the scripts stored in the matrix 
system.
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The On-Screen Display (OSD)
The On-Screen Display (OSD)
The OSD allows you to operate and configure the KVM matrix system. The OSD is 
provided at the console modules.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.
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The On-Screen Display (OSD)
Calling the OSD at a console module
The OSD can be activated with a configured key combination.

How to start the OSD:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

The general OSD structure

The OSD menu is divided into three main sections:

Menu title 
Sort Alph+on          Show All 
Search .......................

Computer modules ...
Console ...
Console type Standard

ESC      F8:Toggle     F2:Save

Header  The header shows the title of the current menu.

Some menus additionally provide a Sort and a Search function as 
well as a View filter (see page 20 ff.). Press the Tab key to move the 
cursor from the list field  to the header .

List field  The list field shows all menu entries.

The menu entries are divided into two categories:

 Menu items with submenu:
These entries are displayed in the right-hand column with three 
dots (…). Select the entry with the arrow keys, and press Enter to 
open the submenu.

 Menu items without submenu:
The current setting is displayed behind the menu entry and can 
be changed directly.

Footer  The footer shows the most important keys for operating the menu 
and, if applicable, further information regarding the menu.
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The On-Screen Display (OSD)
Colour-coded computer module names

The list field lists all computer modules. If the computer module is supplied with 
power and connected to the matrix system, and if a computer is connected to the 
computer module and switched on, the name of the computer module is displayed 
in green.

If the computer module is supplied with power and connected to the matrix system, 
but not connected to the computer or the computer connected to the computer mod-
ule is switched off, the name is displayed in yellow. 

If the computer module is disconnected from the KVM matrix system or is not sup-
plied with power, the name is displayed in red.

Displaying the status condition

The status condition of the computer modules is displayed in the left column of the 
Select menu:

 An arrow () marks the currently accessed computer module.
 If one or more users are currently accessing the computer module, the number of 

accessing users is displayed in the column.
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The On-Screen Display (OSD)
Operating the OSD via keyboard or mouse

Keyboard operation

The OSD is mainly operated by keyboard. The table below shows a list of frequently 
used keys:

Arrow keys: Press the arrow keys Up and Down (in some menus also Left and Right) 
to switch between the different menu entries.

Enter key: This key is often used to confirm entries (e. g. in the login box) or to 
call a submenu.

Esc: This key closes the currently displayed menu and shows the superior 
menu.

A message informs you if you changed your entries but forgot to 
save them.

Tab key: Use this key to move the cursor from one menu entry to the next (or 
vice versa). 

In menu masks, which contain the sort-and-search function or the 
view filter, the cursor can be moved to the header by pressing this key.

F2: Press this key to save your entries.

The currently displayed menu closes after the data was saved. 
Afterwards, the toplevel menu is shown.

F8: Press this key to switch between the different options of a menu entry.

F9: Press this key on the top menu level to call the Operation menu.

F10: Press this key on the top menu level to call the Personal Profile menu.

F11: Press this key on the top menu level to call the Configuration menu.

F12: Press this key on the top menu level to call the Information menu.
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The On-Screen Display (OSD)
Mouse operation

As an alternative to operating the OSD by keyboard, you can use the mouse to execute 
the following functions:

Mouse movement »Up«: This mouse movement moves the cursor upwards
between the different menu entries in the list field.

Mouse movement »Down«: This mouse movement moves the cursor downwards
between the different menu entries in the list field.

Left mouse key: This key is often used to confirm entries (e. g. in the 
login box) or call a submenu.

Right mouse key: The currently displayed menu is closed after your 
settings are saved. Afterwards, the toplevel menu 
is shown.

A message informs you if you changed your entries 
but forgot to save them.

NOTE: The OSD can only be called with the configured key combination (Ctrl+Num).

If a Microsoft »IntelliMouse Explorer« or another compatible mouse with five keys 
is connected to the user console, you can call the OSD through the mouse keys four 
and five, which are located at the side of the mouse (see page 33).
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The On-Screen Display (OSD)
OSD functions

Changing the sort criteria of the list entries

In the default settings, the list entries are sorted alphabetically in ascending order 
(Alph+).

Targets are listed according to their operating status. Active devices are displayed at 
first, followed by all inactive devices. Both groups are sorted in ascending order 
(Alph+on).

You can also activate another sort criterion or reverse the sort order.

How to change the sort criteria and/or sort order:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press the Tab key to select the Sort field in the header.

3. Press F8 to select the desired sort criterion:

Alph+: The names of the list entries are sorted alphabetically in ascending
order.

Alph+on: Active devices are displayed at first, followed by all inactive 
devices. Both groups are sorted in ascending order. 

This option is only available in the device list.

Alph-: The names of the list entries are sorted alphabetically in descending
order.

Alph-on: Active devices are displayed at first, followed by all inactive 
devices. Both groups are sorted in descending order .

This option is only available in the device list.

ID: The names of the list entries are sorted in ascending order accord-
ing to the physical device ID.

This option is only available in lists that include computer modules.

Comment+: The comments are sorted alphabetically in ascending order.

This option is only available in lists that include computer modules.

Comment-: The comments are sorted alphabetically in descending order.

This option is only available in lists that include computer modules.
19 · ControlCenter-Compact



The On-Screen Display (OSD)
Search function

Some menus (e.g. the Select menu or the menu to choose a select key set) provide a 
search function to enable the fast selection of the desired entry in the list field.

How to search a particular entry with a known name:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press the Tab key to select the list field.

3. Enter the name of the entry you want to search. You can also enter the first let-
ters of the name to enable a clear allocation. The entered characters are displayed 
in the Search field.

How to search a particular entry with a known device ID:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Choose the sort criteria ID (see Changing the sort criteria of the list entries on page 19).

3. Press the Tab key to select the list field.

4. Enter the device ID of the entry you want to search. The entered characters are 
displayed in the Search field.

NOTE: After every entered character, the first entry this character does apply to is 
marked in the list field.

Placeholders are not supported. 

NOTE: After every entered character, the first entry this character does apply to is 
marked in the list field.

Placeholders are not supported. 
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The On-Screen Display (OSD)
How to search a particular entry with a known name:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Choose the sort criteria Comment+ or Comment- (see Changing the sort criteria of the list 
entries on page 19).

3. Press the Tab key to select the list field.

4. Enter the comment of the entry you want to search. You can also enter the first 
letters of the comment to enable a clear allocation. The entered characters are 
displayed in the Search field.

Limiting the entries using the view filter

The Show field enables you to limit the list of entries in the list field of some menus:

The Select menu lists all computer modules by default. The view filter can limit the 
computer module list of a particular view group (marked as folder in the web applica-
tion).

How to change the view filter of the entries to be displayed:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press the Tab key to move the cursor to the Show field in the menu header.

3. Press F8 to select the desired view filter.

NOTE: After every entered character, the first entry this character does apply to is 
marked in the list field.

Placeholders are not supported. 

ADVICE: Further information regarding the administration of the computer modules 
of a view filter are provided in the chapter Administrating view filters on page 100.

NOTE: If the Config Panel web application is used to create and administrate groups 
(folders) for the view filter, any number of folders can be added to the superior 
folder.

The OSD only shows the superior view filter. The included computer modules of 
inferior locations are automatically listed.

ADVICE: You can select the ALL view filter directly by pressing Ctrl+A.
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The On-Screen Display (OSD)
Showing an additional column in the Select menu

The Computer module info function enables you to display an additional info column 
in the Select menu list field. The column can display the physical ID or the select 
keys of the computer module.

How to display an additional info column in the Select menu:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to call the Operation menu.

3. Press H (repeatedly) or select the H - Computer module info entry and press F8 (repeat-
edly) to choose one of the following options:

off: hide additional column

id: display the physical ID of the computer modules

select keys: show the select keys of the computer modules

comment: display the comments of the computer modules

ADVICE: After the OSD has been called, activate the Computer module info function 
in the Select menu by pressing Ctrl+H.
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The On-Screen Display (OSD)
Configuration
Many of the OSD’s basic functions and features can be adjusted to the user’s 
demands.

You can change various settings e.g. define the hotkey and adjust the OSD’s position
and font size.

All adjustable settings are described on the following pages. 

Changing the hotkey to call the OSD

The hotkey to call the OSD is used at the console modules within the matrix system. 
This hotkey enables you to open the OSD in order to operate and configure the system.

The hotkey consists of at least one hotkey modifier key and an additional hotkey, 
which you can select.

Both the Ctrl hotkey modifier key and the Num hotkey can be changed.

How to change the hotkey to call the OSD:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Hotkey entry and press Enter.

5. Use the arrow keys for selecting at least one of the listed hotkey modifiers in the 
Modifier entry. Afterwards, press F8.

NOTE: In the default, the hotkey Ctrl+Num is preset.

ADVICE: On a DWC, the WindowMenu can be opened by using the hotkey.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift Shift key
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The On-Screen Display (OSD)
6. Press F8 to select a hotkey in the Key entry. The OSD can be called up by pressing 
the hotkey and the selected hotkey modifier(s) at the same time.

7. Press F2 to save your settings.

Num: Num key

Pause: Pause key

Insert: Insert key

Delete: Delete key

Home: Home key

End: End key

PgUp Page Up key

PgDn Page Down key

Space Space key
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The On-Screen Display (OSD)
Opening the OSD via double keypress

Instead of opening the OSD with the key combination Hotkey+Num, you can define 
a key to press twice to open the OSD.

How to define the key to open the OSD via double keypress:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the OSD via 2x keypress entry and press F8 to select the desired option:

5. Press F2 to save your settings.

ADVICE: On a DWC, the WindowMenu can be opened by using this key.

off: Open OSD via double keypress disabled (default)

Ctrl: Open OSD via double keypress of Ctrl key

Alt: Open OSD via double keypress of Alt key

Alt Gr: Open OSD via double keypress of Alt Gr key

Win: Open OSD via double keypress of Win key

Shift: Open OSD via double keypress of Shift key

Print: Open OSD via double keypress of Print key

Cursor left: Open OSD via double keypress of Cursor left key

Cursor right: Open OSD via double keypress of Cursor right key

Cursor up: Open OSD via double keypress of Cursor up key

Cursor down: Open OSD via double keypress of Cursor down key
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The On-Screen Display (OSD)
Automatic closing of the OSD after inactivity

If desired, you can set the OSD to close automatically after a period of inactivity.

The period of inactivity can be defined by entering a value between 5 and 99 seconds.

How to change the period of inactivity after which the OSD closes:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Under Close OSD when idle for [s] you can define a time span between 5 and 99  
seconds.

4. Click on OK to save your settings.

Adjusting the OSD transparency

In the OSD default settings, the screen content under the OSD is semi-visible. The 
screen content shines through the part that is covered by the OSD.

You can either adjust or turn off the OSD transparency in the personal profile of a user.

How to adjust the OSD transperency:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the OSD transparency entry and press F8 (repeatedly) to select one of the  
following options:

4. Press F2 to save the changes.

NOTE: To disable the function, enter the value 0.

high: Screen content almost completely visible

average: Screen content semi-visible (default)

low: Screen content slightly visible

off: Screen content is covered
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Adjusting the information display

When switching to a computer module, a temporary information display (5 seconds) 
opens. The display informs you about the console name, the name of the currently 
accessed computer module and provides further information.

The information display can also be permanently displayed or deactivated. The selected 
setting is assigned to your user account and stored in your Personal Profile.

How to change the general settings of the information display:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Display entry and press F8 (repeatedly) to select one of the following 
options:

4. Press F2 to save the changes.

How to change the general settings of the information display for computer modules
with view right:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the View only display entry and press F8 (repeatedly) to select one of the  
following options:

4. Press F2 to save the changes.

NOTE: You can set the information display separately for computer modules with 
view rights and all other computer modules.

ADVICE: When active, the temporary information can be recalled by pressing 
Ctrl+Caps Lock.

temp: show information display (five seconds)

perm: permanent information display

off: deactivate information display

display: Using the general setting of the information display (see above)

temp: show information display (five seconds)

perm: permanent information display

off: deactivate information display
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How to change the colour of the information display:

By default, information displays (like when accessing a computer module) are showing 
light green. In their personal profiles, users can change the colour of the information 
display.

The following colours are supported:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the OSD color entry and press F8 (repeatedly) to select the desired colour.

4. Press F2 to save the changes.

black dark red

green dark yellow

dark blue purple

dark turquoise silver

light green yellow

blue fuchsia

light turquoise white
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Defining a standard view filter

After the user login, the Select menu (see page 36) is displayed. The default setting 
of the Select menu displays all computer modules. By applying the view filter (see 
page 29), the displayed computer modules can be filtered.

Use the Default view filter setting to activate a certain view filter directly after accessing 
the Select menu.

How to select a standard view filter for the Select menu:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Default location entry and press F8 (repeatedly) to select the desired setting.

4. Press F2 to save your changes.

NOTE: The preset view filter is applied directly after the OSD has been called 
and after the user has logged in to the matrix system.

The use of a view filter (see page 21) allows you to change the default and 
therefore activate another filter.

ADVICE: On a DWC, the standard view filter can be used as well.

All: All computer modules are displayed.

Last: The view filter that was used by the last user is applied when the 
Select menu is called.

Selection of 
a folder:

The view filter of the selected group is applied if the Select menu 
is called.

IMPORTANT: If the LAST option has been selected and two users are using one user 
account at the same time, the view filter of the previously active person is stored.

ADVICE: Press Ctrl+A to select this view filter directly.
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The On-Screen Display (OSD)
Changing the display‘s position

When accessing a computer module, the information display of the matrix system 
e.g. provides you with the name of the accessed computer module and the name of 
the console module.

By default, the information display is located in the left upper corner at the console 
monitor. You can adjust the display’s position according to your wishes.

Your individual setting is assigned to your user account and stored in your Personal 
Profile.

How to change the display position:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Set display position entry and press Enter.

4. The menu on the right-hand side opens at the display 
position.

5. Use the arrow keys or the mouse to move the menu to 
the desired position.

6. Press F2 to save your settings or press Esc to cancel.

NOTE: Press Ctrl+D to reset the display’s position.

+
Display position
F2: Save
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Changing the OSD position

By default, the information is located in the centre of the console monitor. You can 
adjust the display’s position according to your wishes.

The selected setting is assigned to your user account and stored in your Personal Profile.

How to change the OSD position:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Set menu position entry and press Enter.

4. Use the arrow keys or the mouse to move the menu to the desired position.

5. Press F2 to save your settings or press Esc to cancel the process.

Changing the OSD theme

You can choose between two diferent themes of the OSD.

The selected setting is assigned to your user account and stored in your Personal Profile.

How to change the OSD theme:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Default theme entry and press F8 (repeatedly) to select the desired setting:

4. Press F2 to save your settings or press Esc to cancel the process.

NOTE: Press Ctrl+D to reset the OSD position.

modern: Use of the modern theme (default)

classic: Use of the classic theme
31 · ControlCenter-Compact



The On-Screen Display (OSD)
Selecting a keyboard layout for OSD entries

If the characters entered on the keyboard of the console module deviate from the 
characters displayed on the monitor, the selected keyboard layout does not fit the 
keyboard.

In this case, please ascertain which keyboard layout does apply to the connected 
keyboard and select the layout in the settings of the console module.

How to select the keyboard layout for the console module keyboard:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the OSD key. layout entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

german: Germany

english US: USA

english UK: Great Britain

french: France

spanish: Spain

lat. americ: Latin America

portuguese: Portugal

swedish: Sweden

swiss-french: Switzerland

danish: Denmark
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Operating the OSD by mouse

In the default settings of the matrix system, the OSD can only be called with the 
configured key combination.

If a Microsoft »IntelliMouse Explorer« or another compatible mouse with five keys is 
connected to the console module, you can call the OSD through the mouse keys four 
and five at the side of the mouse.

How to (de)activate the mouse support to operate the OSD:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the OSD by mouse entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

(De)activating the OSD

This function defines if the users at the console module are enabled to activate the 
OSD or if they are only allowed to switch via select keys.

How to (de)activate the OSD at the console module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to (de)activate and press F5.

5. Select the OSD blocked entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

yes: calls the OSD via mouse keys 4 and 5 of a compatible mouse

no: deactivates the possibility to call the OSD by mouse

yes: OSD blocked

no: OSD available

full: Starting the OSD and displaying of info messages blocked.
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The On-Screen Display (OSD)
Adjusting the OSD resolution

In the defaults of the matrix switch the OSD is displayed on the console monitor in 
a resolution of 1024  × 768 pixels if the monitor does support this resolution. If the 
monitor does not support this resolution, a resolution of 640 × 480 pixels is used.

You can also set the OSD resolution for the entire system (see table below). Adjusting 
the resolution for the entire system includes all console modules. However, you can also 
individually set the OSD resolution for each console module.

How to adjust the OSD resolution of the entire system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the OSD resolution entry and press F8 to select one of the following options:

5. Press F2 to save your settings.

auto: If supported by the monitor, the OSD is displayed in a 
resolution of 1024 × 768 pixels.

If the monitor does not support this resolution, a resolution 
of  640 × 480 pixels is used. (default).

640×480/60: OSD is displayed in a resolution of 640 × 480 pixels

720×400/70: OSD is displayed in a resolution of 720 × 400 pixels

1024×768/60: OSD is displayed in a resolution of 1024 × 768 pixels
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The On-Screen Display (OSD)
How to adjust the OSD resolution of a particular console module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to configure and press F5.

5. Select the OSD resolution entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

system: Use systemwide (see above) setting (default).

auto: If supported by the monitor, the OSD is displayed in a 
resolution of 1024 × 768 pixels.

If the monitor does not support this resolution, a resolution 
of  640 × 480 pixels is used. (default).

640×480/60: OSD is displayed in a resolution of 640 × 480 pixels

720×400/70: OSD is displayed in a resolution of 720 × 400 pixels

1024×768/60: OSD is displayed in a resolution of 1024 × 768 pixels
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Overview of the menus and functions
Overview of the menus and functions

The following pages show the main menus of the OSD.

Select menu
The Select menu is usually displayed after the OSD has been called.

The computer modules of the matrix system are displayed in this menu:

The chapter Accessing computer modules (basic functions) on page 41 ff. describes how to 
access the computer module via console module.

Both the Search and Sort function as well as the view filter can be used to limit the dis-
played computer modules. Further information regarding these functions are provided 
on page 20 ff.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

Select 
Sort Alph+on Show ALL
Search .......................

 CPU-001
2CPU-002
1CPU-003

F9: Operation F10:Pers.Profile 
F11:Config    F12:Info
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Overview of the menus and functions
Operation menu
After you called the OSD, press F9 to open the Operation menu. This menu lists all 
functions of the KVM matrix system that the user can carry out directly:

Function Description

A – Autoscan page 71

B – Autoskip page 72

C – Stepscan page 74

D – Disconnect page 11

E – User logout page 11

G – Return to last computer module page 42

H – Computer module info page 22

I – Device power page 12

K – Comment page 12

S – Send sync command page 12

U – USB Connection page 13

W – Wake on LAN page 120

X – Selection dialog page 59
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Overview of the menus and functions
Personal Profile menu
After you called the OSD, press F10 to open the Personal Profile menu. 
The menu settings only apply for the user whose name is displayed in the right corner.

This menu lists the settings of the matrix system, which can be individually defined 
for the user:

Function Description

Language page 196

Display page 27

View only display page 27

Default theme page 31

OSD transparency page 26

OSD color page 28

TS frame settings page 283

TS frame time (s) page 283

TS frame color page 283

TS frame transparency page 283

TS frame width page 283

Close OSD when idle for (s) page 26

Scantime page 72

Step-Keys page 75

Multi-user display page 122

Def. selection dialog page 59

Sel. dialog replace sens. page 59

Default view filter page 29

Restore session page 47

Default execution page 43

Default computer module page 43

Def. script page 44

DynamicWorkplace-CON page 174

Scanmode Set page 75

Select-Key Set page 53

Script-Key Set page 63

Push-Get-Key Set page 220
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Overview of the menus and functions
Configuration menu
After you called the OSD, press F11 to open the Configuration menu. This menu 
enables you to configure the settings of the devices connected to KVM the matrix 
system as well as all user settings.

Set display position page 30

Set menu position page 31

Change password page 83

Function Description

User page 81

User group page 88

Computer modules page 103

Computer module groups page 97

View filter page 100

EDID page 186

Scripting function page 57

Console page 138

DynamicWorkplace-CONs (DWC) page 160

Cascade page 188

System page 195

Network page 201

Tradeswitch function page 272

Function Description
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Overview of the menus and functions
Information menu
After you called the OSD, press F12 to open the Information menu. This menu provides 
information on the different devices and versions of the KVM matrix system.

Function Description

Firmware information page 210

Dynamic port informatio page 210

Feature information page 215

Hotkey information page 210

Hardware infomation page 210

Console status page 155
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Accessing computer modules (basic functions)
Accessing computer modules 
(basic functions)
Switching video, keyboard, mouse, and audio signals to a console module allows 
you to operate the computer connected to the computer module.

This chapter describes how to access the computer modules by using the OSD. 
Information on how to access the computer modules via select keys are provided on 
page 50 ff.

Accessing a computer module via OSD
The OSD of the matrix system allows you to access a computer module via a console 
module.

How to access a computer module via OSD:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Use the arrow keys to select the computer module you want to access.

3. Press Enter.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.

NOTE: A computer module can also be accessed using select keys. 
Further information regarding this topic are provided on page 50.
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Accessing computer modules (basic functions)
Returning to the previously accessed computer 
module via OSD
The Return to last computer module function allows you to switch from the currently 
accessed computer module to the previously accessed computer module.

How to return to the last accessed computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to call the Operation menu.

3. Press G or select the G - Return to last computer module entry and press Enter.

Disconnecting the computer module via OSD
The Disconnect function disconnects the current connection to the computer module. 
After the function has been carried out, the Select menu is displayed.

How to disconnect the connection to a computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to call the Operation menu.

3. Press D or select the D - Disconnect entry and press Enter.

NOTE: This function does not apply if you have only worked on the 
currently accessing computer module since your login.

ADVICE: After the OSD has been called, you are enabled to activate the 
Return to last computer module function in the Select menu by pressing Ctrl+G.

NOTE: After the Disconnect function has been carried out, you are still logged 
in at the matrix system.

Use the User logout function described on page 11 to log out of the system.

ADVICE: After the OSD has been called, you are enabled to activate the 
Disconnect function by pressing Ctrl+D.
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Accessing computer modules (basic functions)
Enhanced functions

Configuring default execution after a user logon

After the user has logged on to a console module, the OSD usually opens on the 
screen of said console module.

The configuration setting Default execution allows you to define a computer module that 
is automatically accessed after the user logs on, or a script that runs automatically.

How to select a default computer module that is automatically accessed after a 
user logon:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Default execution entry and press F8 (repeatedly) to select Computer module.

4. Select the Default computer module entry and press Enter.

The Default computer module menu opens. If already defined, the footer displays the 
currently selected computer module (Current).

5. Select the computer module to be accessed directly after the login.

6. Press F8 to activate the selection. The active computer module is marked  
with an arrow ().

7. Press F2 to save your changes.

IMPORTANT: If a Restore session function (TS workplace or computer module) is 
activated, the user´s configured default execution is ignored.

To configure a default execution, the Restore session function must be switched off 
(see page 48 f.).

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.
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Accessing computer modules (basic functions)
How to select a default script or a script group that is automatically executed 
after a user logon:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Default execution entry and press F8 (repeatedly) to select script.

4. Select the Default script entry and press Enter.

The Default Script menu opens. If already defined, the footer displays the currently 
selected script (Current).

5. Select the script to be executed directly after the login.

6. Press F8 to activate the selection. The active script is marked with an arrow ().

7. Press F2 to save your changes.

How to disable the configured default execution:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Default execution entry and press F8 (repeatedly) to select off.

4. Press F2 to save your changes.

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.
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Accessing computer modules (basic functions)
Defining a DWC default execution

A standard preset or a standard script/script group can be assigned to a user profile. 
The default execution takes place when the corresponding user logs on to the DWC.

How to select a default preset that is automatically executed after a user logon:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC default exec. entry and press F8 (repeatedly) to select preset.

5. Select the DWC default preset entry and press Enter.

The DWC default preset menu opens. If already defined, the footer displays the 
currently selected preset (Current).

6. Select the preset to be accessed directly after the login.

7. Press F8 to activate the selection. The active preset is marked with an arrow ().

8. Press F2 to save your changes.

IMPORTANT: If a Restore session function (TS workplace or computer module) is 
activated, the user´s configured DWC default execution is ignored.

To configure a DWC default execution, the Restore session function must be switched 
off (see page 48 f.).

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.
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Accessing computer modules (basic functions)
How to select a default script or a script group that is automatically executed 
after a user logon on a DWC:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC default exec. entry and press F8 (repeatedly) to select script.

5. Press F2 to save your changes.

6. Select the Def. script entry and press Enter.

The Default Script menu opens. If already defined, the footer displays the currently 
selected script (Current).

7. Select the script to be executed directly after the login.

8. Press F8 to activate the selection. The active script is marked with an arrow ().

9. Press F2 to save your changes.

How to disable the configured DWC default execution:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC default exec. entry and press F8 (repeatedly) to select off.

5. Press F2 to save your changes.

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.
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Accessing computer modules (basic functions)
Returning to the computer modules that were last accessed in 
the previous session

Enable the Restore session function and Computer module option in the personal profile to 
remember the computer module or computer modules at a DWC the user last accessed 
even after the logout. After the next login, the user automatically accesses the last 
computer module or computer modules at a DWC.

How to enable automatic access to the last accessed computer modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Restore session entry and press F8 (repeatedly) to select the Computer 
module option.

4. Press F2 to save your settings.

NOTE: Turning off the console module or DWC on which the user is logged in is 
treated like a logout.

IMPORTANT: When enabling the Restore session function, the user’s configured 
default execution (see page 43 f.) and DWC default execution (see page 45 f.) are 
ignored.
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Accessing computer modules (basic functions)
Restore the last FreeSeating session

Enable the Restore session function and TS workplace option in the personal profile to save 
the connection status of FreeSeating members. With this function, the last connection 
state can be restored when logging in again at the same workplace or another workplace 
that is set up and configured accordingly. By logging in or logging out to the Trade-
switch leader, all other FreeSeating members are automatically logged in with the same 
user (if no other user is logged in yet) or logged out (if the same user is logged in).

How to enable the restore last FreeSeating session function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Restore session entry and press F8 (repeatedly) to select the  
TS workplace option.

4. Press F2 to save your settings.

Deactivation of the Restore session function

How to disable the Restore session function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Restore session entry and press F8 (repeatedly) to select the off option.

4. Press F2 to save your settings.

IMPORTANT: The prerequisite for this is the activation and configuration of the 
premium Tradeswitch function (see page 272 f.).

NOTE: Turning off the console module or DWC on which the user is logged in is 
treated like a logout.

IMPORTANT: When enabling the Restore session function, the user’s configured 
default execution (see page 43 f.) and DWC default execution (see page 45 f.) are 
ignored.
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Accessing computer modules (basic functions)
Messages when accessing a computer module

No route to computer module available

For every time a console module simultaneously accesses a computer module con-
nected to the follower matrix switch, a data link is established from the leader to the 
follower matrix switch.

In case all available data links are occupied, the message No route to computer module 
available is displayed when you try to access the computer module. As soon as a data 
link is available, the desired connection can be established.

Unknown route to computer module

This message is shown when you try to access a computer module connected to a 
follower matrix switch to which no connection can be established.

Check if the follower matrix switch is switched on and properly connected to the 
leader matrix switch.

Computer module not available

This message is shown when the computer module to which the desired computer 
was connected has been removed from the system.

Ask the administrator of the matrix system if the desired computer has been connected 
to another computer module or if it has been removed from the system.

IMPORTANT: The number of possible data links to the follower matrix switch 
depends on how many CPU ports of the leader matrix switch are connected to the 
Console ports of the follower matrix switch.
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Accessing computer modules via select keys
Accessing computer modules via 
select keys
After the select key modifier(s) and a select key set have been adjusted and a select 
key set has been activated in the user account, the computer modules can be 
accessed with key combinations.

Accessing computer modules using select keys
Calling the OSD is not required when accessing the computer modules using select 
keys. The computer modules can be accessed faster via select keys.

How to access a computer module via select keys:

1. Press the select key modifier(s) that have been adjusted in the matrix system and 
the select keys assigned to the computer module.

Further information:
 Changing the select key modifier and the valid keys on page 51
 Administrating select key sets on page 53
 Assigning a select key set to a user account on page 56

ADVICE: On a DWC, the computer modules can also be accessed via select keys.

EXAMPLE: 

 Select key modifiers: Alt Gr+Shift
 Select keys for computer module: S

Press Alt Gr+Shift and the select key S. As soon the keys are released, 
the switching to the computer module takes place.
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Accessing computer modules via select keys
Changing the select key modifier and the valid keys
The select keys enable fast access to a particular computer module by pressing a key 
combination. For this, select key sets can be created in the matrix system.

Both the select key modifier and a select key set define the key combination to be 
pressed to access a particular computer module.

You can also define valid keys for the select keys.

How to change the select key modifier or the valid keys:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select System entry and press Enter.

4. Select the Select key entry and press Enter.

5. Use the arrow keys to select at least one of the select key modifiers listed in the 
Modifier entry. Afterwards, press F8.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift Shift key
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Accessing computer modules via select keys
6. Select the Valid keys entry and press F8 to select one of the following options:

7. Press F2 to save your settings.

Num: only numerical keys are interpreted as select keys when pressed in 
combination with the select key modifier

Alph: only alphabetic keys are interpreted as select keys when pressed in 
combination with the select key modifier

AlphNum: alphabetical and numerical keys are interpreted as select keys when 
pressed in combination with the select key modifier

IMPORTANT: Both the selected valid keys and the select key modifier are 
no longer provided as key combinations to the operating system and the 
applications on the computer.
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Accessing computer modules via select keys
Administrating select key sets
The KVM matrix system enables you to create 20 global select key sets or ten individual 
select key sets for each user. 

Within the select key sets, you can define the select key sets for the computer modules 
you wish to access.

Creating a select key set

How to create a select key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Select key set entry and press Enter.

4. Press F3 and enter the following data in the Add select key set menu:  

5. Press F2 to save your inputs and to create the select key sets.

NOTE: The global select key sets are displayed in the Personal Profile menu of all 
users of the matrix system.

Name: Enter the new select key set name and press Enter.

Global: Select yes by pressing F8 if you want the select key set in the 
Personal Profile menu to be available for all users of the system.

default: no

Return to last 
computer 
module:

Add, change or delete the special select key for quick access to 
the last activated computer module.

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).
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Accessing computer modules via select keys
Changing a select key set

How to change the name and/or Global setting of a select key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Select key set entry and press Enter.

4. Select the select key set whose setting you want to change.

5. Press F5 to change the following data in the Edit select key set menu: 

6. Press F2 to save your settings.

Name: Enter the new select key set name and press Enter.

Global: Select yes by pressing F8 if you want the select key set in the 
Personal Profile menu to be available for all users of the system.

default: no

Return to last 
computer 
module:

Add, change or delete the special select key for quick access to 
the last activated computer module.

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).
ControlCenter-Compact · 54



Accessing computer modules via select keys
Defining the select keys for the computer modules

How to define the select keys for computer modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu

3. Select the Select key set entry and press Enter.

4. Choose a select key set and press F5.

5. Select the Members entry and press Enter.

The Assign select key set dialogue opens. The left column displays the name of the 
computer module and the right column shows the assigned select key(s).

6. Select the computer module you want to assign a select key to or whose select 
key you want to change.

7. Press F5 and enter the desired select key.

8. If you want to create or change the select keys for other computer modules, 
repeat steps 6 and 7.

9. Press F2 to save your settings.

NOTE: Global select key sets can only be edited by users with activated 
Superuser right (see page 93).

Without this right, only the select keys, which are assigned to the computer 
modules, can be viewed. 

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.

NOTE: The chapter Changing the select key modifiers and the valid keys provides 
information on how to use valid keys as select key set.
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Accessing computer modules via select keys
Assigning a select key set to a user account

By assigning a select key set to a user account, the select keys defined in the set are 
interpreted and the particular computer module is accessed.

How to assign a select key set to a user account or cancel the existing assignment:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Select key set entry and press Enter.

4. Select the desired select key set.

5. Press F8 to (de)activate the assignment.

6. Press F2 to save your settings.

Deleting a select key set

How to delete a select key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Select key set entry and press Enter.

4. Select the select key set you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: An assigned select key set is marked with an arrow ().

NOTE: Only users with the Superuser right (see page 93) are allowed to delete a global 
select key set.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Scripting function
Scripting function

The scripting function lets users store the switching condition of one or multiple 
consoles or of the entire system.

The switching conditions are stored in a script. The scripts stored in the matrix system 
can be accessed and executed via OSD provided that the console is assigned with the 
respective rights.

Users can create their own scripts and execute them. Global scripts can be executed 
by users without the Superuser right only if these users are assigned with Scripting 
rights for the global script.

IMPORTANT: Using the scripting function requires the purchase and activation 
of the premium function IP-Control-API.

ADVICE: You cannot save the switching condition in a script via the Window-
Manager on a DWC.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

NOTE: You can create up to 1024 scripts within a matrix system.

ADVICE: The scripts stored in the matrix system can also be executed via the 
window menu of a DWC.
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Scripting function
Executing scripts
The scripts stored in the matrix system can be executed via the OSD of the KVM 
matrix system.

In the defaults, after accessing the OSD at a console module, you can select a computer 
via the Select menu.

If desired, you can use your personal profile to define that the Script menu is shown 
directly after accessing the OSD (see page 59).

You can also use the mouse to switch between Select menu and Script menu (see 
page 59).

Executing a script via OSD

How to execute a script via OSD:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. If the OSD is opened in the Select menu, press Ctrl+X to switch to the Script menu.

3. Use the arrow keys to select the script you want to execute.

4. Press Enter.

ADVICE: Press X in the Operation menu or use the hotkey Ctrl + X on the 
Select menu to access the Script menu (see page 12).

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.
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Scripting function
Editing the default menu mode

In the defaults, after accessing the OSD at a console module, you can select a computer 
via the Select menu. If desired, you can use your personal profile to define that the 
Script menu is shown directly after accessing the OSD.

How to edit the default menu mode:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Def. selection dialog entry and press F8 (repeatedly) to select one of the 
following options:

4. Press F2 to save your settings.

Switching threshold to switch the menu mode by mouse

In addition to switch the menu mode via the hotkey Ctrl+X you can also use the 
mouse to switch between menu modes.

How to activate/deactivate the switching threshold and/or adjust its sensitivity:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Sel. dialog replace sens entry. 

4. Adjust the sensitivity of the switching threshold by entering a value  
between 1 and 10.

5. Press F2 to save your settings.

ADVICE: Independent of the default setting, you can always use the hotkey Ctrl+X
to switch between Select menu and Script menu.

select: The Select menu is shown after accessing the OSD.

script: The Script menu is shown after accessing the OSD.

ADVICE: After the activation of the switching of the menu mode by mouse, you 
can move the mouse to the left or to the right to switch between the two modes in 
the Select menu and in the Script menu.

IMPORTANT: Switching the menu mode by mouse is not possible if the entry is not 
available in the Select menu or in the Script menu!

NOTE: To deactivate the switching between menus by mouse, enter 0.
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Creating, editing and deleting scripts

Creating scripts

How to create a script:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Scripting function entry and press Enter.

4. Press F3 and enter the following data under Add Script:

5. Press F2 to save your settings and the script.

NOTE: Users without Superuser rights can create and store scripts only for their 
console. The options Owner (current user) and Scope (console) are auto-assigned 
and can not be viewed or edited.

Users with Superuser rights can view and edit all options.

ADVICE: You cannot save the switching condition in a script via the Window-
Manager on a DWC.

Name: Enter the desired name of the script key set and press Enter.

Owner: Press F8 to select if the script should be assigned to the logged 
on user account (current user) or if it should be used by all users 
(none).

Scope: Select if the switching condition of the console, the entire system
(switching states of a DWC are not taken into acount) or a 
console list should be stored in the script.

The leader console of a Tradeswitch console is provided with 
the option TS workplace.

NOTE: Executing global scripts requires Scripting rights for the script.

NOTE: When selecting the option console list you can define the list of console 
modules via the Consoles entry.
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Editing the settings of a script

How to edit the settings of a script:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Scripting function entry and press Enter.

4. Select the script you want to edit and press F5.

5. Enter the following data under Edit Script:

6. Press F2 to save your settings.

NOTE: Users without Superuser rights can view and edit only the names and 
Enable settings of their own scripts.

Users with Superuser rights can view and edit all settings of all scripts.

Name: Enter the desired name of the script key set and press Enter.

Enable: Select if the script should be activated and editable (yes) or 
if it should be deactivated (no).

Ignore device 
response:

Activate this function if the response of the device should not 
be evaluated.

Execution 
delay:

You can delay the execution of the script by up to 999 seconds 
after it is called. Enter the desired delay time in seconds..

Owner: Press F8 in the user list to assign a script to a user or to cancel 
the assignment.

If the script is not assigned to any user account, it is a global 
 script. global scripts can be used by all users.

Script  
Availabilty

Select the console modules and/or DWCs whose script menu 
lists this script.

Available via 
EasyControl

Select if the script should be available in the EasyControl tool 
(yes) or not (no).

NOTE: The function can only be activated if the script is executed on 
another device.

NOTE: Executing global scripts requires Scripting rights for the script.
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Deleting a script

How to delete a script:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Scripting function entry and press Enter.

4. Select the script you want to delete and press F4.

5. Confirm the security prompt with Yes and press Enter.

Defining rights to execute scripts

Executing global scripts requires Scripting rights for the script.

You can assign this right directly in the settings of a user account. As an alternative, 
you are able to administrate this right via user groups (see Efficient user group adminis-
tration on page 80).

How to change the right to execute global scripts:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right for a user account, select the User entry.  
For changing this right for a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights to execute scripts  
you want to edit and press F5.

6. Select the Scripting rights entry and press Enter.

7. Select the script from the list whose execute rights you want to edit.

NOTE: Users are always able to view and delete their own scripts (Owner) without 
having to be assigned with additional rights.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to 
limit the selection of list entries.
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8. Press F8 t select one of the following options:

9. Repeat steps 7. and 8. to edit the execute rights of another script.

10.Press F2 to save your settings.

Executing a script with script keys
After the script key modifier(s) and a script key set have been adjusted and a script 
key set has been activated in the user account, scripts can be executed at the console 
keyboard via key combinations.

Opening the OSD is not required to execute scripts using script keys. This way, scripts 
can be executed much faster.

How to execute a script with script keys:

1. Press the script key modifier(s) that have been adjusted in the matrix system and 
the script keys assigned to the script.

Further information:
 Changing the script key modifier and the valid keys on page 64
 Administrating script key sets on page 65
 Assigning script key sets to user accounts on page 68

no: Denies right to execute script

yes: Grants right to execute script

ADVICE: On a DWC, a script can also be executed via script keys.

EXAMPLE: 

 Script key modifiers: Win+Shift
 Script key for script : 1

Press and hold Win+Shift together with the script key 1.  
After releasing the keys, the script is executed.
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Changing the script key modifier and the valid keys
Script keys enable the fast execution of scripts by pressing a key combination. 
For this, script key sets can be created in the matrix system.

Both the script key modifier and a script key set define the key combination to be 
pressed to execute a script.

You can also define valid keys for the script keys.

How to change the script key modifier or the valid keys:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Script key entry and press Enter.

5. Use the arrow keys to select at least one of the script key modifiers listed under 
Modifier. Afterwards, press F8:

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift Shift key
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6. Select the Valid keys entry and press F8 to select one of the following options:

7. Press F2 to save your settings.

Administrating script key sets
The KVM matrix system enables you to create 20 global script key sets or ten individual 
script key sets for each user. 

Within the script key sets, you can define script keys to execute scripts.

Num: only numerical keys are interpreted as script keys when pressed in 
combination with the script key modifier

Alph: only alphabetic keys are interpreted as script keys when pressed in 
combination with the script key modifier

AlphNum: alphabetical and numerical keys are interpreted as script keys when 
pressed in combination with the script key modifier

IMPORTANT: Both the selected valid keys and the script key modifier are 
no longer provided as key combinations to the operating system and the 
applications on the computer.

NOTE: Global script key sets are displayed in the Personal Profile menu of all users of 
the matrix system.
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Creating a script key set

How to create a script key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Script key set entry and press Enter.

4. Press F3 and enter the follwoing data under Add Script Key Set:

5. Press F2 to save your settings and the script key set.

Changing name and global allocation of a script key set

How to change the name and/or global allocation of a script key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Script key set entry and press Enter.

4. Select the script key set whose name or global allocation you want to change.

5. Press F5-Taste and change the following data under Edit Script Key Set:

6. Press F2 to save your settings.

Name: Enter the desired name of the script key set and press Enter.

Global: Press F8 for selecting yes if you want to make the script key set in the 
Personal Profile menu available to all users of the system.

Default: no

Name: Enter the desired name of the script key set and press Enter.

Global: Press F8 for selecting yes if you want to make the script key set in the 
Personal Profile menu available to all users of the system.

Default: no

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).
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Defining script keys for scripts

How to define script keys for scripts:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Script key set entry and press Enter.

4. Select a script key set and press F5.

5. Select the Members entry and press Enter.

The Assign script key set dialogue opens. The left column shows the name of the 
scripts and the right column shows the assigned script key(s).

6. Select the script you want to assign a script key to or whose script key you want 
to edit.

7. Press F5 and enter the desired script key.

8. Repeat steps 6. and 7. to define or change the script keys of other scripts.

9. Press F2 to save your settings.

NOTE: Global script key sets can be edited only by users with activated Superuser 
right (see page 93).

Without this right, only script keys assigned to scripts can be viewed. 

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.

NOTE: The chapter Changing the script key modifier and the valid keys on page 64 
provides information on how to edit valid keys that are used as script keys.
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Assigning script key sets to user accounts

By assigning a script key set to a user account, the script keys defined in the set are 
interpreted and the particular script is executed.

How to assign a script key set to a user account or cancel the existing assignment:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Script key set entry and press Enter.

4. Select the desired script key set.

5. Press F8 to activate or deactivate the assignment.

6. Press F2 to save your settings.

Deleting script key sets

How to delete a script key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Script key set entry and press Enter.

4. Select the script key set you want to delete and press F4.

5. Confirm the security prompt with Yes and press Enter.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: Script key sets that are already assigned to a user account are marked 
with an arrow ().

NOTE: Only users with the Superuser right (see page 93) are allowed to delete global 
script key sets.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Push events

Push event keys let users at consoles trigger push events via XML control. The trig-
gered push event contains the following information:

 the string entered by the user,
 the console module or DWC name and device ID,
 name and device ID of the computer module switched to the console module or 

DWC.

Triggering push events
You can trigger push events by pushing and holding the push event key modifier and 
entering a valid string (see below).

NOTE: This function is available only after activating the additional IP-Control-API
function (see page 225 ff.).

PUSH EVENT OF THE XML SERVICE (EXAMPLE)
<?xml version="1.0" encoding="utf-8"?>
<root>

<pushNotification type="user_push_event">
<sourceId>0x00000115</sourceId> <!-- device ID of console module on which

         the push event was triggered -->
<sourceCl>DviConsole</sourceCl> <!-- device class -->
<sourceName>CON-NixStn</sourceName> <!-- device name-->
<text>123</text> <!-- user input -->
<targetId>0x00001D4E</targetId> <!-- device ID of computer module -->
<targetCl>DviCpu</targetCl> <!-- device class of computer module -->
<targetName>CPU HW 1</targetName> <!-- device name of computer module -->
<originatorId>0x00000115</originatorId> <!-- device ID of console module operated

         by user -->
<originatorCl>DviConsole</originatorCl> <!-- device class -->
<originatorName>CON-NixStn</originatorName> <!-- device name -->

</pushNotification>
</root>

NOTE: The values of<originatorId> and <sourceId> differ only when using 
Tradeswitching.
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Changing push event key modifiers and valid keys
You can trigger push events by pushing and holding the push event key modifier and 
entering a valid string (see entry Valid keys).

How to change push event key modifiers or valid keys:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to open the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Push event key entry and press Enter.

5. Under Modifier, select at least one modifier key by selecting the control box with 
the arrow keys and press F8 to confirm your selection:

6. Under Valid keys, press F8 to select one of the following options:

7. Press F2 to save your settings.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift: Shift key

Num: Only numerical keys are interpreted as push event keys when pressed 
together with the push event key modifier. 

Alph: Only alphabetic keys are interpreted as push event keys when pressed 
together with the push event key modifier.

AlphNum: Numerical and alphabetical keys are interpreted as push event keys 
when pressed together with the push event key modifier 
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Switching the computer modules 
automatically or manually

Auto scanning all computer modules (Autoscan)
The Autoscan function successively accesses all computer modules that are mentioned 
in the active scancode set and available to the user.

The Scantime setting (see page 72) enables you to define how long a computer module 
is to be accessed.

When accessing the computer modules, the console module name, the name of the 
currently accessed computer module, and a note regarding the Autoscan function are 
displayed.

Applying the Autoscan function

How to start the Autoscan function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to call the Operation menu.

3. Press A or select the A - Autoscan entry and press Enter.

How to stop the Autoscan function:

1. Press the hotkey Ctrl+Num (default) to call the OSD. 

This causes the Autoscan function to stop.

IMPORTANT: Functions of automatic and manual switching between computer 
modules are not available on a DWC.

NOTE: If the Autoscan function is active, the keyboard and mouse inputs are 
transmitted to the currently accessed computer module.

During your inputs, the Autoscan function stops and continues after you 
finished your inputs.

Requirements for using the Autoscan function:

 Creating a scanmode set on page 75
 Assigning a scanmode set to a user account on page 78

ADVICE: After the OSD has been called, you can activate the Autoscan function in 
the Select menu by pressing Ctrl+A.
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Configuring the scantime of the Autoscan function

By default, each computer mdoule is accessed for five seconds. After that, the computer 
module is disconnected and the next computer module is accessed.

Select a time span between 1 and 99 seconds to define how long the computer module 
is to be accessed.

How to change the scantime:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Move the cursor to the Scantime entry and enter a span between 1 and 99 seconds.

4. Press F2 to save your settings.

Auto scanning all active 
computer modules (Autoskip)
The Autoskip function successively accesses any computer module that is included 
into the active scancode set and available to the user.

The connected computer must be active to carry out this function.

The Scantime setting (see page 72) enables you to define how long each computer 
module is to be accessed.

When accessing the computer modules, the console module name, the name of the 
currently accessed computer module, and a note regarding the Autoskip function are 
displayed.

NOTE: If the Autoskip function is active, the keyboard and mouse inputs are 
transmitted to the currently accessed computer module.

During the inputs, the Autoskip function stops and continues after you 
finished your inputs.
ControlCenter-Compact · 72



Switching the computer modules automatically or manually
Applying the Autoskip function 

How to start the Autoskip function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to call the Operation menu.

3. Press B or select the B - Autoskip entry and press Enter.

How to stop the Autoskip function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

This causes the Autoskip function to stop.

Configuring the scantime of the Autoskip function

By default, each computer module is accessed for five seconds. After that, the computer 
module is disconnected and the next computer module is accessed.

Select a time span between 1 and 99 seconds to define how long the computer module 
is to be accessed.

How to change the scantime:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Move the cursor to the Scantime entry and enter a span between 1 and 99 seconds.

4. Press F2 to save your settings.

Requirements for using the Autoskip function:

 Creating a scanmode set on page 75 
 Assigning a scanmode set to a user account on page 78

ADVICE: After the OSD has been called, you are enabled to activate the 
Autoskip function in the Select menu by pressing Ctrl+B.
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Scanning the computer modules 
manually (Stepscan)
By pressing a key, the Stepscan function successively accesses any computer module 
that is included in the scanmode set and available to the user.

When accessing the computer modules, the console module name, the name of the 
currently accessed computer module, and a note regarding the Stepscan function are 
displayed.

(De)activating the Stepscan function

How to activate the Stepscan function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to call the Operation menu.

3. Press C or select the C - Stepscan entry and press Enter.

How to deactivate the Stepscan function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

This causes the Stepscan function to stop.

Switching between the computer modules

How to switch between computer modules via Stepscan function:

1. Press the Up stepkey (default) to access the next computer module or the  
Down stepkey (default) to access the previous computer module.

Requirements to use this function:
 Creating a scanmode set on page 75 
 Configuring keys to scan the computer modules manually on page 75 
 Assigning a scanmode set to a user account on page 78 

ADVICE: After the OSD has been called, you are enabled to activate the 
Stepscan function in the Select menu by pressing Ctrl+C.
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Configuring keys to scan the computer modules manually

By pressing a key, the Stepscan function successively switches to all computer modules 
that are available to the user.

You can select different keys to access the next (default Up) or the previous (default
Down) computer module.

How to select the keys for using the Stepscan function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Stepkeys entry and press F8 (repeatedly) to select between the following 
options:

4. Press F2 to save your changes.

Administrating the scanmode sets
The matrix system enables you to create 20 global select key sets or ten individual 
scanmode sets for each user. 

The select key sets allow you to define the computers to be accessed when performing 
the Autoscan, Autoskip or Stepscan function.

Creating a scanmode set

How to create a scanmode set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Scanmode set entry and press Enter.

Up/Down: Up and Down arrow keys

PgUp/PgDn: Page and Page keys

Num Up/Down: Up and Down arrow keys of the numeric keypad

Num PgUp/PgDn: Page and Page keys of the numeric keypad

Num +/- plus and minus keys of the numeric keypad

NOTE: The global scanmode sets are displayed in the Personal Profile menu of all 
users of the matrix system.
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4. Press F3 and collect the following data in the Add Scanmode Set menu:

5. Press F2 to save your settings.

Changing the name and global allocation of a scanmode set

How to change the name and/or Global setting of a scanmode set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Scanmode set entry and press Enter.

4. Select the scanmode set whose setting you want to change.

5. Press F5 to change the following data in the Edit Scanmode Set menu:

6. Press F2 to save your settings.

Name: Enter the desired scanmode set name and press Enter.

Global: Select yes by pressing F8 if you want the scanmode set in the 
personal profile to be available for all users of the system.

default: no

Name: Enter the desired scanmode set name and press Enter.

Global: Select yes by pressing F8 if you want the scanmode set in the 
personal profile to be available for all users of the system.

default: no

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).
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Assigning the computer modules to a scanmode set

How to assign computer modules to a scanmode set or cancel the existing 
assignment:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Scanmode set entry and press Enter.

4. Press F5 to edit the selected scanmode set.

5. Select the Members entry and press Enter.

The Scanmode Set Members menu opens. This menu lists all computer modules 
within the matrix system that you are allowed to access.

6. Mark a computer module to be assigned to the scanmode set or whose  
assignment is to be cancelled.

7. Press F8 to (de)activate the selection.

8. If you want to assign further computer modules to the scanmode set,  
repeat steps 6 and 7.

9. Press F2 to save your settings.

NOTE: Global scanmode sets can only be edited by users with activated 
Superuser right (see page 93).

Without this right, only the assigned computer modules can be viewed. 

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.

NOTE: The computer module that has been assigned to the scanmode 
set is marked with an arrow ().
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Assigning a scanmode set to a user account

A scanmode set defines the targets to be accessed when the Autoscan, Autoskip or Step-
scan function is carried out.

How to assign a scanmode set to the user account or cancel the existing assign-
ment:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Scanmode set entry and press Enter.

4. Select the desired scanmode set in the list field.

5. Press F8 to (de)activate the selection.

6. Press F2 to save your settings.

Deleting a scanmode set

How to delete a scanmode set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to open the Personal Profile menu.

3. Select the Scanmode set entry and press Enter.

4. Select the scanmode set you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.

NOTE: An assigned scanmode set is marked with an arrow ().

NOTE: Only users with activated Superuser right (see page 93) can delete a global 
scanmode set.

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.
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Users and Groups

Efficient rights administration
The matrix system administrates up to 256 user accounts and the same amount of 
user groups. Each user within the system can be a member of up to 20 groups.

Both user accounts and user groups can be provided with different rights.

The effective right

The effective right determines the right to carry out a particular function.

Example: The user JDoe is member of the groups Office and Computer module config. 

The following table shows the user account rights, the rights of the assigned groups, 
and the resulting effective right:

ADVICE: The rights administration can almost completely be carried out 
through user groups. Therefore, the user groups and the assigned rights have 
to be adequately planned and implemented. 

This way, the user rights can be quickly and efficiently changed.

IMPORTANT: The effective right is the maximum right that consists of the 
user account’s individual right and the rights of the assigned group(s).

In the OSD, the individual right is highlighted in yellow. The effective 
right is highlighted in green.

Press Ctrl+F12 to open the Right Source window. Here you can see the groups 
the effective right results from. 

Right User
JDoe

Group
Office

Group
Computer 

module config

Effective 
right

Computer 
module  
config

No No Yes Yes

Change own 
password

No Yes No Yes

Device rights: 
access

Full View No Full
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The settings of the Computer module config and Change own password rights result from 
the rights assigned to the user groups. The Device rights: access right which, in this case, 
enables full access to a computer module, was given directly in the user account.

Efficient user group administration

User groups enable the creation of a shared right profile for several users with identi-
cal rights. Furthermore, the user accounts that are included in the member list can 
be grouped and therefore no longer have to be individually configured. This facilitates
the rights administration within the matrix system.

If the rights administration takes place within the user groups, the user profile only 
stores general data and user-related settings (key combinations, language settings, …).

When initiating the matrix system, it is recommended to create different groups for 
users with different rights (e. g., »Office« and »IT«) and assign the respective user 
accounts to these groups.

EXAMPLE: Create more groups if the user rights are to be further divided. If, for 
example, some users of the »Office« group are to be provided with the MultiAccess 
right, a respective user group can be created:

 Create a user group (e. g., »Office_MultiAccess«) with identical settings for the »Office« 
group. The Device rights: MultiAccess right is set to full. Assign the respective user 
accounts to this group.

 Create a user group (e. g., »MultiAccess«) and only set the Device rights: MultiAccess 
right to Yes. In addition to the »Office« group, also assign the respective user 
accounts to this group. 

In both cases, the user is provided with the full effective right for MultiAccess.

NOTE: To be able to better differentiate between individual and effective right 
displayed in the menus of the user management, the rights are highlighted in 
different colours.

 Individual rights are displayed in yellow.
 Effective rights are displayed in green. 

ADVICE: The user profile offers the possibility to provide extended rights to a 
group member.
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Administrating user accounts

Creating a new user account

A matrix system can contain up to 256 user accounts.

The owner of a user account is provided with individual login data, rights and user-
related settings for the system.

How to create a new user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Press F3 and enter the following data in the Add User  menu:

5. Press F2 to save your inputs and create a user account.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

IMPORTANT: If an individual password policy is to be taken into account, you 
must configure the password complexity (see Configuring the password complexity on 
page 5) before creating a new user account.

Name: username of the new account

Password: password of the new account

Repeat: repeat new password

IMPORTANT: The recently created user account can neither configure nor 
access the computer modules. 

Before the account can be used, it has to be added to an existing user group 
or provided with individual rights.
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Renaming the user account

How to rename a user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.
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Changing the user account password

How to change the user account password:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account whose password you want to change and press F5.

5. Select the Password entry and press Enter.

6. Enter the following data:  

7. Press F2 to save your settings.

NOTE: The personal password can be changed in the Personal Profile menu 
(see page 10) if the user account is provided with the Personal Profile or the 
Change own password right.

NOTE: When changing the password, any defined password policies (see Configur-
ing the password complexity on page 5) are taken into account.

Current: Enter the current password.

2-Factor Auth 
Code (TOTP):

Enter the 2-Factor Auth Code (TOTP) from 
two-factor authentication.

New: Enter your new password.

Repeat: Repeat your new password.

NOTE: No entry is required in this field for users with activated superuser 
rights (see page 93 ff.).

NOTE: The 2-Factor Auth Code (TOTP) field only appears if 2-factor-authenti-
cation is enabled. For detailed information, please refer to the separate 
manual of the web application.
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Changing the user account rights

A user account can be assigned with different rights. 

The following tables list the different rights. Further information regarding these 
rights are provided in the respective chapters.

Superuser right

Config rights

Global device rights 

Name Right Page

Superuser right Unrestricted access to the configuration of the 
system

page 93

Name Right Page

Computer module 
config

Configuration of computer modules page 110

WebIf login Login to the Config Panel web application page 211

Name Right Page

Personal profile Change personal user settings page 94

MultiAccess Access mode when a computer module is 
simoultaneously accessed

page 106

USB access USB access page 108

Exclusive signals Access to exclusive signals page 145

Change own password Change own password page 95

Replace device Execution of the “Replace device” function page 96
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Device rights and device group rights 

Scripting rights 

Push-Get rights 

Name Right Page

Device rights: 
Access

Access to a computer module page 103

Device group rights: 
Access

Access to a computer module group page 105

Device rights: 
MultiAccess

Access if a computer module is accessed by 
several users

page 107

Device group rights: 
MultiAccess

Access if computer modules are accessed by 
several users (computer module group)

page 107

Device rights:  
USB accesss

Access USB devices for a certain computer 
module

page 109

Device group rights: 
USB access

Access USB devices for computer modules 
(computer module group)

page 109

Device rights: 
Excl. signals

Access to exclusive signals of a certain computer 
module

page 146

Device group rights: 
Excl. signals

Access to exclusive signals of computer modules 
(computer module group)

page 146

Device rights: 
Device power

Switching the power outlets of a computer module page 111

Device group rights:  
Device power

Switching the power outlets of computer modules 
(computer module group)

page 111

Name Right Page

Scripting rights Carry out a global script page 62

Name Right Page

Device rights: 
Push-Get

Carry out Push-Get function page 224
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Changing a user account’s group membership

How to change a user account’s group membership:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account whose group membership you want to change and press F5.

5. Select the Group membership entry.

6. Select the user group to which you want to add a user account or from which you 
want to delete a user account.

7. Press F8 to add the user account to or delete it from the selected user group.

8. Repeat steps 6 and 7 to edit the group membership for further accounts.

9. Press F2 to save your settings.

NOTE: Any user within the matrix system can be a member of up to 20 user groups.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: User groups to which the user account is assigned to are marked 
with an arrow ().
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(De)activating a user account

How to (de)activate a user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the user account you want to (de)activate and press F5.

4. Select the Enable entry and press F8 to select one of the following options: 

5. Press F2 to save your settings.

Deleting a user account

How to delete a user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Mark the user account you want to delete and press F4.

5. Select Yes and press Enter to respond to the prompt for confirmation.

IMPORTANT: If the user account is deactivated, the user will be denied access to 
the matrix system.

yes: user account activated

no: user account deactivated
87 · ControlCenter-Compact



Users and Groups
Administrating user groups

Creating a new user group

The matrix system can contain up to 256 user groups.

How to create a new user group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User group entry and press Enter.

4. Press F3 and enter the user group name.

5. Press F2 to save your inputs and create a user group.

Renaming a user group

How to rename a user group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User group entry and press Enter.

4. Select the user group you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

IMPORTANT: The recently created user group can neither configure nor access the 
computer modules.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Changing the user group rights

The user groups can hold different rights.

The following tables list the different rights. Further information regarding these 
rights are provided in the respective chapters.

Superuser right 

Config rights 

Global device rights 

Name Right Page

Superuser right Unrestricted access to the configuration of the 
system

page 93

Name Right Page

Computer module 
config

Configuration of computer modules page 110

WebIf login Login to the Config Panel web application page 211

Name Right Page

Personal profile Change personal user settings page 94

MultiAccess Access mode when a computer module is 
simoultaneously accessed

page 106

USB access USB access page 108

Exclusive signals Access to exclusive signals page 145

Change own password Change own password page 95

Replace device Execution of the “Replace device” function page 96
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Device rights and device group rights 

Scripting rights 

Push-Get rights 

Name Right Page

Device rights: 
Access

Access to a computer module page 103

Device group rights: 
Access

Access to a computer module group page 105

Device rights: 
MultiAccess

Access if a computer module is accessed by 
several users

page 107

Device group rights: 
MultiAccess

Access if computer modules are accessed by 
several users (computer module group)

page 107

Device rights:  
USB accesss

Access USB devices for a certain computer 
module

page 109

Device group rights: 
USB access

Access USB devices for computer modules 
(computer module group)

page 109

Device rights: 
Excl. signals

Access to exclusive signals of a certain computer 
module

page 146

Device group rights: 
Excl. signals

Access to exclusive signals of computer modules 
(computer module group)

page 146

Device rights: 
Device power

Switching the power outlets of a computer module page 111

Device group rights:  
Device power

Switching the power outlets of computer modules 
(computer module group)

page 111

Name Right Page

Scripting rights Carry out a global script page 62

Name Right Page

Device rights: 
Push-Get

Carry out Push-Get function page 224
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Administrating the user group members

How to administrate the members of a user group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User group entry and press Enter.

4. Select the user group whose members you want to administrate and press F5.

5. Select the Member management entry and press Enter.

6. Select the user account you want to add to or delete from the user group.

7. Press F8 to add the user account to the selected user group or to delete it from this 
group.

8. Repeat steps 6 and 7 to change the group membership for further accounts.

9. Press F2 to save your settings.

(De)activating a user group

How to (de)activate a user group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User group entry and press Enter.

4. Select the user group whose status you want to change and press F5.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: User accounts that are assigned to the user group are marked with an 
arrow ().

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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5. Select the Enable entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

Deleting a user group

How to delete a user group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User group entry and press Enter.

4. Select the user group you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

yes: activate user group

no: deactivate user group

IMPORTANT: If the user group is deactivated, the group rights do not apply to 
the assigned members.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Rights regarding the user account

The Superuser right

The Superuser right enables you to fully access and configure the matrix system. 

How to change the Superuser right of a user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right for a user account, select the User entry.  
For changing this right for a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose Superuser rights you want to 
change and press F5.

6. Select the Superuser right entry and press F8 to select one of the following options:

7. Press F2 to save your settings.

NOTE: The information on the user rights that have been assigned before are still 
stored when the Superuser right is activated. After the Superuser right has been with-
drawn, the saved rights do apply again.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

yes: full access to KVM matrix system

no: access authorisation according to user and group rights
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Changing settings in the Personal Profile menu

How to change a user account’s operating rights:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right for a user account, select the User entry.  
For changing this right for a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Global device rights entry and press Enter.

7. Select the Personal Profile row and press F8 to select one of the following options:

8. Press F2 to save your settings.

yes: allows to view and edit the personal profile

no: denies to view and edit the personal profile
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Changing your own password

How to change a user account’s operation rights:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right for a user account, select the User entry.  
For changing this right for a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Global device rights entry and press Enter.

7. Select the Change own password row and press F8 to select one of the following 
options:

8. Press F2 to save your settings.

yes: allows to change the password of the own user account

no: denies to change the password of the own user account
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Authorisation to execute the »Replace device« function

If a console module or a computer module is replaced by new device, the previous 
config settings can be copied to the new device. After the config settings have been 
copied to the new device, it can be operated immediately.

In the default settings, the authorisation to execute the function is limited to the 
administrator and all users with activated superuser rights.

If desired, the authorization can be granted to other users.

How to change the right to replace a device:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right for a user account, select the User entry.  
For changing this right for a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Global device rights entry and press Enter.

7. Select the Replace device row and press F8 to select one of the following options:

8. Press F2 to save your settings.

yes: Allow users to execute the function

no: Deny users to execute the function
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Computer module groups and view filters
Computer module groups and view filters

Difference between computer module groups and 
view filters
The computer modules of the matrix system can be organised into computer 
module groups and view filters.

Intended use of computer module groups

Computer module groups enable the administrator to quickly assign the rights of a 
user or a user group for all computer modules within a group.

Intended use of view filters

View filters enable the users of a matrix system to organise the different computer
modules into view groups. Especially in large matrix systems, the creation of view 
groups gives you the possibility to keep a better overview over the system.

You can group the computer modules according to their view filter (e.g. the server 
room) or to any other features (e.g. to the operating system of the connected computer).

Administrating computer module groups

The »New digital Targets« and »New analog Targets« 
computer module group

By default, the New digital targets and New analog targets computer module groups are 
created in the KVM matrix system. This groups automatically contain any 
computer module that is connected to the system. For this, the computer connected 
to the module also has to be switched on.

NOTE: The different computer modules can be members of several computer 
module groups.
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If you want to provide a user or a user group with particular rights to all recently 
connected computer modules, change the device group rights of either the user 
account or the user group.

Creating a new computer module group

How to create a new computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer module group entry and press Enter.

4. Press F3 to create a new group.

5. In the Name line, enter the name of the computer module group.

6. Press F2 to save your inputs and create a computer module group.

Renaming a computer module group

How to rename a computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer module group entry and press Enter.

4. Select the computer module group you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

NOTE: The rights for this computer module group can be assigned when access 
rights to a computer module group (see page 105) of either the user account or the 
user group are changed.
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Administrating the computer module group members

How to administrate the members of a computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer module group entry and press Enter.

4. Select the computer module group whose members you want to administrate and 
press F5.

5. Select the Members entry and press Enter.

6. Select the computer module you want to add to or delete from the computer 
module group.

7. Press F8 to add the computer module to the selected computer module group or 
to delete it from this group.

8. Repeat steps 6 and 7 to edit the group membership of further computer modules.

Deleting a computer module group

How to delete a computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer module group entry and press Enter.

4. Select the computer module group you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

NOTE: You can assign up to 20 computer modules to a computer module group 
within the matrix system.

NOTE: The special MEMBERS and NONMEMBERS options of this menu’s view 
filter (see page 21) enable you to only list the computer modules that are or are 
not assigned to this group.

You can also use the menu’s search function or the sort criteria (see page 20 ff.) to 
limit the selection of list entries.

NOTE: The computer modules that are assigned to a computer module group 
are marked with an arrow ().
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Administrating view filters

Creating a new view filter

How to create a new view filter:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the View filter entry and press Enter.

4. Press F3 and enter the view filter name.

5. Press F2 to save your inputs and create a view filter.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.
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Assigning a computer module to a view filter

How to assign a view filter to a computer module or cancel the existing assignment:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the View filter entry and press Enter.

4. Select the view filter which you want to assign a computer module to or whose 
assignment you want to cancel and press F5.

5. Select the Members entry and press Enter.

The Assign View Filter menu opens. This menu contains a list of all computer  
modules within the matrix system. 

6. Mark a computer module which you want to assign to the view filter or whose 
assignment you want to cancel.

7. Press F8 to (de)activate the assignment.

8. Repeat steps 6 and 7 for further computer modules.

9. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: A computer module, which is assigned to a view filter, is marked with 
an arrow ().
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Renaming a view filter

How to rename a view filter:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the View filter entry and press Enter.

4. Select the view filter you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

Deleting a view filter

The created view filters can be deleted at any time. Deleting a view filter has no 
effect on the computer modules assigned to the view filter.

How to delete a view filter:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the View filter entry and press Enter.

4. Select the view filter you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.
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Computer modules
The computer modules serve to connect the computers to the matrix system. The 
computer modules can be accessed through the console modules.

Adjusting the access and config rights

Accessing a computer module

In order to carry out setting deviating from the rights assigned to the existing 
computer module groups, you can assign individual access rights in addition to the 
group rights.

How to change the access rights:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Device rights: Access entry and press Enter.

7. Select the desired computer module whose access right you want to change.

ADVICE: It is recommended to use computer module groups to assign the 
computer module access rights (see page 89). 

This way, you are able to keep an overview of the KVM matrix systems. It also 
benefits the operating performance within the OSD of the system.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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8. Press F8 to select one of the following options:

9. Repeat steps 7 and 8 to change the access rights to further computer modules.

10.Press F2 to save your settings.

no: denies access to the computer connected to the computer module

view: enables to view the screen content of the computer connected to the 
computer module

full: full access to the computer connected to the computer module

NOTE: The View mode enables you to access the monitor image of the target 
computer. Inputs, however, are not possible.
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Accessing a computer module group

How to change the computer module group access right:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Device group rights: Access entry and press Enter.

7. Select the desired computer module group whose access rights you want to 
change.

8. Press F8 to select one of the listed options:

9. Repeat steps 7 and 8 to change the access rights to further computer module 
groups.

10.Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

no: denies access to the computer connected to the group’s computer 
modules

view: enables to view the screen content of the computer connected to the 
group’s computer modules

full: full access to the computer connected to the group’s computer 
modules

NOTE: The View mode enables you to access the monitor image of the computer
connected to the computer module. Inputs, however, are not possible.
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Access mode when simultaneously accessing a computer module

In the default settings of the KVM matrix system, only one user can access a computer 
module.

This restriction can be lifted by changing the MultiAccess rights for a user account or a 
user group.

You can either change the global settings to allow multiple users to access a 
computer module at the same time (for all computer modules a user or a user group 
has access to) or you can change the rights for particular computer modules or 
computer module groups only.

How to change the MultiAccess rights for all computer modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Global device rights entry and press Enter.

7. Select the MultiAccess entry and press F8 (repeatedly) to select one of the following 
options:

8. Press F2 to save your settings.

NOTE: The right for simultaneous access depends on the user’s effective right (see 
page 79). The effective right is the highest right that results from the individual 
right of the user accounts and the rights of the assigned group(s).

no: denies access to an already accessed computer module

view: when connecting to a computer module with an already active 
connection, only the monitor image is displayed; no inputs possible

full: full access to an already accessed computer module
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How to change the MultiAccess rights for a certain computer module or computer 
module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change 
and press F5.

6. Select the Device rights: MulitAccess/Device group rights: MultiAccess entry and  
press Enter.

7. Select the computer module or computer module group whose rights you want to 
change.

8. Press F8 (repeatedly) to select one of the following options:

9. Press F2 to save your settings.

NOTE: You can configure and apply MultiAccess rights if the user account or the 
user group are assigned with general access rights (see page 103 f.) for the computer 
module.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

no: denies access to an already accessed computer module

view: when connecting to a computer module with an already active 
connection, only the monitor image is displayed; no inputs possible

full: full access to an already accessed computer module
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Access to USB devices

In the defaults of the matrix system, users have access to USB devices of a channel 
group.

This right can be denied by changing the right USB access of a user account or a user 
group.

The right to access USB devices of a certain computer module can be denied either 
globally (for all computer modules a user or a user group can access) or for certain 
computer modules or computer module groups.

How to change the right to access USB devices for all computer modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Global device rights entry and press Enter.

7. Select the USB access entry and press F8 (repeatedly) to select one  
of the following options:

8. Press F2 to save your settings.

NOTE: The access right depends on the user’s effective right (see page 79). The 
effective right is the highest right that results from the individual right of user 
accounts and the rights of assigned group(s).

yes: Allow access to USB devices of the channel group.

no: Deny access to USB devices of the channel group.
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How to change the right to access USB devices for a certain computer module 
or computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change 
and press F5.

6. Select the Device rights: USB access/Device group rights: USB access entry and  
press Enter.

7. Select the computer module or computer module group whose rights you want to 
change.

8. Press F8 (repeatedly) to select one of the following options:

9. Press F2 to save your settings.

NOTE: You can configure and apply access to USB devices if the user account or 
the user group are assigned with general access rights (see page 103 f.) for the com-
puter module.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

yes: Allow access to USB devices of the channel group.

no: Deny access to USB devices of the channel group.
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Rights for configuring the computer modules

How to change the computer module config rights:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Config rights entry and press Enter.

7. Select the Computer module config entry and press F8 to select one of the following 
options:

8. Press F2 to save your settings.

yes: allows the right to view and edit the computer module config

no: denies the right to view and edit the computer module config
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Rights to switch the power outlets of a computer module or a 
computer module group

If the system is equipped with at least one powerswitch, you can assign one or several 
power outlets to a computer module (see separate manual of the web application).

The assigned power outlets can be switched via the Operation menu (see page 12 f.).

How to change the rights to switch the power outlets assigned to a computer 
module or a computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change 
and press F5.

6. Select the Device rights: Device power/Device group rights: Device power entry and  
press Enter.

7. Select the computer module or computer module group whose rights you want to 
change.

8. Press F8 (repeatedly) to select one of the following options:

9. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

yes: Allow switching of power outlets assigned to the selected computer 
module or computer module group

no: Deny switching of power outlets assigned to the selected computer 
module or computer module group
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Basic configuration of the computer modules

Renaming a computer module

During the booting process of the matrix system, the computer modules are auto-
matically named. The text CPU-ID is put before the physical device ID.

All computer modules that are automatically named can be renamed. 

How to rename a computer module in the Configuration menu:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

ADVICE: The computer modules can be renamed in the Configuration (see below) 
or the Select menu (see page 113).

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: The message »Name exists« is displayed if a computer module with the 
same name has already been connected to the system. 

The settings of such computer modules are stored within the matrix system and 
are only visible in the Config Panel web application. If necessary, use the web 
application to delete the computer module from the system. 

Afterwards, this name can be assigned to another computer module.
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How to rename a computer module in the Select menu:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Select the computer module to be renamed.

3. Press F5.

4. Change the name and press Enter.

Deleting a computer module from the KVM matrix system

If the matrix system is not able to detect a computer module that has already been 
connected to the system, the device is defined as inactive.

Therefore, the list entry of the computer module you want to permanently remove 
from the system has to be manually removed.

How to delete a computer module that is inactive or disconnected from the system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

NOTE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: The message »Name exists« is displayed if a computer module with the 
same name has already been connected to the system. 

The settings of such computer modules are stored within the matrix system and 
are only visible in the Config Panel web application. If necessary, use the web 
application to delete the computer module from the system. 

Afterwards, this name can be assigned to another computer module.

NOTE: Only inactive computer modules can be deleted.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Copying the computer module config settings

If a computer module of the KVM matrix system is replaced by another device, it is 
possible to copy the previous config settings to the new device.

After the config settings have been copied to the new device, it can be operated 
immediately.

How to copy the computer module config settings:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the active computer module to which you want to copy the config settings 
of a computer module that is switched off or disconnected from the matrix  
system and press F7.

5. Select the computer module whose settings you want to copy and press Enter.

6. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

7. Press F2 to save your settings.

IMPORTANT: The computer module whose settings you want to copy is afterwards 
deleted from the KVM matrix system.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: Only computer modules that are switched off or disconnected from the 
system are listed in this menu.
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Settings for special hardware

Choosing the USB keyboard type

USB computer modules support different USB input devices. You can use the special 
features of a USB input device after selecting the specific USB keyboard mode (see 
page 117).

As an alternative to the specific USB keyboard modes, you can use the Generic HID
mode. In this mode, the data from the USB devices connected to the Keyb./Mouse
interface is transmitted to the active computer module.

 USB keyboards: In addition to the keys of standard keyboard layouts, the default 
USB keymode Multimedia supports several multimedia keys like Loud and Quiet.

With Apple Keyboards, you can apply special keymodes to use the special keys of 
these keyboards.

The following table lists the supported USB keyboards:

NOTE: This setting can only be edited with USB versions of the computer modules.

IMPORTANT: When connecting a USB hub or a USB composite device containing 
multiple USB devices, only the first of the connected HID devices can be used in 
the Generic HID mode (see page 148).

INPUT DEVICE SETTING

PC keyboard with additional multimedia keys  Multimedia

PC keyboard with standard keyboard layout  Standard

Apple Keyboard with numeric keypad (A1243)  Apple A1243
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 Displays and tablets: You can operate computers connected to the computer module 
with one of the supported displays or tablets (depending on model):

 Generic HID mode: In this mode, the data from the USB devices connected to the 
Keyb./Mouse interface is transmitted to the active computer module. 

INPUT DEVICE SETTING

HP 2310tk  HP 2310t

iiyama T1931  iiyama T1931

iiyama TF2415MC  iiyama TF2415

NOTTROT N170 KGE  N170 KGE

Wacom Cintiq 21UX Gen 1  Wacom Cintiq 21UX

Wacom Cintiq 21UX Gen 2  Wacom UX21 Gen2

Wacom CP24 Pen  Wacom CP 24 Pen

Wacom CP27 Pen/Touch  Wacom CP 27 Pen/Touch

Wacom CP32 Pen  Wacom CP 32 Pen

Wacom CP32 Touch  Wacom CP 32 Touch

Wacom DTK-2451  Wacom DTK-2451

Wacom Intuos3  Wacom Intuos3

Wacom Intuos4 L  Wacom Intuos4 L

Wacom Intuos4 M  Wacom Intuos4 M

Wacom Intuos4 S  Wacom Intuos4 S

Wacom Intuos4 XL  Wacom Intuos4 XL

Wacom Intuos5 S  Wacom Intuos5 S

Wacom Intuos5 M  Wacom Intuos5 M

Wacom Intuos5 L  Wacom Intuos5 L

Wacom Intuos Pro L  Wacom Intuos Pro L

INPUT DEVICE SETTING

Any USB device  Generic HID

IMPORTANT: To use a generic HID device, you need to activate the Generic HID
support of the console module to which the USB device is connected to (see 
page 131).
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 Controller: With ShuttlePRO v2 multimedia controllers, you can operate audio and 
video programs. You can use a special USB keymode to operate computers con-
nected to the computer module using the controller:

 LK463 compatible keyboard: You can connect an LK463 compatible keyboard to the 
console modules of the matrix system. The order of the 108 keys of these keyboards is 
the same as the OpenVMS keyboard layout.

A special USB keyboard mode guarantees that the keypress of a special key on this 
keyboard is forwarded to the computer:

How to select a USB keyboard mode:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module whose settings you want to change and press F5.

5. Select the USB HID mode entry and press F8 to select one of the options.

6. Click OK to save your settings.

INPUT DEVICE SETTING

Contour ShuttlePRO v2  Contour SP2

INPUT DEVICE SETTING

LK463 compatible keyboard  LK463

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: Press the Ctrl+F8 key combination to display a list of all options. Select the 
desired option and press Enter.
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Defining the EDID profile to be used

The EDID information (Extended Display Identification Data) of a monitor inform the 
graphics card of a connected computer about the technical features of the device.

The EDID profile of the monitor, which is connected to the console module, is not 
available at the computer module. Therefore, the computer module transmits a 
standard profile to the computer. The EDID information of this profile are opti-
mised for the majority of available graphics cards.

We provide additional profiles for special resolutions.

How to choose the EDID profile to be transmitted to the computer:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module whose settings you want to change and press F5.

5. Select the EDID entry and press F8 to choose between the standard profile (Device 
specific default profile) or another profile from the list.

6. Press F2 to save your settings.

ADVICE: In some cases it is recommended to read out the EDID profile of the console 
monitor (see page 186 f.) and activate the configuration of the computer module.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

default: activates the device-specific default profiles

user: activates a user-defined profile

NOTE: The names of the special G&D profiles provide information on the 
maximum resolution and refresh rate for the profile.

The GUD DVI1024D4 060 1280×1024/60 profile is provided for a resolution 
of 1280×1024 pixels at 60 Hz refresh rate.

IMPORTANT: Select the Assign EDID entry to choose the user-defined profile 
and press Enter.

Select the desired profile and press F8.

Press F2 to save your settings.
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Reducing the colour depth of the image data to be transmitted

In the default settings of a computer module, the central module transmits the image 
information with a maximum colour depth of 24 bit to the console module.

Using a high resolution and displaying moving images can result in the console
module “skipping” several images.

In such cases, reduce the colour depth of the image data to 18 bits. This way the 
data volume to be transmitted can be reduced.

How to change the colour depth of the image data to be transmitted:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module whose settings you want to change and press F5.

5. Use the Colour depth entry and press F8 to choose between the following options:

6. Press F2 to save your settings.

NOTE: Depending on the image contents, reducing the colour depth may result in 
slight colour grades.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

24 Bit: transmits the image data with a maximum colour depth of 24 bits

18 Bit: reduces the colour depth of image data to 18 bits
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Enhanced functions

Wake On LAN

Wake on LAN (WoL) is a standardized method to start a computer that is powered 
off or in sleep mode via a network command. If a WoL-compatible and accordingly 
configured computer receives a so-called magic packet on the LAN connection, the 
network card and BIOS initiate the startup process. In addition to the network card 
and the BIOS, the computer's operating system also needs to be configured accord-
ingly. 

The matrix switch also supports this function to use WoL in a KVM installation.

How to configure WoL function:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module whose settings you want to change and press F5.

5. Select the Wake on LAN entry and press Enter.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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6. Enter the following data:

7. Press F2 to save your settings.

How to send a WoL command to the defined computer:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F9 to call the Operation menu.

3. Press W or select the W - Wake on LAN entry and press Enter to send the WoL 
command to the defined computer.

Enable: Choose yes to enable or no to disable the WoL function.

MAC address: Enter the MAC address of the WoL-compatible and 
configured computer connected to the selected 
computer module.

Password: Enter a password if a password has been stored on the 
computer at the WoL setup.

Auto mode: Choose on to enable or off to disable the automatic 
Wake On LAN when connection to the defined com-
puter module.
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Displaying Multiuser information

If several users are accessing a computer module (Multiuser mode), the Multiuser 
information can be activated. This way, all accessing users are provided at the 
console module with the information how many users are connected to the 
computer module.

How to (de)activate the Multiuser information for the entire system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Multiuser display entry and press F8 to select one of the following options: 

5. Press F2 to save your settings.

How to (de)activate the Multiuser information for a particular user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Multiuser display entry and press F8 (repeatedly) to select one of the  
following settings.

4. Press F2 to save your settings.

NOTE: The setting to display the Multiuser information for the entire system are 
usually carried out in the Configuration menu. This setting of the Personal Profile 
menu enables you to individually configure this setting for each user account.

Both possibilities are described on this page.

yes: activates »Multiuser« display

no: deactivates »Multiuser« display

System: The global setting made in the Configuration menu applies for this 
user account.

on: displays Multiuser information 

off: does not display Multiuser information 
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Resetting the video profiles of a analog computer module

A video profile is created for each analog computer module (Bridge mode only). This 
video profile stores information on different cable parameters. This information 
ensures that an optimum video image is displayed at the monitor.

Changing the cable length between a computer module and the matrix switch can 
affect the image quality.

In this case, delete the existing video profiles of the computer module. When access-
ing the computer module the next time, a new profile is created at the workplace.

How to delete the stored video profiles of a computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the analog computer module (CATpro2) whose video profiles you want to 
delete and press F5.

5. Mark the entry Reset computer module video data and press Enter.

6. Use the arrow keys to mark the entry Yes and press Enter to confirm the appearing 
security request.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: Every time a connection without an existing entry in the video profile data-
base is established between the console module and the computer module, the 
image signal coming from the computer is switched off within the computer module. 
A test signal is created instead and transmitted to the console module.

With the aid of this test signal, the required parameters to display an optimized 
image are determined. If other users are trying to access this computer module at 
the same time, they receive a message regarding the video adjustment.

Depending on the cable length, the cable quality, and the connected monitor type, 
it takes between 5 and 10 seconds until the image is displayed again at these console 
modules.
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Viewing the route information of the computer module

The route information provides an overview of how the computer module is connected 
to the other devices of the matrix system.

How to view the route information:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Move the cursor to the computer module whose route information you want to 
view.

3. Press Ctrl + F12 to display the route information:

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

Route Information

CPU-Server 00005821
 Leader 000010BE
 Transmission  CPU 1
------------------------------
LEADER 000010BE
 CON-Admin 00001AEB
 Console 1  Transmission

ESC

NOTE: If the computer module is part of a channel group, press F8 to select the 
desired channel under Channel.
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The exemplary information window provides the following information:

 The CPU-Server computer module is connected to the Leader matrix switch. The 
devices are connected through the Transmission port of the computer module 
and the CPU 1 of the matrix switch.

 The CON-Admin console module is connected to the Leader matrix switch. The 
devices are connected through the Console 1 port of the matrix switch and the 
Transmission port of the console module.

ADVICE: The colour of the arrow shows the transmission medium and the type 
of connection.

 White:  copper cable (CAT), no active connection
 Turquoise: copper cable (CAT), a user is accessing the device
 Yellow: fibre cable, no active connection
 Purple: fibre cable, a user is accessing the device

NOTE: Any follower devices, which are connected to the leader device of the 
matrix system, are also displayed in the route information as long as the con-
nection between computer module and console module is established through 
the devices.
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Remote gateways and remote targets
The computer modules of the RemoteAccess-CPU series let you integrate virtual 
machines into a digital matrix switch. You can access these virtual machines via 
network.

Like other computer modules, the virtual machines connected via these computer
modules are integrated into the OSD and the operating concept of the matrix 
switch:

As usual, you connect to a virtual machine (remote target) via the Select menu in the 
OSD and can also use functions such as push-get, multi-user access or CrossDisplay-
Switching with these virtual machines.

The instructions and functions provided in the chapter Computer modules on 
page 103 ff. also apply for remote targets (apart from marked exceptions). 

To connect a remote target, you need to configure the remote gateway and the different 
remote targets.

NOTE: To establish a network connection to virtual machines, you can use the 
SSH, VNC or RDP protocol.

With the fee-based RemoteAccess Streaming Feature, streams can also be received via 
RTP/TCP, RTSP/TCP and MMSH transport protocols. The H.264, VP8 and VP9 codecs for 
decoding video data and MPGA, MP3 and AC3 for decoding audio data are supported.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

NOTE: The following terms are important to distinguish in connection with remote 
targets:

 Remote gateway: Each connected computer module of the RemoteAccess-CPU
series is listed under Remote Gateways in the web application.

Remote gateways establish a connection between a KVM matrix system and virtual 
machines.

 Remote targets: Configured virtual machines are called remote targets within a 
KVM matrix system. They are listed under Remote targets in the web application

 Remote pools: A remote pool groups all remote targets that are accessible via the 
remote gateways included in the pool.
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Configuring remote gateways

Configuring remote targets

Changing the name of a remote target

How to change the name of a remote target:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

IMPORTANT: The configuration of the remote gateway (name, comment and net-
work interface) is only possible in the web application. For detailed information, 
please refer to the separate manual of the web application.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

NOTE: The message »Name exists« is displayed if a computer module with the 
same name has already been connected to the system. 

The settings of such computer modules are stored within the matrix system and 
are only visible in the Config Panel web application. If necessary, use the web 
application to delete the computer module from the system. 

Afterwards, this name can be assigned to another computer module.
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Saving the resolution of a virtual machine

To make sure the video signal from the virtual machine is displayed correctly on the 
console modules, you need to provide information about the resolution set in the 
virtual machine.

How to save the resolution set in a virtual machine in the KVM matrix system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Use the Resolution entry and press F8 to choose between the following options:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

ADVICE: Press the Ctrl+F8 key combination to display a list of all options. Select 
the desired option and press Enter.

1024x768

1280x1024

1680x1050

1600x1200

1920x1200

2048x2160

2560x1440

2560x1600
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Reducing the colour depth of the image data to be transmitted

By default, a remote target transmits image information with a maximum colour 
depth of 24 bit to the console module.

When using a high image resolution and displaying moving images, it may happen in 
exceptional cases that some images are "skipped" on the console module.

In this case, reduce the colour depth of the image data to be transmitted to 18 bit. This 
can reduce the data volume to be transmitted.

How to reduce the colour depth of image data to be transmitted:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Use the Colour depth entry and press F8 to choose between the following options:

6. Press F2 to save your settings.

NOTE: Depending on the content of the image, slight colour gradations may occur 
when reducing the colour depth.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

24 Bit: Transmit image data with a maximum colour depth of 24 bits.

18 Bit: Reduce colour depth of image data to 18 bits.
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Remote gateways and remote targets
Holding a connection

In the default setting of the matrix switch, the existing connection is disconnected 
when switching from a remote target to a classic target or to a remote target of another 
pool. The connection to the classic target is then established.

You can also hold the connection to the remote target for a specified period of time 
(1 to 10 minutes). Within this time span, you can quickly continue the existing con-
nection by reconnecting to the console module.

How to set the hold period of a connection:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to rename and press F5.

5. Use the Keep session entry and press F8 to choose between the following options:

6. Press F2 to save your settings.

IMPORTANT: Activating this option may pose a security risk, since reconnecting to 
the remote target within the holding period does not require a new login!

NOTE: When connecting to another remote target of the same pool, the existing 
connection cannot be maintained, since only one connection via a remote gate-
way is possible at any time.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

ADVICE: Press the Ctrl+F8 key combination to display a list of all options. Select 
the desired option and press Enter.

no: Connection is not held.

× min: Hold connection × minute/s (1 to 10 minutes) long.

permanent: Connection is held permanently.
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Remote gateways and remote targets
Connection repeats

If the connection to a remote target is interrupted or not possible, you can configure 
a number and interval of connection repeats.

How to set the number and the interval of connection repeats:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Select the Number of connection repeats entry and press Enter.

6. Define the number of connection repeats (between 0 and 999) and press Enter.

7. Select the Reconnect delay entry and press Enter.

8. Define an intervall between 1 and 999 seconds at which several connection 
repeats are executed and press Enter.

9. Press F2 to save your settings.

NOTE: Connection repeats are disabled in the default settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Remote gateways and remote targets
Defining the basic connection parameters for a remote target

How to configure the basic connection parameters for a remote target:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Specify the IP address or virtual machine name in the Server line.

6. Use the Protocol entry and press F8 to choose between the following options:

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

SSH

VNC

RDP

Streaming
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Remote gateways and remote targets
Saving login data or use the matrix credentials for login

To automatically log on a user after connecting to the virtual machine, you can save 
the login data in the web application.

How to save the login data of a virtual machine:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Enter the following values:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

Use matrix 
credentials

Enable (Yes) or disable (No) this function.

Default: function is disabled.

If you enable this function, any remote target credentials 
(username and password) that may have been entered 
are ignored.

Username Enter the username of the user to log on.

Password Enter the password of the user to log on.

NOTE: Depending on the configuration of the virtual machine, it is sometimes 
necessary to enter both username and password; sometimes you only need to 
enter the password!
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Remote gateways and remote targets
Defining the RDP connection parameters for a remote target

How to configure the RDP connection parameters for a remote target:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Select the RDP line and press Enter.

6. Specify in the Port through which the connection to the Terminal Server is  
established.

7. Use the RemoteFX entry and press F8 to choose between the following options:

8. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

off: By default, RemoteFX optimisation is disabled.

Only enable RemoteFX Optimisation if the RDP server 
supports it!

image: RemoteFX optimisation for static images (Image) of a 
common desktop environment

video: RemoteFX optimisation for moving images (Video).
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Remote gateways and remote targets
Defining the VNC connection parameters for a remote target

How to configure the VNC connection parameters for a remote target:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Select the VNC line and press Enter.

6. Specify in the Port through which the connection to the Terminal Server is  
established.

7. Select the Quality line and press the F8 key to select the quality level 
between 0 (low) and 9 (high).

8. Select the Compression line and press the F8 key to select the compression level 
between 0 (fast) and 9 (best).

9. Use the Local cursor entry and press F8 to choose between the following options:

10.Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

off: Only the cursor of the virtual machine is displayed.

on: The local cursor (circle) of the RemoteAccess-CPU is dis-
played in addition to the cursor of the virtual machine.
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Remote gateways and remote targets
Defining the streaming connection parameters for a 
remote target

How to configure the streaming connection parameters for a remote target:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Select the Streaming line and press Enter.

6. In the Audio delay (ms) line, enter the delay in the range from -2500 to 2500 ms.

7. In the RTSP transport line, select the TCP or UDP protocol.

8. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Remote gateways and remote targets
Adjusting the mouse speed

If CrossDisplay-Switching is enabled, the mouse speed is not controlled by the operating 
system of the target computer, but by the matrix switch.

If the cursor on the monitor of the target computer moves too fast or too slow, you 
can adjust the speed in the matrix switch.

You can adjust the mouse speed for the entire system (see Adjusting the mouse speed on 
page 287) or for one computer module only.

How to change the mouse speed of a specific computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the remote target you want to configure and press F5.

5. Use the Mouse speed entry and press F8 to choose between the following options:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

System: Apply the system mouse speed setting for the
remote target

[value]: Use individual mouse speed (level 1 to 10).
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Console modules
Console modules
The computers connected to the KVM matrix system are operated at the console 
modules of the system.

Operating modes of console modules
Depending on the intended use of the console module, the module’s operating 
mode can be selected from the following three options:

Standard operating mode

The Standard operating mode only permits access to the matrix system after the user 
has entered their username, a password and, if two-factor authentication is activated, 
with an additional 2-Factor Auth Code (TOTP).

The user rights can be individually adjusted in the settings of the user accounts.

OpenAccess operating mode

In this mode, the access to the matrix system is not password-protected. 

For this console module, you can configure the same access rights as for a user account.

NOTE: The computers connected to the system can also be operated at a 
DynamicWorkplace-CON (DWC, see page 160).

NOTE: This operating mode is preset in the default.

IMPORTANT: The configured access rights apply for all users at this console module.
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Console modules
Video operating mode

A video console (only possible when combined with the optional Push/Get function, 
page 216) is especially suited when used with a projector since mouse and keyboard do 
not have to be connected. 

If the video console is provided with mouse and keyboard, inputs can only be made 
in the OSD.

It is possible to configure the same access rights for this console module as for a user 
account.

Selecting the console module operating mode

How to select the console module operating mode:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to configure and press F5.

5. Select the Console type entry and press F8 to select an access type:

6. Press F2 to save your settings.

IMPORTANT: The configured access rights apply for all users at this console module.

NOTE: A video console is not displayed. The accessing video console is therefore 
not highlighted to other accessing users. A user without Multiuser rights can access 
the console module simultaneously to the video console.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

Standard: Standard operating mode

OpenAccess: OpenAccess operating mode

Video: Video operating mode

NOTE: By selecting the OpenAccess or Video options, you can activate further sub-
menus to configure the access rights. 

The settings are explained in the chapter Administrating user accounts on page 81 ff.
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Console modules
Basic configuration of the console modules

Renaming a console module

How to rename a console module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Console modules
Enabling or disabling a console module

If you want to deny a console module the access to the matrix system, the console
module can be deactivated.

How to (de)activate the console module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to (de)activate and press F5.

5. Select the Enable entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

NOTE: After the console module has been deactivated, the monitor displays the 
message »This console has been disabled!«. It is therefore not possible to call the 
OSD or the login box.

If a user is currently accessing this console module, access is immediately withdrawn.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

yes: activate console module

no: deactivate console module
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Console modules
Copying the console module config settings

If a console module of the matrix system is replaced by another device, the config 
settings of the device can be copied to the new device.

The new device can be operated immediately.

How to copy the console module config settings:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the active console module to which you want to copy the config settings of 
an inactive or disconnected console module. Press F7.

5. Select the console module whose settings you want to copy and press Enter.

6. Use the arrow keys to select Yes and press Enter to respond to the prompt for  
confirmation.

7. Press F2 to save your settings.

IMPORTANT: The console module whose settings are to be copied is deleted from 
the system afterwards.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: This menu only list console modules that are switched off or discon-
nected from the system.
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Console modules
Deleting a console module from the matrix system

If the matrix system is not able to detect a console module that already has been 
connected to the system, the device is considered inactive.

Therefore, you have to manually delete the list entry of the console module you 
want to permanently remove from the system.

How to delete an inactive or disconnected console module from the system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

NOTE: Only inactive console modules can be deleted by the administrator and all 
users with the Superuser right.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Console modules
(De)Activating access to exclusive signals

There are signals that cannot be connected to several console modules and DWCs at 
the same time (e.g. Generic-HID, RS232, GPIO). In the default setting, the console 
module or DWC that connects to computer module first is given access to these 
exclusive signals.

It may be that the exclusive signals are not needed at this console module or DWC or 
that certain users should not have access to them. Therefore, access to the exclusive 
signals can be deactivated for console modules and DWCs (see How to (de)activate access 
to exclusive signals for a DWC: on page 167) as well as users and user groups.

How to (de)activate access to exclusive signals for a console module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the Exclusive signals entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

yes: Basically access to the exclusive signals (default)

no: No access to the exclusive signals

IMPORTANT: The user only has access to the exclusive signals if the access is 
enabled at the corresponding console module and the user has the correspond-
ing right (default).
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Console modules
Rights for access to exclusive signals

You can either change the global settings to allow access to exclusive signals (for all 
computer modules to which a user or a user group has access) or you can change the 
rights for particular computer modules or computer module groups only.

How to change the rights to access exclusive signals for all computer modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Global device rights entry and press Enter.

7. Select the Exclusive signals entry and press F8 (repeatedly) to select one  
of the following options:

8. Press F2 to save your settings.

NOTE: The access right depends on the user’s effective right (see page 79). The 
effective right is the highest right that results from the individual right of user 
accounts and the rights of assigned group(s).

yes: Basically access to the exclusive signals of the computer modules 
(default)

no: No access to the exclusive signals of the computer modules

IMPORTANT: The user only has access to the exclusive signals if the user has 
the corresponding right and the access is enabled at the corresponding console 
module or the corresponding DWC (default).
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Console modules
How to change the right to access exclusive signals for a certain computer module 
or computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change 
and press F5.

6. Select the Device rights: Excl. signals/Device group rights: Excl. signals entry and press 
Enter.

7. Select the computer module or computer module group whose rights you want to 
change.

8. Press F8 (repeatedly) to select one of the following options:

9. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

yes: Basically access to the exclusive signals of the computer module or 
computer module group (default)

no: No access to the exclusive signals of the computer module or 
computer module group

IMPORTANT: The user only has access to the exclusive signals if the user has 
the corresponding right and the access is enabled at the corresponding console 
module or the corresponding DWC (default).
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Console modules
Settings for special hardware

Adjusting the scancode set of a PS/2 keyboard

If a key is pressed on the PS/2 keyboard, the keyboard processor sends a data packet 
that is called scan code. The two common scan code sets (sets 2 and 3) contain dif-
ferent scan codes.

The KVM switch interprets all inputs of the PS/2 keyboard with scan code set 2.

If the pipe (“|”) cannot be entered or if the arrow keys of the keyboard do not work 
as expected, it is recommended to switch to scan code set 3.

How to select the scancode set of the PS/2 keyboard:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the Scancode set entry and press F8 to select the scancode sets 2 or 3.

6. Press F2 to save your settings.

7. Restart the console module to apply your changes.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Console modules
Support of any USB device

In the Generic USB/Generic HID mode, the data from the USB devices connected to the 
interface is transmitted to the active computer module.

In the Generic USB/Generic HID mode, you can connect USB hubs or USB composite 
devices to the Generic interface of the console module.

How to enable/disable the Generic USB/Generic HID mode of the console module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the Generic USB/Generic HID entry and press F8 to select the keyboard type:

6. Press F2 to save your settings.

NOTE: When the Generic USB/Generic HID mode is enabled, it is not possible to operate 
the OSD with a keyboard connected to the Generic interface.

NOTE: In multiuser mode, the generic USB device is available on the first active 
console module/the first active DWC. Once this console module/DWC logs off 
and another console module/another DWC logs in, the generic USB device of the 
other console module/the other DWC is available.

ADVICE: Use the menu’s search function or the sort criteria (see page 14 ff.) to limit 
the selection of list entries.

off: You can connect either a USB keyboard or a USB mouse to the 
Generic interface of the console module.

on: The data from any USB device connected to the Generic interface is 
transmitted to the active computer module.

IMPORTANT: To use the generic HID device, enable the USB HID mode 
Generic HID of the computer modules you want to access (see page 115).
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Console modules
Reinitialising USB input devices

After connecting a USB keyboard or mouse to the console module, the input devices 
are initialised and can be used immediately.

Some USB input devices require a reinitialisation of the USB connection. Enable 
the automatic reinitialisation of USB devices if a USB keyboard or mouse does not 
respond to your inputs during operation.

How to enable/disable the reinitialisation of USB devices:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the USB Auto Refresh entry and press F8 to select the keyboard type:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 19 ff.) to limit 
the selection of list entries.

off: The status of the USB devices is not monitored. 
If communication to a USB device is interrupted, the 
device is not reinitialised.

all: The status of the USB devices is monitored. 
If communication to one USB device is interrupted, 
all devices are reinitialised.

only faulty: The status of USB devices is monitored. 
If the communication with a USB devices is interrupted, 
this device is reinitialised (recommended setting).
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Console modules
Enhanced functions

Setting the auto user logout

The console module can be configured so that it auto-disconnects the access to the 
computer module after a user has been inactive for a certain amount of time. After 
the configured period of time, the user is logged out from the matrix system.

How to set the auto user logout:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the Auto logout (min) entry and press Enter.

6. Enter a number between 1 and 999 minutes to set the auto logout and press Enter.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: The value »0« deactivates the automatic user logout.
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Console modules
Auto-disconnecting the access to a computer module

The console module can be configured so that the active access to a computer module is 
auto-disconnected after the user has been inactive for a certain amount of time.

If the OSD is opened at the moment of disconnection, it remains on the screen even 
after it has been auto-disconnected.

In case the OSD is closed at the moment of disconnection, 
the message displayed on the right appears on the screen 
of the console console.

How to auto-disconnect the access to a computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the Auto disconnect (min) entry and press Enter.

6. Enter a number between 1 and 999 minutes to start the screensaver and press Enter.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: The value »0« deactivates the auto disconnection when a computer
module is accessed.

CON-Admin
Not connected
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Console modules
Adjusting the logoff procedure of CON-2 console modules

You can connect CON-2 console modules to up to two digital matrix switches of the 
ControlCenter-Digital or the ControlCenter-Compact series.

The button on the front panel of the console module or configured key combina-
tions (select keys) let you switch between the connected matrix switches.

In the defaults of the matrix switches, the existing connection between the first and 
the second matrix switch is disconnected via logout during a switching operation 
while the connection to the second matrix switch is established. Due to the logout 
users are required to logon again after each switching operation.

In the settings of the matrix switches connected to the console module you can 
adjust that the connection is not disconnected via logout when switching but that it 
should be held. If you switch back to the matrix switch at a later point, you can con-
tinue work without having to log on again.

How to adjust the logoff procedure of CON-2 console modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

IMPORTANT: Activating this option can pose a security risk since other users can 
switch your session at this console module without having to log on again!

IMPORTANT: Adjust this setting separately for both matrix switches connected to 
the console module.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Console modules
5. Select the Stay connected to the matrix entry and press F8 to select the keyboard type:

6. Press F2 to save your settings.

Channel auto-switching for CON-2 console modules

You can connect CON-2 console modules to up to two digital matrix switches of the 
ControlCenter-Digital or the ControlCenter-Compact series.

The buttons on the front panel of the console module or configured key combina-
tions (select keys) let you switch between the connected matrix switches.

You can configure the matrix switch to automatically switch to the other channel 
when a connection is lost on the channel selected by the user.

How to configure the channel auto-switching for CON-2 console modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

No: When switching to the second channel of the console module, the 
existing connection is disconnected via logout (default).

Yes: When switching to the second channel of the console module, the 
existing connection is held. If you switch back to the matrix switch at a 
later point, you can continue work without having to log on again

ADVICE: For example, you can use this function to automatically switch to a 
redundant matrix switch when a connection to the matrix switch or to the 
computer module is terminated.

IMPORTANT: Change this setting separately for both matrix switches connected to 
the console module.
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Console modules
4. Select the console module whose settings you want to change and press F5.

5. Select the Channel auto-switching entry and press F8 to select the keyboard type:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

never: The channel accessed by the user is maintained in case of a 
disconnection (default).

online: If a connection is terminated, the device auto-switches to the other 
channel if this channel has an active connection.

always: If a connection is terminated, the device auto-switches to the other 
channel regardless of the conenction status of the other channel.
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Console modules
Viewing information about the console modules

The Console status menu provides detailed information about the console modules 
and displays e.g. the unique ID, the accessing user, and the firmware version.

How to call detailed information about the console modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F12 to call the Information menu.

3. Select the Console status entry and press Enter.

4. Press F8 (repeatedly) to select the information to be displayed in the right-hand 
column:

5. Press Esc to leave the menu.

ID: displays unique device ID

Port: displays connection port at matrix switch

User: displays active user

Computer  
module:

displays accessing computer module

Firmware: displays firmware version of the console module

Type: displays operating type of the console module

Comment: displays a comment about the console module

ADVICE: Press Enter to show the comment viewer of the 
console module. Press F5 to switch to the comment editor.
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Remembering the user name in the login box

If the same user often works at a certain console module, their user name can be 
saved as default in the login box.

After a user has logged out of the system, the login box remembers the user name of 
the last active user.

How to remember the username in the login box:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings you want to change and press F5.

5. Select the Remember last username entry and press F8 to select one of the following 
options:

6. Press F2 to save your settings.

Setting the hold time for the screensaver

The screensaver deactivates the screen display at the console module after the user 
has been inactive for a configurable amount of time.

How to set the hold time of the screensaver:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

yes: remember last user name 

no: do not remember last user name

NOTE: This setting works independently from the screensaver settings of the com-
puter.
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4. Select the console module whose settings are you want to change and press F5.

5. Select the Screensaver (min) entry and press Enter.

6. Enter a number between 1 and 999 minutes to activate the screensaver and press 
Enter.

7. Press F2 to save your settings.

Setting the hold time for the login screensaver

The screensaver deactivates the screen display at the console module after the user 
has been inactive for a configurable amount of time.

How to set the hold time of the screensaver:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings are you want to change and press F5.

5. Select the Login Screensaver (min) entry and press Enter.

6. Enter a number between 1 and 999 minutes to activate the screensaver and press 
Enter.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 15 f.) to limit 
the selection of list entries.

ADVICE: The value »0« deactivates the screensaver.

NOTE: This setting works independently from the screensaver settings of the com-
puter.

ADVICE: Use the menu’s search function or the sort criteria (see page 19 f.) to limit 
the selection of list entries.

ADVICE: The value »0« deactivates the screensaver.
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Enabling or disabling DDC/CI support

Most of the computer and console modules supported by the ControlCenter-Compact 
system are ready to support monitors with DDC/CI functionality.

After the function has been activated, the DDC/CI information is transparently for-
warded to the monitor in order to support as many monitors as possible. However, 
we cannot guarantee the support for all monitors.

You can set the DDC/CI support for the entire system. The system-wide setting is used 
by all console modules. In addition, you can define these settings for each console 
module individually.

How to configure the sytem-wide setting of the DDC/CI support:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the DDC/CI support entry and press F8 to select the desired option:

5. Press F2 to save your settings.

NOTE: The paragraph Technical data of the manuals of the computer and console
modules shows which modules (after an update to the latest firmware) support 
DDC/CI.

Disabled: The transmission of DDC/CI signals is disabled (default).

CPU > monitor: The transmission of DDC/CI signals is carried out 
exclusively from the computer module to the monitor.

Bidirectional: The transmission of DDC/CI signals is carried out by 
bidirectionally.
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How to configure the individual settings of the DDC/CI support of a console 
module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module whose settings are you want to change and press F5.

5. Select the DDC/CI support entry and press F8 to select the desired option:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

System: Use system-wide setting (see above).

Disabled: The transmission of DDC/CI signals is disabled (default).

CPU > monitor: The transmission of DDC/CI signals is carried out 
exclusively from the computer module to the monitor

Bidirectional: The transmission of DDC/CI signals is carried out by 
bidirectionally.
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DynamicWorkplace-CONs
A DynamicWorkplace-CON (DWC) enables you to simultaneously display and 
operate several computer modules on one or several monitors.

Operating modes of DWCs
Depending on the intended use, you can select the DWC operating mode from the 
following options:

Standard operating mode

The Standard operating mode only permits access to the matrix system after the user 
has entered their username, a password and, if two-factor authentication is activated, 
with an additional 2-Factor Auth Code (TOTP).

The user rights can be individually adjusted in the settings of the user accounts.

OpenAccess operating mode

In this mode, the access to the matrix system is not password-protected. 

For this DWC, you can configure the same access rights as for a user account.

NOTE: The computers connected to the system can also be operated at console 
modules (see page 138 ff.).

NOTE: This operating mode is preset in the default.

IMPORTANT: The configured access rights apply for all users at this DWC.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.
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Selecting the DWC operating mode

How to select the DWC operating mode:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC you want to configure and press F5.

5. Select the Console type entry and press F8 to select an access type:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

Standard: Standard operating mode

OpenAccess: OpenAccess operating mode

NOTE: By selecting the OpenAccess option, you can activate further submenus to 
configure the access rights. 

The settings are explained in the chapter Administrating user accounts on page 81 ff.
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Basic configuration of a DWC

Renaming a DWC

How to rename a DWC:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Renaming a DWC transmission channel

How to rename a  DWC transmission channel:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC you want to change and press Enter.

5. Select the Channel entry and press Enter.

6. Select the channel you want to rename and press F5.

7. Select the Name entry and press Enter.

8. Enter the new name and press Enter.

9. Press F2 to save your settings.

NOTE: The configuration of a specific DWC transmission channel is only possible 
after a connection between the matrix switch and the DWC transmission channel 
has been established at least once. Prior to this, the transmission channel is not in 
the database, is not displayed and cannot be configured as a result.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Enabling or disabling a DWC

If you want to deny a DWC the access to the matrix system, the DWC can be 
deactivated.

How to (de)activate a DWC:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC you want to (de)activate and press F5.

5. Select the Enable entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

NOTE: If the DWC is disabled, the monitors display the message »Console disabled 
- This console has been disabled«. It is therefore not possible to open the login box.

If a user is accessing this DWC, access is immediately withdrawn.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

yes: activate DWC

no: deactivate DWC
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Transfer configuration settings to a new DWC

If a DWC of the matrix system is replaced by another device, the config settings of 
the device can be copied to the new device.

The new device can be operated immediately.

How to copy the DWC config settings:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the active DWC to which you want to copy the config settings of an 
inactive or disconnected DWC. Press F7.

5. Select the DWC whose settings you want to copy and press Enter.

6. Use the arrow keys to select Yes and press Enter to respond to the prompt for  
confirmation.

7. Press F2 to save your settings.

IMPORTANT: The DWC whose settings are to be copied is deleted from the system
afterwards.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: This menu only list DWCs that are switched off or disconnected from 
the system.
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Deleting a DWC from the matrix system

If the matrix system is not able to detect a DWC that already has been connected to 
the system, the device is considered inactive.

Therefore, you have to manually delete the list entry of the DWC you want to 
permanently remove from the system.

How to delete an inactive or disconnected DWC from the system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

NOTE: Only inactive DWCs can be deleted by the administrator and all users with 
the Superuser right.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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(De)Activating access to exclusive signals

There are signals that cannot be connected to several console modules and DWCs at 
the same time (e.g. Generic-HID, RS232, GPIO). In the default setting, the console 
module or DWC that connects to computer module first is given access to these 
exclusive signals.

It may be that the exclusive signals are not needed at this console module or DWC or 
that certain users should not have access to them. Therefore, access to the exclusive 
signals can be deactivated for console modules (see How to (de)activate access to exclusive 
signals for a console module: on page 144) and DWCs as well as users and user groups.

How to (de)activate access to exclusive signals for a DWC:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC whose settings you want to change and press F5.

5. Select the Exclusive signals entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

yes: Basically access to the exclusive signals (default)

no: No access to the exclusive signals

IMPORTANT: The user only has access to the exclusive signals if the access is 
enabled at the corresponding DWC and the user has the corresponding right 
(default).
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Rights for access to exclusive signals

You can either change the global settings to allow access to exclusive signals (for all 
computer modules to which a user or a user group has access) or you can change the 
rights for particular computer modules or computer module groups only.

How to change the rights to access exclusive signals for all computer modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change and 
press F5.

6. Select the Global device rights entry and press Enter.

7. Select the Exclusive signals entry and press F8 (repeatedly) to select one  
of the following options:

8. Press F2 to save your settings.

NOTE: The access right depends on the user’s effective right (see page 79). The 
effective right is the highest right that results from the individual right of user 
accounts and the rights of assigned group(s).

yes: Basically access to the exclusive signals of the computer modules 
(default)

no: No access to the exclusive signals of the computer modules

IMPORTANT: The user only has access to the exclusive signals if the user has 
the corresponding right and the access is enabled at the corresponding console 
module or the corresponding DWC (default).
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How to change the right to access exclusive signals for a certain computer module 
or computer module group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing the right of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose rights you want to change 
and press F5.

6. Select the Device rights: Excl. signals/Device group rights: Excl. signals entry and press 
Enter.

7. Select the computer module or computer module group whose rights you want to 
change.

8. Press F8 (repeatedly) to select one of the following options:

9. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

yes: Basically access to the exclusive signals of the computer module or 
computer module group (default)

no: No access to the exclusive signals of the computer module or 
computer module group

IMPORTANT: The user only has access to the exclusive signals if the user has 
the corresponding right and the access is enabled at the corresponding console 
module or the corresponding DWC (default).
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Settings for special hardware

Support of any USB device

In the Generic USB mode, the data from the USB devices connected to the interface is 
transmitted to the active computer module.

In the Generic USB mode, you can connect USB hubs or USB composite devices to 
the Generic interface of the DWC.

How to enable/disable the Generic USB mode of the DWC:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC whose settings you want to change and press F5.

5. Select the Generic USB entry and press F8 to select the keyboard type:

6. Press F2 to save your settings.

NOTE: When the Generic USB mode is enabled, it is not possible to operate the 
WindowManager with a keyboard connected to the Generic interface.

NOTE: In multiuser mode, the generic USB device is available on the first active 
console module/the first active DWC. Once this console module/DWC logs off 
and another console module/another DWC logs in, the generic USB device of the 
other console module/the other DWC is available.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

off: You can connect either a USB keyboard or a USB mouse to the 
Generic interface of the DWC.

on: The data from any USB device connected to the Generic interface of 
the DWC is transmitted to the active computer module.

IMPORTANT: To use a generic USB device, enable the USB HID mode 
Generic USB of the computer modules you want to access.
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Reinitialising USB input devices

After connecting a USB keyboard or mouse to the DWC, the input devices are 
initialised and can be used immediately.

Some USB input devices require a reinitialisation of the USB connection. Enable 
the automatic reinitialisation of USB devices if a USB keyboard or mouse does not 
respond to your inputs during operation.

How to enable/disable the reinitialisation of USB devices:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC whose settings you want to change and press F5.

5. Select the USB Auto Refresh entry and press F8 to select the keyboard type:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

off: The status of the USB devices is not monitored. 
If communication to a USB device is interrupted, the 
device is not reinitialised.

all: The status of the USB devices is monitored. 
If communication to one USB device is interrupted, 
all devices are reinitialised.

only faulty: The status of USB devices is monitored. 
If the communication with a USB devices is interrupted, 
this device is reinitialised (recommended setting).
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Enhanced functions

Setting the auto user logout

The DWC can be configured so that it auto-disconnects the accesses to the 
computer modules after a user has been inactive for a certain amount of time. After 
the configured period of time, the user is logged out from the matrix system.

How to set the auto user logout:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC whose settings you want to change and press F5.

5. Select the Auto logout (min) entry and press Enter.

6. Enter a number between 1 and 999 minutes to set the auto logout and press Enter.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: The value »0« deactivates the automatic user logout.
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Remembering the user name in the login box

If the same user often works at a certain DWC, their user name can be saved as 
default in the login box.

After a user has logged out of the system, the login box remembers the user name of 
the last active user.

How to remember the user name in the login box:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC whose settings you want to change and press F5.

5. Select the Remember last username entry and press F8 to select one of the following 
options:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

yes: remember last user name 

no: do not remember last user name
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Defining the primary mouse button

The DWC WindowManager is optimized for mouse operation. 

How to change the primary mouse button for a user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account you want to configure and press F5.

5. Select Personal Profile and press the Enter key.

6. Select the DynamicWorkplace-CON entry and press Enter.

7. Select the Primary mouse button entry and press F8 to select one of the following 
options:

8. Press F2 to save your settings.

ADVICE: Mouse operation can be optimized for right-handed or left-handed users. 
For right-handed operation, the primary mouse button is placed on the left-hand 
side of the mouse (default). For left-handed operation, the primary mouse button 
can be placed on the right-hand side of the mouse.

left Primary mouse button on the left side of the mouse (default)

right Primary mouse button on the right side of the mouse
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Defining the delay before focusing by mouseover

In the DWC WindowManager, it is possible to operate a window via mouseover, 
even if this window is not in the foreground. Depending on the configuration, it 
may also be necessary to click on the window to bring it to the foreground.

How to change the delay before focusing by mouseover for a user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account you want to configure and press F5.

5. Select Personal Profile and press the Enter key.

6. Select the DynamicWorkplace-CON entry and press Enter.

7. Select the Focus via mouse (s) entry and press Enter.

8. Enter the desired delay in seconds (default: 0.0 = no delay).

9. Press F2 to save your settings.

IMPORTANT: If a computer module is activated in a window of the DWC, which 
is operated via relative mouse coordinates, the window cannot be operated when 
moving the mouse over it.
175 · ControlCenter-Compact



DynamicWorkplace-CONs
Show window frames

By default, windows in the WindowManager of a DWC do not have a frame. You 
can activate a frame for all windows in a user profile.

How to change the window frame display for a user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account you want to configure and press F5.

5. Select Personal Profile and press the Enter key.

6. Select the DynamicWorkplace-CON entry and press Enter.

7. Select the Window frames entry and press F8 to select one of the following options:

8. Press F2 to save your settings.

off Window frames deactivated (default)

on Window frames activated
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Selecting a keyboard layout for WindowManager entries

If the characters entered on the DWC keyboard deviate from the characters dis-
played on the WindowManager, the selected keyboard layout does not fit the key-
board.

In this case, please ascertain which keyboard layout does apply to the connected 
keyboard and select the layout in the DWC settings.

How to select the keyboard layout for the DWC keyboard:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC whose settings you want to change and press F5.

5. Select the Keyboard layout entry and press F8 to select one of the following options:

6. Press F2 to save your settings.

german: Germany

english US: USA

english UK: Great Britain

french: France

spanish: Spain

lat. americ: Latin America

portuguese: Portugal

swedish: Sweden

swiss-french: Switzerland

danish: Denmark
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Changing the DWC MainNav key to open the DWC main 
navigation

The DWC MainNav key to open the DWC main navigation is used on the DWCs 
connected to the KVM matrix system. This DWC MainNav key enables you to 
open the main navigation in order to operate the system.

The DWC MainNav key consists of at least one DWC MainNav key modifier key 
and an additional DWC MainNav key, which you can freely select.

Both the DWC MainNav key modifier key and the Num DWC MainNav key can be 
configured by the user.

How to change the DWC MainNav key to open the main navigation:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the DWC MainNav Key entry and press Enter.

5. Use the arrow keys to select at least one of the DWC MainNav Key modifiers listed 
in the Modifier entry. Afterwards, press F8.

NOTE: The DWC MainNav key Num is the default DWC MainNav key. By 
default there is no DWC MainNav key modifier.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift Shift key
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6. Select the Valid keys entry and press F8 to select one of the following options:

7. Click on Save.

Changing the hotkey to open the Window Menu

The hotkey to open the OSD is used on the console modules connected to the KVM 
matrix system. On a DWC, this hotkey can be used to open the Window Menu.

Opening the Window Menu via double keypress

Instead of opening the Window Menu with a hotkey, you can define a key to press 
twice to open the Window Menu.

Pause Pause key

Insert Insert key

Delete Delete keye

Home Home key

PgUp Page up key

PgDown Page down key

Num Num key

End End key

Space Space key

NOTE: Information on changing the hotkey can be found in the chapter Changing 
the hotkey to call the OSD on page 23 ff..

NOTE: Information on changing this key can be found in the chapter Opening the 
OSD via double keypress on page 25 ff..
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Calling presets via DWC preset keys
After you have configured DWC preset key modifier key(s) and a DWC preset key set, 
and enabled a DWC preset key set in the user account, you can call a preset using key 
combinations on the keyboard of the DWC.

How to call a preset via DWC preset keys:

1. Press the DWC preset key modifier(s) that have been adjusted in the matrix 
system and the DWC preset key assigned to the preset.

Further information:
 Changing the DWC preset key modifier and the valid keys on page 180
 Creating a DWC preset key set on page 182
 Assigning a DWC preset key set to a user account on page 185

Changing the DWC preset key modifier and the valid keys

DWC preset keys enable you to quickly call a previously saved status with a key 
combination. For this, you can create DWC preset key sets in the KVM matrix system.

Both the DWC preset key modifier and a DWC preset key set define the key 
combination to be pressed to call a particular preset.

You can also define valid keys for the DWC preset keys.

How to change the DWC preset key modifier or the valid keys:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select System entry and press Enter.

4. Select the DWC preset key entry and press Enter.

EXAMPLE: 

 DWC preset key modifiers: Alt Gr+Shift
 DWC preset key for preset: 1

Press Alt Gr+Shift and the DWC preset key 1. As soon the keys are released, 
the calling of the preset takes place.
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5. Use the arrow keys to select at least one of the DWC preset key modifiers listed in 
the Modifier entry. Afterwards, press F8.

6. Select the Valid keys entry and press F8 to select one of the following options:

7. Press F2 to save your settings.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift Shift key

Num: only numerical keys are interpreted as DWC preset keys when 
pressed in combination with the DWC preset key modifier

Alph: only alphabetic keys are interpreted as DWC preset keys when 
pressed in combination with the DWC preset key modifier

AlphNum: alphabetical and numerical keys are interpreted as DWC preset 
keys when pressed in combination with the DWC preset key 
modifier

IMPORTANT: Both the selected valid keys and the DWC preset key modifier are 
no longer provided as key combinations to the operating system and the 
applications on the computer.
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Creating a DWC preset key set

Within the DWC preset key sets, you can define the DWC preset key sets for the presets 
you wish to call.

How to create a DWC preset key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC preset key set entry and press Enter.

5. Press F3 and enter the following data in the Add DWC Preset Key Set menu:  

6. Press F2 to save your inputs and to create the DWC preset key sets.

Name: Enter the new DWC preset key set name and press Enter.

Global: Select yes by pressing F8 if you want the DWC preset key set in 
the Personal Profile menu to be available for all users of the 
system.

default: no

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).
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Changing a DWC preset key set

How to change the name and/or Global setting of a DWC preset key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC preset key set entry and press Enter.

5. Select the DWC preset key set whose setting you want to change.

6. Press F5 to change the following data in the Edit DWC Preset Key Set menu: 

7. Press F2 to save your settings.

Name: Enter the new DWC preset key set name and press Enter.

Global: Select yes by pressing F8 if you want the DWC preset key set in 
the Personal Profile menu to be available for all users of the 
system.

default: no

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).
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Defining the DWC preset keys for the presets

How to define the DWC preset keys for presets:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC preset key set entry and press Enter.

5. Choose a DWC preset key set and press F5.

6. Select the Members entry and press Enter.

The Assign DWC Preset Key Set dialogue opens. The left column displays the name 
of the preset(s) and the right column shows the assigned DWC preset key(s).

7. Select the preset you want to assign a DWC preset key to or whose DWC preset 
key you want to change.

8. Press F5 and enter the desired DWC preset key.

9. If you want to create or change the DWC preset keys for other presets, repeat 
steps 6 and 7.

10.Press F2 to save your settings.

NOTE: Global DWC preset key sets can only be edited by users with activated 
Superuser right (see page 93).

Without this right, only the DWC preset keys of the current user can be viewed. 

ADVICE: Use the menu’s search function, the view filter or the sort criteria
(see page 20 ff.) to limit the selection of list entries.

NOTE: The chapter Changing the DWC preset key modifier and the valid keys on 
page 180 provides information on how to use valid keys as DWC preset key 
set.
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Assigning a DWC preset key set to a user account

By assigning a DWC preset key set to a user account, the DWC preset keys defined 
in the set are interpreted and the particular preset is accessed.

How to assign a DWC preset key set to a user account or cancel the existing 
assignment:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC preset key set entry and press Enter.

5. Select the desired DWC preset key set.

6. Press F8 to (de)activate the assignment.

7. Press F2 to save your settings.

Deleting a DWC preset key set

How to delete a DWC preset key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the DynamicWorkplace-CON entry and press Enter.

4. Select the DWC preset key set entry and press Enter.

5. Select the DWC preset key set you want to delete and press F4.

6. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

NOTE: An assigned DWC preset key set is marked with an arrow ().

NOTE: Only users with the Superuser right (see page 93) are allowed to delete a global 
DWC preset key set.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Administrating EDID profiles
The EDID information (Extended Display Identification Data) of a monitor inform the 
graphics card of a connected computer about various technical features of the 
device.

The EDID profile of the monitor that is connected to the console module, is not 
available at the computer module. Therefore, the computer module transmits a 
standard profile to the computer. The EDID information of the profile are 
optimised for the majority of available graphics cards.

We provide additional profiles for special resolutions.

Importing the EDID profile of a monitor

How to import the EDID profile of a connected monitor:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the EDID entry and press Enter.

4. Press F3.

5. Select the console module to which the monitor whose EDID profile you want to 
import is connected to and press Enter.

The imported data is displayed in the Add EDID entry.

6. If you wish, you can rename the EDID profile.

7. Press F2 to save the imported EDID profile.

ADVICE: In some cases it is recommended to read out the EDID profile of the 
monitor of the console module (see page 118) and then activate the configuration of 
the computer module.

NOTE: An EDID profile can either be imported from a bin file or directly from a 
monitor, which is connected to the console module.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Renaming the EDID profile of a monitor

How to rename an existing EDID profile:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the EDID entry and press Enter.

4. Choose the EDID profile you want to rename and press F5.

5. Rename the EDID profile.

6. Press F2 to save your settings.

Deleting the EDID profile of a monitor

How to delete an EDID profile:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the EDID entry and press Enter.

4. Choose the EDID profile you want to delete and press F4.

5. Respond to the confirmation prompt by selecting Yes and press Enter.

Defining the EDID profile to be applied for a computer module

In some cases it is recommended to read out the EDID profile of the console moni-
tor and then activate the configuration of the computer module.

Detailed information regarding this topic is provided on page 118.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Special functions for cascaded KVM 
matrix systems
Cascading allows you to increase the number of computer modules, which can be 
connected to the KVM matrix system. For this, several matrix switches are integrated 
into the system.

This chapter describes the configuration settings for a cascaded KVM matrix switch.

Basic functions

Renaming the leader matrix switch

How to rename a matrix switch:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Name entry and press Enter.

5. Enter the new name and press Enter.

6. Press F2 to save your settings.

Renaming a follower matrix switch

How to rename a follower matrix switch:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Cascade entry and press Enter.

4. Select the matrix switch you want to rename and press F5.

5. Select the Name entry and press Enter.

6. Enter the new name and press Enter.

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Deleting a follower matrix switch from the system

If the matrix system is not able to detect a matrix switch that has already been con-
nected to the system, the switch is considered as inactive.

Therefore, you have to manually delete the list entry of a matrix switch that you 
want to permanently remove from the system.

How to delete a matrix switch that is switched off or disconnected from the system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Cascade entry and press Enter.

4. Select the matrix switch you want to rename and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation. 

NOTE: Only inactive matrix switches can be deleted by the administrator and by 
all users with the Superuser right.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Configuration settings

Defining the cascade mode of a matrix switch

In a cascaded KVM matrix system, the single matrix switches auto-detect if they 
have been installed as leader or follower device within the cascaded system.

How to change the cascade mode of a matrix switch:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4.  Select the Cascade mode entry and press F8 to choose between the following options:

5. Press F2 to save your settings.

NOTE: Using the Auto setting in the cascade mode can change the matrix switch’s 
operating mode if the devices’ cabling has been changed by accident.

In order to avoid this, the operating mode of every matrix switch can be 
separately adjusted in the OSD.

Auto: The matrix switch decides whether it is operating in the leader or 
follower mode.

Leader: In this operating mode, only console modules can be connected to 
the Console ports. The names of the connected computer modules 
can be edited. The edited names are auto updated at the follower 
devices within the cascade.

Follower: In this operating mode, the connected computer modules cannot 
be renamed. The computer modules are auto named by the 
leader device.
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Forwarding computer modules names to the follower matrix 
switches

Within a cascaded KVM matrix system, the computer module names from the supe-
rior matrix switch are forwarded to the connected matrix switch(es). This way, the 
computer modules are named identically across the entire system.

If you want to define different computer module names within the different matrix 
switches of the cascaded system, deactivate the Forward target names function.

How to (de)activate the forwarding of target names to the follower matrix 
switches:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Forward target names entry and press F8 to choose between the following 
options:

5.  Press F2 to save your settings.

IMPORTANT: Deactivating the function for forwarding the target names in the 
first level of the matrix switch only affects the directly connected matrix switches 
of the second level. 

If the third level also includes follower matrix switches, this function has to be 
deactivated in the matrix switches of the second level!

On: The computer module names are forwarded from the superior 
matrix switch to the connected matrix switch(es).

Off: The computer module names are not forwarded from the superior 
matrix switch to the connected matrix switch(es).
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Expanding switchable signals
You can expand a computer’s or a console’s switchable signals through channel grouping.

With the ControlCenter-Compact, you can switch various computer modules of one
computer or various console modules of one console at the same time.

In the Config Panel web application, you can assign the KVM channel of a computer 
or console with up to seven additional video channels and a USB or RS232 channel.

EXAMPLE: To transmit a second video signal and a USB 2.0 signal of the same 
computer, in addition to the first computer module, connect a second computer 
module (second video channel) and a U2+R-CPU module (USB2.0/RS232) to the 
computer.

In addition to the first console module, connect a second console module (second 
video channel) and a U2+R-CON module (USB2.0/RS232) to the console, the 
aforementioned computer is accessing.

IMPORTANT: A DWC and its channels cannot be part of a channel grouping.

NOTE: Only in this mode, you can hold the USB signal using the OSD’s Operation
menu at the currently accessed computer. If you switch to another computer after 
pressing the hold function, the USB signal remains on the computer that you 
accessed first.

After disabling the hold function on the Operation menu, the USB signal switches to 
the currently accessed computer.
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Expanding through channel grouping
The Config Panel web application (see separate manual) lets you assign up to seven 
additional video channels, one USB 2.0 or RS 232 channel and four multi channels to 
the KVM channel of the console.

You can assign up to seven additional video channels to the KVM channel of the com-
puter, too. In addition, you can create pools of four devices for the USB 2.0/RS 232 
channel and for each of the four multi-channels.

By using pools, you can grant up to four users the right to access the USB 2.0/
RS 232 channel and the four multi-channels at the same time. For this, the matrix switch 
selects an available device from the pool after switching.

Assigning multiple ports to a console or computer creates a channel group.

NOTE: Within the channel groups of the console a USB 2.0/RS 232 channel or a 
multi-channel represent one single device. For computers such a channel repre-
sents a group of up to four devices.

NOTE: The OSD does not show any console or computer modules that you added 
as additional channels to the channel group.
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Shared editing
The matrix system enables two users with the respective rights to edit the settings at 
the same time.

If two users simultaneously change the user account settings, for example, the OSD 
informs the other user about these changes:

 The upper row of the footer displays a purple message, which highlights the 
changes of the other user.

 The changed setting or the menu item in the submenu ,which contains this set-
ting, is displayed in green.

If you made changes in this sector, the following options are provided to process the 
entered data when leaving the menu (by pressing Esc):

Save: In order to save the changes, select this menu entry with the Tab key 
or the arrow keys and press Enter.

Discard: In order to discard the changes, select this menu entry with the Tab
key or the arrow keys and press Enter.

Cancel: In order to cancel the data storage, select this menu entry with the 
Tab key or the arrow keys and press Enter.

Your values are displayed again.

Load: In order to load the current values from the databank, select this 
menu entry with the Tab key or the arrow keys and press Enter.
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System settings and functions

Renaming the matrix switch

How to rename the matrix switch:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Name entry and press Enter.

5. Enter the new name and press Enter.

6. Press F2 to save your settings.

Select language
The specified system language is assigned to all user accounts by default. If required, 
you can permanently assign a (different) language to each user account.

How to set the system language:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Language line and press the F8 key to select the desired language.

5. Press F2 to save your settings.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

NOTE: All language settings apply to the web application as well as to the  
on-screen display (OSD) of the device and the user interface of a DWC.
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How to set the language of a specific user account:

How to change the password of your user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account you want to configure and press F5.

5. Select the Personal Profile line and press the Enter key.

6. Select the Language line and press the F8 key to select the desired language.

7. Press F2 to save your settings.

Restoring the connection state after a restart
If you enable the function to Restore connection state, after every restart the matrix 
switch automatically logs in the last active users at the console modules. Then the 
connection to the last accessing computer modules are automatically restored.

How to enable or disable the restore of connection states:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Restore connection state entry and press F8 to select the desired option:

5. Press F2 to save your settings.

NOTE: The original access order is not considered when restoring the connection 
state. This can result in restrictions when using the multi-user mode.

on: After you restart the matrix switch, the last connection states 
are restored.

off: After you restart the matrix switch, the login box is displayed 
at all console modules (default).
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Freeze mode
When the cable connection between the computer module and the console module 
or the DWC is lost during operation, the console monitor or the corresponding win-
dows of a DWC no longer show an image in the default settings of the KVM matrix 
system.

Enable the freeze mode if you want to display the last image received at the console 
module or in the corresponding windows of a DWC before the loss of connection. 
This image is displayed until the connection is re-established.

You can set the freeze mode for the entire system, too. The setting for the entire system 
applies to all console modules and DWC channels. In addition, you can set the freeze 
mode individually for each console module and each DWC channel.

ADVICE: To emphasize the lost connection, the image last received is either high-
lighted by a coloured frame at a console module or a coloured title bar in the cor-
responding windows at a DWC and/or the note Frozen at a console module or an 
Frozen icon in the title bar of the corresponding windows at a DWC and the time 
past since the loss of connection.
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How to configure the freeze mode for the entire system:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Freeze function entry and press F8 to select one of the following options:

5. If the Freeze function is enabled, select one of the options under Freeze visualization:

6. Press F2 to save your settings.

off: Shows no image when connection is lost (default).

on: Shows last image when connection is lost.

frame: Show coloured frame at a console module or a coloured title 
bar in the corresponding windows at a DWC in case of a dis-
connection.

OSD: Show the message Frozen at a console module or a Frozen 
icon in the title bar of the corresponding windows at a DWC 
and the time past since the loss of connection.

frame+OSD: Show a coloured frame at a console module or a coloured 
title bar in the corresponding windows at a DWC in case of a 
disconnection  and the message Frozen at a console module or 
an Frozen icon in the title bar of the corresponding windows 
at a DWC and the time past since the loss of connection.
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How to configure the freeze mode for individual console modules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to configure and press F5.

5. Select the Freeze function entry and press F8 to select one of the following options:

6. When the Freeze function is explicitly enabled for this console module, enable one 
or both options under Freeze visualization:

7. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

system: Apply setting to the entire system (see above).

off: Shows no image when connection is lost.

on: Shows last image when connection is lost.

frame: Shows a coloured frame when connection is lost.

OSD: Shows the note Frozen and the time past since the loss of 
connection.

frame+OSD: Shows a coloured frame and the note Frozen with the time 
past since the loss of connection.
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How to configure the freeze mode individually for a DWC channel:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC you want to configure and press F5.

5. Select the Channel entry and press Enter.

6. Select the channel you want to configure and press F5.

7. Select the Freeze function entry and press F8 to select one of the following options:

8. When the Freeze function is explicitly enabled for this DWC channel, enable one or 
both options under Freeze visualization:

9. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

system: Apply setting to the entire system (see above).

off: Shows no image when connection is lost.

on: Shows last image when connection is lost.

frame: Show coloured title bar in the corresponding windows in 
case of a disconnection.

OSD: Show an Frozen icon and the time past since the loss of 
connection in the title bar of the corresponding windows.

frame+OSD: Show a coloured title bar in the corresponding windows in 
case of a disconnection and an Frozen icon and the time past 
since the loss of connection in the title bar of the 
corresponding windows.
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Network settings
The network ports on the back panel of the matrix switch enable you to carry out the 
following network functions:

 execute the matrix switches’ network configuration
 authenticate against directory services (LDAP, Active Directory, RADIUS, 

TACACS+)
 time synchronisation via NTP server
 forward log messages to syslog servers
 execute firmware updates and backups

Configuring the network ports

Configure the network settings in the OSD in order to make the matrix switch available 
for the entire network.

How to configure the network port settings:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Network entry and press Enter.

4. Select the Interfaces entry and press Enter.

NOTE: The functions listed above are carried out in the Config Panel web application 
and described in the manual of the web application.

NOTE: In the defaults, the following settings are pre-selected:

 IP address of network interface A: 192.168.0.1
 IP address of network interface B: address obtained using DHCP
 global network settings: settings obtained using DHCP
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5. Enter the following data in the Interface A (interface Network A) or Interface B  
(interface Network B) section:

6. Press F2 to save your settings.

Configuring the global network settings

In complex networks, the global network settings ensure that the matrix switch is 
available from all sub networks.

How to configure the global network settings:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Network entry and press Enter.

4. Select the Interfaces entry and press Enter.

Operational 
mode:

Press F8 to select the operating mode of the 
interface Network A or Network B:

 Off: switches off network interface.
 Static: uses static settings.
 DHCP: obtains the settings from a DHCP server.

IP address: Enter the interface IP address.

This setting is auto obtained in the DHCP operating mode.

Netmask: Enter the network netmask.

This setting is auto obtained in the DHCP operating mode.

Connection type: Press F8 to define if the network port and its communication 
partner are to negotiate the connection type automatically 
(Auto) or select one of the listed types.
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5. Enter the following data in the Main Network paragraph:

6. Press F2 to save your settings.

Using link aggregation to increase the reliability of network 
connections

In the default settings, both network interfaces can be used at the same time to 
access the web application from two different network segments, for example.

To increase reliability, the network interfaces can be grouped via link aggregation. 
Within the group, only one interface is active. The other interface is only activated if 
the active interface is down.

Two different modes allow you to monitor the interfaces:

 MII mode: The carrier status of the network interface is monitored via Media Inde-
pendent Interface. This mode only checks if the network interface is working.

 ARP mode: Requests to an ARP target in the network are sent via Address Resolution 
Protocol. With its answer, the ARP target confirms that the network interface is 
working and the proper network connection to the ARP target.

If the ARP target is connected to the network but is temporarily offline, requests 
cannot be answered. Define several ARP targets to still receive an answer of at least 
one target in case an ARP target is down.

Global prefer-
ences

Select the operating mode by pressing F8:

 Static: uses static settings.
 DHCP: auto obtains the settings described below from a 

DHCP server. 

Hostname: Enter the matrix switch hostname.

Domain: Enter the domain the matrix switch is to belong to.

Gateway: Enter the gateway IP address.

DNS 1: Enter the DNS server IP address.

DNS 2: Enter the IP address of another DNS server (option).

NOTE: MII mode and ARP mode cannot be combined.
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How to configure the settings of an network interface group:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Network entry and press Enter.

4. Select Link Aggregation and press Enter.

5. Enter the following data under Network:

NOTE: According to RFC 3330, the Link Local address room 169.254.0.0/16 
is reserved for the internal communication between devices. Therefore, it is 
not possible to assign an IP address from this address room.

Name: Enter the name of the network interface group.

Operational 
mode:

Select the Operational mode of the network interface group:

 Off: Switches off link aggregation.
In this case, configure the network interfaces under »Interfaces«.

 Static: Assigns a static IP address.
 DHCP: Receives IP address from DHCP server.

Address: Enter the interface IP address – only applies to operational 
mode Static.

Netmask: Enter the network netmask – only applies to operational 
mode Static.
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6. Enter the following data under Parameter:

7. Press F2 to save your settings.

Primary  
follower:

Choose if the data traffic should run via Network A (Interface A) 
or Network B (Interface B). As soon as the selected interface is 
available, the data traffic is sent via this interface.

If you choose the option None, the data traffic is sent via any 
interface. The interface only changes if the active interface is 
down.

Link monitoring: Choose if you want to use the MII mode or the ARP mode  
(see explanation above) to monitor the interface.

MII down delay: Waiting time in milliseconds before a failed network  
interface is disabled.

The defined value must be a multiple of 100 ms (MII link 
monitoring frequency).

MII up delay: Waiting time in milliseconds before a reset network interface 
is enabled.

The defined value must be a multiple of 100 ms (MII link 
monitoring frequency).

ARP interval: Enter the interval (100 to 10,000 milliseconds) after which 
the network interfaces are checked for incoming ARP  
packets.

ARP validate: The validation ensures that the ARP packet for a defined  
network interface was generated by the defined ARP target.

Choose if and which incoming ARP packets should be  
validated:

 None: ARP packets are not validated (default).

 Active: Only ARP packets of active network interface are 
validated.

 Backup: Only ARP packets of inactive network interface 
are validated

 All: ARP packets of all network interfaces within the group 
are validated.

ARP target: The list contains all configured ARP targets.

Use F3 (Add), F5 (Edit) and F4 (Delete) to administrate the 
ARP targets.
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Resetting the netfilter rules

In the default settings, all network computers can access the system’s IP address 
(open system access).

With the Config Panel web application, you can create netfilter rules to control the 
access to the matrix system. After a netfilter rule has been created, the open system 
access is deactivated and all incoming data packets are compared to the netfilter 
rules.

The created netfilter rules can also be deleted with this function.

How to delete the created netfilter rules:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Reset netfilter configuration entry and press Enter.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
 confirmation.

Enhanced functions

Reading out the status of the network interfaces

The current status of both network interfaces can always be read out via the OSD.

How to detect the status of the network interfaces:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Network entry and press Enter.

4. Select the Link Status entry and press Enter.
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5. The Interface A (Network A interface) or Interface B (Network B interface) paragraph 
provides you with the following data:

6. Press Esc to leave the menu.

Checking the availability of a host in the network (Ping)

The OSD of a console module can be used to test the availability of a particular host 
(e. g., a computer or a network device) in the network.

How to check the availability of a host in the network:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Network entry and press Enter.

4. Select the Ping Host entry and press Enter.

5. Use the Host entry to enter the IP address or the host name and press Enter.

6. The test results are displayed in the following table:

7. Press Esc to leave the menu.

Link detected: connection to network established (yes) or interrupted (no).

Auto-negotiation: The transmission speed and the duplex mode have 
been configured automatically (yes) or manually by 
the administrator (no).

Speed: transmission speed

Duplex duplex mode (full or half)

NOTE: Press Enter to update the displayed data.

Transmitted: number of transmitted data packets

Received: number of received data packets

Lost: number of lost data packets

Min. RTT: minimum round-trip-time

Avg. RTT: average round-trip-time

Max. RTT: maximum round-trip-time

NOTE: A message informs the user if the host name cannot be resolved into an 
IP address.
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Resetting the default settings

This setting resets the default settings of the matrix switch. All settings that have 
been changed by the user are reset.

How to reset the default settings of the matrix switch:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Set system defaults entry and press Enter.

5. Select Delete KVM configuration and press F8 to enable/disable the deletion of the 
configurations of the connected devices and configured users and groups stored 
in the matrixs witch.

6. Select Delete dynamic ports and press F8 to enable/disable the option to delete the 
Dynamic Port configuration.

7. Select Delete network config and press F8 to enable/disable the option to delete the 
network interface configuration.

8. Press Enter to reset the default settings.
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Retrieving information about the system

Displaying dynamic port information

Use the Dynamic port information menu to query the modes and amount of ports.

How to call the dynamic port information:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F12 to call the Information menu.

3. Select the Dynamic port information entry and press Enter. 

The desired information is displayed.

4. Press Esc to leave the menu.

Displaying firmware information of the matrix system

The Firmware information menu displays the firmware of the matrix switch, 
the console module, and the accessing computer module.

How to call the Firmware information:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F12 to call the Information menu.

3. Select the Firmware information entry and press Enter. 

The desired information is displayed.

4. Press Esc to leave the menu.

Displaying the premium functions

The Feature information menu lists the activated premium functions.

How to display the list of active premuim functions:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F12 to call the Information menu.

3. Select the Feature information entry and press Enter. 

The desired information is displayed.
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Displaying Hotkey settings

The active hotkey, the valid select keys and the tradeswitch keys are displayed in the 
Hotkey information menu.

How to display the hotkey settings:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F12 to call the Information menu.

3. Select the Hotkey information entry and press Enter. 

The desired information is displayed.

4. Press Esc to leave the menu.

Displaying hardware information of the matrix switch

The hardware information of the matrix switch can be displayed in the 
Hardware information menu.

This menu lists e.g., the firmware version, the device’s serial number, 
and the MAC addresses of the network ports.

How to display the hardware information:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F12 to call the Information menu.

3. Select the Hardware information entry and press Enter. 

The desired information is displayed.

4. Press Esc to leave the menu.
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Rights administration

Login rights for the Config Panel web application

The Config Panel web application offers a graphical user interface to configure the 
matrix system.

The web application provides an alternative to configuring the matrix switches via 
the OSD of a console module and can be applied independently from the console 
modules in the network.

How to change the login right for the Config Panel web application:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select the User entry.  
For changing this right for a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose login rights for the Config Panel 
web application you want to change and press F5.

6. Select the Config rights entry and press Enter.

7. Select the WebIf Login entry and press F8 to select one of the following options:

8. Press F2 to save your settings.

IMPORTANT: For applying the web application, the user accounts or the user 
groups have to hold the corresponding right.

yes: allows access to Config Panel web application

no: denies access to Config Panel web application
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Optional premium functions
The functional range of the matrix system can be expanded by purchasing additional 
premium functions. 

Name Function Description

Push-Get 
function

The Push-Get function allows the user to push 
the image on his monitor at a console module 
or the image of a DWC channel at a DWC to 
the display of another workplace or a large-
screen projection or to get it from there.

page 216

IP-Control-API The IP-Control-API enables text-based XML 
control of a KVM matrix system over the net-
work. It offers developers/administrators the 
ability to create custom applications for control, 
send switching commands and retrieve selective 
information on switching states and computer 
status. Thanks to easy integration into existing 
systems, including those from third-party 
manufacturers, the API offers a flexible and 
expandable solution that goes beyond the 
standard functions of the KVM matrix system 
and enables seamless integration into IT 
infrastructures from various providers.

page 225

Scripting  
function

With the scripting function, as part of the IP 
Control API, you can create, manage and 
execute scripts. A script is an XML document 
that contains one or more commands that are 
executed by the matrix switch. This allows you 
to automate scenarios such as changing the 
switching status of individual workplaces, 
several workplaces or the entire system. 

HTTP requests can also be used to control 
external devices.

page 226

EasyControl 
tool

You can use the EasyControl tool integrated in 
the web application to connect a console module 
to a specific computer module or to execute an 
existing script or script group.

Important: It is not possible to connect a DWC or 
DWC channel to a specific computer module with 
the EasyControl tool.

manual of the 
web application
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Tradeswitch 
function

The TradeSwitch-Function (TS function) 
optimizes the operation of workplaces that, 
through multiple console modules and/or 
DWCs, are responsible for the simultaneous 
monitoring or control of multiple computers. 
Instead of assigning a separate keyboard and 
mouse to each console module and/or DWC, 
the TradeSwitch-Function provides a central 
keyboard and mouse for controlling the entire 
workplace. 

The user can switch these two input devices to 
any console module or display areas of the 
DWCs using a hotkey. 

page 272

CrossDisplay-
Switching 
function

With CrossDisplay-Switching (CDS) as part of 
the TS function, user-friendly switching via 
mouse movement is enabled. The mouse 
behaves as if on a “virtual desktop” and can be 
seamlessly moved across the connected 
monitors. When the mouse pointer moves from 
one monitor to another, the keyboard-mouse 
focus is automatically redirected to another 
module, thus switching to a different computer.

manual of the 
web application

FreeSeating 
function

With the FreeSeating function, as part of the 
TS-Function, the user’s personal work environ-
ment is automatically restored at any workplace 
within the group – including the last connected 
sources. The simplified login process optimizes 
workflows and increases productivity: The login 
credentials only need to be entered once to log 
into all console modules of the group and 
switch to the most recently used sources. Simi-
larly, a single logout is sufficient to log out the 
entire group.

page 48

SyncSwitching Configure up to two matrix switches as Sync-
Follower following the switching states of the 
matrix switch configured as SyncLeader.

Each switching operation of the SyncLeader 
matrix switch is performed simultaneously on 
the SyncFollower matrix switches.

manual of the 
web application

Name Function Description
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Matrix-Grid 
function

The Matrix-Grid function allows for the flexible 
use of any matrix switch port within the Matrix-
Grid for console modules, DWCs, computer 
modules, or grid lines. While cascading expands 
only the number of connectable computers, the 
Matrix-Grid allows for the universal expansion of 
the existing KVM system.

Additionally, the function removes the limitations 
of the top-down structure within cascading and 
enables bidirectional communication between 
console modules, DWCs and computer modules 
connected to different matrix switches. This 
allows multiple digital matrix switches to be 
combined into a large matrix network. Console 
modules, DWCs and computer modules can be 
connected to any matrix switch within the Matrix-
Grid.

The matrices grouped in a grid are virtually 
combined into one large matrix system for the 
user. As a result, all sources within the system can 
be accessed from any connected workplace. The 
matrix system automatically handles the routing 
of KVM signals by selecting the optimal path 
through the grid.

manual of the 
web application

MatrixGuard 
function

To use the MatrixGuard function, the Matrix-
Grid function is also required. 

The MatrixGuard function allows any matrix 
switch within the Matrix-Grid/MatrixGuard 
system to take over the role of the database 
leader if the original database leader fails or 
becomes inaccessible. This transition is per-
formed automatically according to predefined 
rules. 

The participants in the Matrix-Grid connect to 
the new leader, and the system resumes 
operation automatically. The full operation of 
the remaining components is ensured (except 
for the endpoints connected to the unavailable 
matrix). Manual intervention is not required.

manual of the 
web application

Name Function Description
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Activating a premium function

2-factor 
authentication

To provide a greater level of security, optional 
two-factor authentication (2FA) can be used to 
query a second factor based on a device in the 
user’s possession.

2FA makes use of a time-based one-time pass-
word (TOTP). Authenticator apps or hardware 
tokens can be used.

manual of the 
web application

NOTE: The premium functions can be activated in the Config Panel web application. 

The necessary steps are described in the manual of the web application.

Name Function Description
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Push-Get function (optional)

The optional Push-Get function allows the user to push the switch state of his console 
module or DWC channel to another console module or DWC channel or to get it 
from there.

Push the switch state

Push the switch state of a console module to another console 
module or a DWC channel

How to push the switch state of a console module to another console module or a 
DWC channel:

1. Press the hotkey Ctrl+Num (default) to call the OSD.

2. Use the Select menu to choose the computer module that you want to connect 
with another console module or DWC channel.

3. Press F7 to open the Push menu.

The menu displays all active console modules and DWC channels within the KVM 
matrix system, which you have access to and are therefore allowed to perform the 
Push-Get function. The right-hand column additionally provides you with the names 
of the computer modules that are accessing the console modules and DWC 
channels.

4. Select the console module or DWC channel to which the switch state is to be moved 
to and press Enter.

IMPORTANT: Using the Push-Get function requires the purchase and activation of 
the premium Push-Get-Function.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Stop the push of the switch state

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F7 to call the Push menu.

The menu displays all active console modules and DWC channels within the KVM 
matrix system, which you have access to and are therefore allowed to perform the 
Push-Get function. The right-hand column additionally provides you with the names 
of the computer modules that are accessing the console module and DWC channels.

3. Select the console module or DWC channel to be disconnected from the 
computer module with the arrow keys and press F4.

Get the switch state (Get)

Get the switch state from another console module or a DWC 
channel on a console module

How to get the switch state from another console module or DWC channel on a 
console module:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F8 to call the Get menu.

3. The menu displays all active console modules and DWC channels within the KVM 
matrix system, which you have access to and are therefore allowed to perform the 
Push-Get function. The right-hand column additionally provides you with the names 
of the computer modules that are accessing the console module and DWC channels.

4. Use the arrow keys to select the console module or DWC channel whose screen 
content you want to access and press Enter.

NOTE: This function stops if another computer module (see page 10) is accessing the 
console module.
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Push/get switch state via push get keys
After having defined push get key modifier(s) and a push get key set and after hav-
ing activated a push get key set in the user account, you can push/get the switch 
state of the console module or of a DWC channel by using the console keyboard.

Push switch state 1. Press and hold configured modifier key(s).

2. Press P

3. Press push get key of console module or DWC channel.

4. Release configured modifier key(s).

Stop push of switch 
state

1. Press and hold configured modifier key(s).

2. Press D

3. Press push get key of console module or DWC channel.

4. Release configured modifier key(s).

Get switch state 1. Press and hold configured modifier key(s).

2. Press G

3. Press push get key of console module or DWC channel.

4. Release configured modifier key(s).
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Setting push get keys
After you adjust the push-get key modifier(s) and a push/get key set and activate the 
push-get key set in the user account, you can use key combinations on the console 
module or DWC keyboard to push or get switch states.

Changing push-get key modifiers and valid keys

Push-get keys let you push or get switch states from or to a console module or DWC 
channel by using key combinations. For this, you can create Push-get key sets in the 
matrix system.

In combination with a defined push-get key modifier a push-get key set defines the key 
combination to be pressed for push or get switch states.

In addition to the push-get key modifier you can also define valid keys to be used as 
push-get keys.

How to change push-get key modifiers or valid keys:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select System entry and press Enter.

4. Select the Push-Get key entry and press Enter.

5. Use the arrow keys to select at least one of the Push-Get key modifiers listed in the 
Modifier entry. Afterwards, press F8.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift Shift key
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6. Select the Valid keys entry and press F8 to select one of the following options:

7. Press F2 to save your settings.

Administrating push get key sets

The KVM matrix system allows you to create 20 global push get key sets or ten indi-
vidual push get sets for each user.

Within push get key sets you can define push get keys for selected console modules
and DWC channels to move the switch state of a console module or DWC channel.

Num: Only numerical keys are interpreted as push-get keys when 
pressed in combination with the push get key modifier

Alph: Only alphabetic keys are interpreted as push-get keys when 
pressed in combination with the push get key modifier

AlphNum: alphabetical and numerical keys are interpreted as push-get keys 
when pressed in combination with the push get key modifier

IMPORTANT: Both the selected valid keys and the Push-Get key modifier 
are no longer provided as key combinations to the operating system and 
the applications on the computer.

NOTE: Global push get key sets are displayed in the personal profile of all users of 
the KVM matrix system.
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Creating push get key sets

How to create push get key sets:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Push-Get key set entry and press Enter.

4. Press F3 and enter the following data in the Add Push-Get key set menu:

5. Press F2 to save your inputs and to create the Push-Get key sets.

Changing name, comment or global allocation 

How to change the name, comment and/or the Global setting of push get key sets:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Push-Get key set entry and press Enter.

4. Select the Push-Get key set whose setting you want to change.

5. Press F5 to change the following data in the Edit Push-Get key set menu:

6. Press F2 to save your settings.

Name: Enter the new Push-Get key set name and press Enter.

Global: Select yes by pressing F8 if you want the Push-Get key set in the 
Personal Profile menu to be available for all users of the system.

default: no

Name: Enter the new name of the Push-Get key set and press Enter.

Global: Press F8 for selecting yes if you want to make the Push-Get key set 
in the personal profile available to all users of the system.

default: no

NOTE: This option can only be activated by users with the Superuser right 
(see page 93).
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Defining push get keys for console modules and DWC channels

How to define push get keys for console modules and DWC channels:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Push-Get key set entry and press Enter.

4. Choose a Push-Get key set and press F5.

5. Select the Members entry and press Enter.

The Assign Push-Get key set dialogue opens. The left column displays the name of 
the console modules and DWC channels and the right column shows the 
assigned Push-Get key(s).

6. Select the console module or DWC channel you want to assign a Push-Get key 
to or whose Push-Get key you want to change.

7. Press F5 and enter the desired Push-Get key.

8. If you want to create or change the Push-Get keys for other console modules or 
DWC channels, repeat steps 6 and 7.

9. Press F2 to save your settings.

NOTE: Global push get key sets can only be edited by users with activated 
Superuser rights (see page 93).

Without this right, only push get keys assigned to the console modules or DWC chan-
nels can be viewed.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.
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Assigning push get key sets to user accounts

By assigning a push get key set to a user account, the push get keys of the set are eval-
uated for entries at the console module or DWC and the switch state of the console 
module or DWC channel can be pushed or got.

How to assign a push get key set to a user account or cancel an existing assignment:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Push-Get key set entry and press Enter.

4. Select the desired Push-Get key set.

5. Press F8 to (de)activate the assignment.

6. Press F2 to save your settings.

Deleting push get key sets

How to delete a push get key set:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F10 to call the Personal Profile menu.

3. Select the Push-Get key set entry and press Enter.

4. Select the Push-Get key set you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to 
limit the selection of list entries.

NOTE: An assigned Push-Get key set is marked with an arrow ().

NOTE: Global push get key sets can only be deleted by users with activated 
Superuser rights (see page 93).

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to 
limit the selection of list entries.
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Changing a user account’s Push-Get right

How to change a user account’s Push-Get right:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. If you want to change this right of a user account, select User entry.  
For changing the rights of a user group, select the Usergroup entry.

4. Press Enter.

5. Select the user account or the user group whose right to execute  
the Push-Get function you want to change and press F5.

6. Select the Push-Get rights entry and press Enter.

7. Select the console module or DWC channel whose user rights you want to 
change.

8. Press F8 to select one of the following options:

9. Repeat steps 7 and 8 to change the Push-Get right for further console modules and 
DWC channels.

10.Press F2 to save your settings.

11.Press Esc to leave the menu.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to 
limit the selection of list entries.

yes: allows usage of Push-Get function

no: denies usage of Push-Get function
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IP-Control-API (optional)  

After you activate the additional IP-Control-API function, you are able to access the 
KVM matrix system over a TCP/IP connection and you can use the network inter-
faces to send text-based commands in the form of XML files to the matrix switch.

Supported functions via text-based control
You can use the text-based control to perform the following functions:

 Logon User: user logon at a console module or at a DWC
 Logout User: user logout at a console module or at a DWC
 Connect CPU: accesses a computer module with a console module or  

a DWC channel

 Disconnect CPU: disconnects active access
 List Connections: queries connections between connected devices
 List MatrixSwitches: queries known matrix switches
 List CPUs: queries known computer modules
 List Consoles: queries known console modules
 List DWCs: queries known DWCs
 Redirection: redirects keyboard and mouse data

IMPORTANT: Using the IP-Control-API requires the purchase and activation of 
the premium IP-Control-API.

ADVICE: The separate chapter Controlling the matrix switch via XML on page 226 ff. 
provides you with detailed information on this topic.

NOTE: This function can only be executed if an user with the computer module 
access rights ViewOnly or FullAccess is logged on to the console module or to the 
DWC or if it is an OpenAccess console with these rights.

NOTE: Only after you have purchased the additional Tradeswitching function, 
you are enabled to forward keyboard and mouse data to another console 
module, another DWC or another computer module.



Controlling the matrix switch via XML
Controlling the matrix switch via XML

XML enables you to control digital matrix switches using third-party devices (e.g. 
AMX® and Crestron®). The matrix switch uses the ethernet interface to process 
any XML commands received from third-party devices.

Structure of a valid XML document
Any commands are transmitted as XML documents to the G&D device. Valid 
XML documents start with an optional, standardized header. On the top level, they 
are surrounded by the <root> tag:

Any commands you want to execute are placed between a tag that starts and ends 
the document (root). The commands are described on page 237.

IMPORTANT: Controlling the matrix switch via XML requires the purchase and 
activation of the premium IP-Control-API (see page 225 ff.).

NOTE: For controlling external devices HTTP requests can be used. For more infor-
mation, please refer to the separate manual of the web application.

STRUCTURE OF A VALID XML DOCUMENT
<?xml version="1.0" encoding="utf-8"?> <!-- optional header -->
<root> <!-- start tag of document -->
</root> <!-- end tag of document   -->
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Selecting devices
The XML API lets you specify devices not only by ID, but also by name.

Use the attribute type to select devices via ID ("id") or via name ("name"). The attribute 
is supported by all commands referring to devices with a name.

Use of device IDs
For responses and messages, device IDs are output as hexadecimal values including 
the prefix 0x.

In commands, device IDs can be stated as hexadecimal values including the prefix 0x, 
as octal values including the prefix 0 or as decimal values.

ADVICE: The use of the type attribute is optional. If you do not use this attribute, 
devices are identified via ID.

USING THE NAME OF A CONSOLE MODULE FOR IDENTIFICATION
<?xml version="1.0" encoding="utf-8"?>
<root>

<logon>
<DviConsole type="name">CON1</DviConsole>
<User>JohnDoe</User>
<Password>secret</Password>

</logon>
</root>

USING THE ID OF A CONSOLE MODULE FOR IDENTIFICATION
<?xml version="1.0" encoding="utf-8"?>
<root>

<logon>
<DviConsole type="id">0x22222222</DviConsole>
<User>JohnDoe</User>
<Password>secret</Password>

</logon>
</root>
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Use of port names
Port names are output in a visible notation. The port names are the same as printed on 
the device panel:

 For matrix switches of the ControlCenter-Compact series, ports are output as a  
combination of slot and port (1.1, 1.2, …).

Responses and messages of G&D devices
G&D devices respond with a complete XML document after processing an XML 
document.

Responses of G&D devices

Responses of the device are included in a <result> tag.

The attribute <type> includes the name of the executed command. When executing 
several commands within an XML document (see below), you can assign the 
responses to the different commands.

In the following example, data of a console module was requested. The available 
information is listed within <item> tags:

NOTE: The port names are the same as the names stated in the logs and the 
printings on the device panel.

EXEMPLARY RESPONSE OF XML API
<?xml version="1.0" encoding="utf-8"?>
<root>
<result type="list">

<DviConsole>
<item>

<id>0x22222222</id>
<cl>DviConsole</cl>
<type>DVI-CON</type>
<name>CON1</name>
<ownerId>0x11111111</ownerId>
<ownerCl>DviMatrix</ownerCl>
<ownerPort>1.11</ownerPort>
<enable>1</enable>
<poweredOn>true</poweredOn>

</item>
</DviConsole>

</result>
</root>
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Messages of G&D devices

If the XML service is not able to process a request, the service responds with an 
error document:

Depending on the type of message, responses to commands, which are not executed 
by the XML service itself, but are delegated to the device service of the matrix 
switch, are output in different XML containers.

The following containers are used for this purpose:

 Error messages are output within the container <Error>.
 Warnings are output within the container <Warning>.
 Success messages and general messages not fitting the categories given above are  

output within the container <commandStatus>.

STRUCTURE OF AN ERROR DOCUMENT

<?xml version="1.0" encoding="utf-8"?>
<root>

<Error>Invalid request document</Error>
</root>

EXEMPLARY ERROR MESSAGE
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="logon">
<Error>authentication failed</Error>

</result>
</root>
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Combining multiple commands in an XML document
You can combine several commands within one XML document. The XML service 
processes the commands in the same order in which they are listed in the XML 
document.

An XML document as described above can look as follows:

The corresponding response combines individual commands in one document.

Push notifications for events occurred
For TCP connection, the service for text-based control sends push notifications to 
inform users about events occurred.

Such events are reported via <pushNotification> container. The type of notification is 
listed as type attribute of this tag.

EXAMPLE: Connecting and disconnecting of devices triggers push notifications for 
every channel. It is not important how the connection was established or disconnected 
(e.g. via OSD or XML).

COMBINING MULTIPLE COMMANDS IN ONE XML DOCUMENT
<?xml version="1.0" encoding="utf-8"?>
<root>

<logon>
<DviConsole>0x22222222</DviConsole>
<User>JohnDoe</User>
<Password>secret</Password>

</logon>
<connect>

<DviConsole>0x22222222</DviConsole>
<DviCpu>0x33333333</DviCpu>

</connect>
<showmessage>

<Type>INFO</Type>
<Text> Message</Text>
<DviConsole>0x22222222</DviConsole>

</showmessage>
</root>
ControlCenter-Compact · 230



Controlling the matrix switch via XML
By default, the following notifications are active:

 connection_event: Connection between console module or DWC channel and 
computer module established

 disconnection_event: Connection between console module or DWC channel and 
computer module disconnected

 user_push_event: Push event triggered by user

In addition, you can subscribe to the following notifications:

 device_online_event: Status change of a module to online
 device_offline_event: Status change of a module to offline
 peripheral_power_on_event: The computer connected to the computer module is 

active.
 peripheral_power_off_event: The computer connected to the computer module is 

inactive.
 redirect_event: Redirection of keyboard and mouse data executed

PUSH NOTIFICATION WHEN ESTABLISHING A CONNECTION

<?xml version="1.0" encoding="utf-8"?>
<root>

<pushNotification type="connection_event">
<consoleId>0x22222222</consoleId>
<consoleCl>DviConsole</consoleCl>
<consoleName>CON1</consoleName>
<targetId>0x33333333</targetId>
<targetCl>DviCpu</targetCl>
<targetName>CPU1</consoleName>
<userName>JohnDoe</userName>
<userRealname>John Doe</userRealname>

</pushNotification>
</root>

PUSH NOTIFICATION WHEN DISCONNECTING A CONNECTION
<?xml version="1.0" encoding="utf-8"?>
<root>

<pushNotification type="disconnection_event"
><consoleId>0x22222222</consoleId>
<consoleCl>DviConsole</consoleCl>
<consoleName>CON1</consoleName>

</pushNotification>
</root>

ADVICE: When evaluating push notifications, you can reproduce any switching 
processes of the device, for example.
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Subscribing to push notifications

Use the <subscribe> container, to subscribe to push notifications for one or more 
types of notifications.

Within the <Notification> tag, you can specify the type of notification (see above) by 
using the type attribute.

To activate notifications for the event that the device status changes, you can use the 
following XML document:

Unsubscribing from push notifications

Use the <unsubscribe> container, to unsubscribe to push notifications for one or 
more types of notifications.

Within the <Notification> tag, you can specify the type of notification (see above) by 
using the type attribute.

To activate notifications for events regarding connections, you can use the following 
XML document:

NOTE: The subscription applies only for the connection on which the subscribe
command is sent.

ACTIVATING NOTIFICATIONS FOR CHANGES OF THE DEVICE STATUS
<?xml version="1.0" encoding="utf-8"?>
<root>

<subscribe>
<Notification type="device_online_event"/>
<Notification type="device_offline_event"/>

</subscribe>
</root>

NOTE: The unsubscription applies only for the connection on which the unsubscribe
command is sent.

DEACTIVATING NOTIFICATIONS FOR EVENTS REGARDING CONNECTIONS
<?xml version="1.0" encoding="utf-8"?>
<root>

<unsubscribe>
<Notification type="connection_event"/>
<Notification type="disconnection_event"/>

</unsubscribe>
</root>
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Configuration and encryption
As of version 1.1, the XML API supports two ways of encryption:

 Transport encryption: If this type of encryption is enabled, the entire outgoing data 
stream is encrypted by the XML service.
Incoming XML commands are only accepted and executed when encrypted with 
the identical key and initialisation vector.

 Password encryption: This type of encryption encrypts only the passwords of user 
accounts included in XML responses of G&D devices. For this, a subset of XML 
encryption (see page 235) is used.
Within XML commands, passwords can either be encrypted (recommended) or 
in plain text when sent to the device.

For encoding CBC-3DES or TLS are used. The required key and the initialization vector
(only required with transport encryption and enabling of CBC-3DES) are configured in 
the web application Config Panel.

Configuring accesses of devices for XML control

Use the web application Config Panel to define »remote control« accesses and their 
settings.

How to create a new access or edit an existing access:

1. In the directory tree, click KVM matrix systems > [Name] > Matrix switches.

2. Right-click the device you want to configure and click Configuration on the context 
menu.

3. Click the Network> Remote Control tabs.

4. To add a new remote control access, click Add. 
To edit an existing access, click Edit.

NOTE: For detailed information, please refer to the separate manual of the web 
application.

ADVICE: On request, our support will provide you with examples for API encryption
in the programming languages C# and C++.

IMPORTANT: These accesses are required to control the device via XML.
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5. Enter or edit the following data:

6. Click on Save.

Port: Enter the port you want to use for text-based communica-
tion.

Ports 80, 443 and 27996 are not available for XML control.

Status: Select if the access is enabled or disabled.

Encryption: The following types of encryption are supported:

 Unencrypted: Select None to transmit the data without 
encryption (default).

 Partly encrypted: Select Password: CBC-3DES, 
to transmit only login passwords with encryption. 

 Encrypted: Select CBC-3DES or TLS to transmit the data 
entirely encrypted.

Key: After enabling the encryption type CBC-3DES, enter the key 
(192 bit) in the form of 48 hex digits.

Initialization  
vector:

Enabling the encryption type CBC-3DES additionally requires 
an initialization vector. Enter the initialization vector (64 bit) 
in the form of 16 hex digits.

Certificate 
Authentication:

With TLS encryption enabled, you can additionally enable Certi-
ficate authentication after uploading a certificate (in the Remote 
Control section of the Network tab).
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Instructions for encrypting passwords

If the transcription type transport encryption is enabled, the entire outgoing data stream 
is encrypted. When using Password encryption, however, only the passwords of user 
accounts are encrypted in XML requests.

A subset of the W3C standard XML encryption is used to encrypt passwords. An 
<EncryptedData> container replaces the password with the XML namespace "http://
www.w3.org/2001/04/xmlenc#". This container includes the <CipherData> container, 
which inlcudes the  <CipherValue> container:

The encrypted data block (CipherValue) consists of a combination of initialization vector
and encrypted text with BASE64-coded padding.

NOTE: In XML requests, passwords can either be encrypted (recommended) or in 
plain text when sent to the device.

PASSWORD AS EMBEDDED ENCRYPTED TEXT
<?xml version=\"1.0\" encoding=\"utf-8\"?>
<root>

<logon>
<DviConsole>0x22222222</DviConsole>
<User>JohnDoe</User>
<Password>

<EncryptedData xmlns="http://www.w3.org/2001/04/xmlenc#">
<CipherData>

<CipherValue>B2Wmn52teOPvY31wq0l4nw==</CipherValue>
</CipherData>

</EncryptedData>
</Password>

</logon>
</root>
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The data block is formed as follows:

Padding is required to make the data block to be encrypted multiple times larger than 
block size (8 bytes). The XML API expects that the last byte of the padding states 
the number of added padding bytes. The padding bytes are to be randomly selected.

The initialization vector is required for stream ciphers (here: CBC). It is randomly 
selected in the encryption mode Password encryption. Its size corresponds to the block 
size of the selected encryption (8 bytes).

IV encrypted data

plain text padding

Initialization Vector (IV)
encrypt using

BASE64

encoded data
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Commands

User logon and user logoff

User can log in with the command <logon>. The command <logoff> logs users off.

A successful login requires the following parameters:

Transmitting username and password is not required when logging in.

<DviConsole>
<DynamicWorkplace>

Console module or DWC of user logon

<User> Name of user who wants to log in

<Password> Password of user who wants to log in

<OTP> Optional parameter to transfer the one-time password

<AllowTemporaryLogon/> Allow temporary user login to OpenAccess or video console

USER LOGIN
<?xml version="1.0" encoding="utf-8"?>
<root>

<logon>
<DviConsole>0x22222222</DviConsole>
<User>JohnDoe</User>
<Password>secret</Password>
<OTP>secret</OTP>

</logon>
</root>

NOTE: Information about optional password encryption is given on page 235.

USER LOGOFF
<?xml version="1.0" encoding="utf-8"?>
<root>

<logoff>
<DviConsole>0x22222222</DviConsole>

</logoff>
</root>
237 · ControlCenter-Compact



Controlling the matrix switch via XML
Establishing a connection to a computer module or disconnecting 
a connection

The command <connect> allows a console module or a DWC channel to access a 
computer module.

The ID or name of the computer module to be accessed and the ID or name of the 
console module or of the DWC channel are used as parameters:

<DviConsole>
<DwcConsole>
<MultiDviConsole>
<UsbDviConsole>

compatible console module, DWC channel, 
virtual console module of a multi IO card or a 
USB console module

<DviCpu>
<MultiDviCpu>
<UsbDviConsole>

compatible computer module, 
virtual computer module of a multi IO card or a 
USB computer module

<VtCpu> Computer module of the RemoteAccess series

<CloseDialogs> Close OSD after establishing a connection (connect)

<OpenSelectDialog> Close OSD after disconnection (disconnect)

NOTE: When connecting an analogue matrix switch via bridging, you can 
address its computer modules via <NeoCpu>.

ADVICE: In channel groups the additional video, multi and USB channels are 
automatically switched with the main channel.

NOTE: USB modules and multi modules can also be switched directly – 
independently from a channel group.

ESTABLISHING A CONNECTION

<?xml version="1.0" encoding="utf-8"?>
<root>

<connect>
<DviConsole>0x22222222</DviConsole>
<DviCpu>0x33333333</DviCpu>
<CloseDialogs/>

</connect>
</root>

DISCONNECTING A CONNECTION
<?xml version="1.0" encoding="utf-8"?>
<root>

<disconnect>
<DviConsole>0x22222222</DviConsole>
<OpenSelectDialog/>

</disconnect>
</root>
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Disconnecting all connections to a computer module

The command <disconnect> can alternatively be used for a computer module. This 
has the consequence that all connected console modules and DWC channels are 
disconnected from this computer module.

The ID or name of the computer module to be disconnected is used as parameter:

<DviCpu> compatible computer module

<VtCpu> Computer module of the RemoteAccess series

<OpenSelectDialog> Close OSD after disconnection (disconnect)

DISCONNECTING ALL CONNECTION
<?xml version="1.0" encoding="utf-8"?>
<root>

<disconnect>
<DviCpu>0x33333333</DviCpu>
<OpenSelectDialog/>

</disconnect>
</root>
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Select video stream

Use the command <selectvideostream> to assign the »Dual-Head (DH)« video streams 
to the display channels.

<DviConsole>
<DwcConsole>

Console module or DWC channel whose transmission channel is to be 
selected

<VideoOut1> Optional: Number of the video stream to be displayed on the 
first video output.

<VideoOut2> Optional: Number of the video stream to be displayed on the 
second video output.

SELECTION OF A TRANSMISSION CHANNEL VIA THE ACTIVE ROUTE
<?xml version="1.0" encoding="utf-8"?>
<root>

<selectvideostream>
<DviConsole type="name"> Platz_007  </DviConsole>
<VideoOut1> 2 </VideoOut1> <!-- Optional: Video output 1 outputs the 

second video stream. -->
<VideoOut2> 1 </VideoOut2> <!-- Optional: Video output 2 outputs the

first video stream. -->
</selectvideostream>

</root>
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Switching the channel of a CON-2 console module

The command <selecttransmission> is used to switch the channel of a CON-2 console 
module.

The ID or name of the console module as well as the intended channel are used as 
parameters.

ADVICE: In addition to entering the channel number with the parameter 
<TransmissionInterface>, you can use the parameter <Pull> to switch to the 
channel that is used to connect the console module to the implemented 
matrix switch.

<DviConsole> Console modules

<TransmissionInterface> Channel of console module: 1 or 2

<Pull> Activates the channel that is used to connect the console module to 
the implemented matrix switch.

SWITCHING THE CONSOLE MODULE TO CHANNEL 1
<?xml version="1.0" encoding="utf-8"?>
<root>

<selecttransmission>
<DviConsole>0x22222222</DviConsole>
<TransmissionInterface>1</TransmissionInterface>

</selecttransmission>
</root>

SWITCHING THE CONSOLE MODULE TO THE CHANNEL 
CONNECTED TO THE MATRIX SWITCH
connected to the matrix switch
<?xml version="1.0" encoding="utf-8"?>
<root>

<selecttransmission>
<DviConsole>0x22222222</DviConsole>
<Pull/>

</selecttransmission>
</root>
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Transferring the configuration settings of a module

If a module within the KVM matrix system is replaced by another module, you can 
use the command <movedevice> to transfer the configuration settings of the previous 
module to the new module.

Once the configuration settings have been transferred, the new module is immedi-
ately ready for use.

The ID of the old and the new module and the access data of the user account are 
transferred as parameters.

IMPORTANT: The transmission of the configuration settings is only possible if both 
modules belong to the same device class (e.g. DVIConsole).

<DviConsole>
<DynamicWorkplace>
<MultiDviConsole>
<UsbDviConsole>

compatible console module,
compatible DWC,
virtual console module of a multi-IO card or
USB console module

<DviCpu>
<MultiDviCpu>
<UsbDviCpu>

compatible computer module,
virtual computer module of a multi-IO card or
USB computer module

<User> Name of the user account (has to be assigned with the required 
rights) to exevute the command

<Password> User password

<OTP> Optional parameter to transfer the one-time password

HOW TO TRANSFER THE CONFIGURATION SETTINGS OF A CONSOLE MODULE

<?xml version="1.0" encoding="utf-8"?>
<root>
    <movedevice>
        <DviConsole>0x22222222</DviConsole>
        <DviConsole>0x33333333</DviConsole>
        <User>JohnDoe</User>
        <Password>secret</Password>
        <OTP>secret</OTP>
    </movedevice>
</root>
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Defining the leader workplace of a tradeswitch workplace

Within a tradeswitch workplace, you have to define a console module or DWC to 
which you want to connect a keyboard and a mouse. 

Use the command <setworkplacemasterconsole> to determine the leader workplace of a 
specific tradeswitch workplace.

The ID of the tradeswitch worksplace and the leader workplace as well as the access 
data of the user account are transferred as parameters.

IMPORTANT: To delete the assignment of the leader workstation, execute the 
command without the <DviConsole> or <DynamicWorkplace> parameter.

<Workplace> Tradeswitch workplace

<DviConsole>
<DynamicWorkplace>

compatible console module or
compatible DWC

<User> Name of the user account (has to be assigned with the required 
rights) to exevute the command

<Password> User password

<OTP> Optional parameter to transfer the one-time password

HOW TO DEFINE THE LEADER WORKPLACE
<?xml version="1.0" encoding="utf-8"?>
<root>
    <setworkplacemasterconsole>
        <Workplace>101</Workplace>
        <DviConsole>0x22222222</DviConsole>
        <User>JohnDoe</User>
        <Password>secret</Password>
        <OTP>secret</OTP>
    </setworkplacemasterconsole>
</root>

HOW TO DELETE THE ASSIGNMENT OF THE LEADER WORKPLACE
<?xml version="1.0" encoding="utf-8"?>
<root>
    <setworkplacemasterconsole>
        <Workplace>101</Workplace>
        <User>JohnDoe</User>
        <Password>secret</Password>
        <OTP>secret</OTP>
    </setworkplacemasterconsole>
</root>
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Showing messages

Use the command <showmessage> to send a message to a console module. Users at 
the console module can see the message on their OSD.

You can add an optional timeout (time in seconds). After the time elapses, the message 
closes automatically.

The following parameters are required to send commands:

<Type> Type of message (INFO, WARNING or ERROR)

<Text> Text of message to be shown

<Timeout> Time in seconds after which the message is closed automatically

<DviConsole> Console module, which shows the message

SHOWING A MESSAGE (WITH TIMEOUT)
<?xml version="1.0" encoding="utf-8"?>
<root>

<showmessage>
<Type>INFO</Type>
<Text>Message</Text>
<Timeout>5</Timeout>
<DviConsole>0x22222222</DviConsole>

</showmessage>
</root>
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Opening or closing the OSD

Use the commands <openmenu> and <closemenu> to open or close the OSD (Select 
menu) on a console module.

The following parameters are required to send commands:

<openmenu> Open OSD on a console module

<closemenu> Close OSD on a console module

OPEN OSD
<?xml version="1.0" encoding="utf-8"?>
<root>

<openmenu>
<DviConsole>0x22222222</DviConsole>

</openmenu>
</root>

CLOSE OSD
<?xml version="1.0" encoding="utf-8"?>
<root>

<closemenu>
<DviConsole>0x22222222</DviConsole>

</closemenu>
</root>
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Redirecting keyboard and mouse data

With the optional Tradeswitching function, you can use the command<redirect> to 
redirect a device’s in- and outputs to another device.

In the syntax, the target of the redirection is stated by a device-specific marker. The 
same applies to the source.

NOTE: Redirecting keyboard and mouse data to another console module, DWC or 
computer module requires the premium Tradeswitching function.

<DviConsole>
<DynamicWorkplace>

Console module or DWC (tag can be used for source and target)

<DviCpu> Computer module (tag can be used for target only)

NOTE: When connecting an analogue matrix switch via bridging, you can address 
its computer modules via <NeoCpu>.

REDIRECTING KEYBOARD AND MOUSE DATA
<?xml version="1.0" encoding="utf-8"?>
<root>

<redirect>
<DviConsole>0x22222222</DviConsole>
<DviCpu>0x33333333</DviCpu>

</redirect>
</root>
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Executing a script

You can use the command <executeScriptlet> to execute a script stored in the matrix 
switch.

The following parmeters are required to send the command:

<DviConsole>
<DwcConsole>

Console module or DWC channel that is used to trigger the script

<Name> Name of script

NOTE: The script can be executed only if a user with the required rights is logged 
on at the console module or the DWC.

EXECUTING A SCRIPT
<?xml version="1.0" encoding="utf-8"?>
<root>

<executeScriptlet>
<DviConsole>0x22222222</DviConsole>
<Name>MeinScriptlet</Name>

</executeScriptlet>
</root>
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Open a DWC window

You can use the command <openwindowdwc> to open a window at a DWC.

The following parameters are supported:

<DwcConsole> DWC channel to be displayed in a new transmission window

<FocusArea> FocusArea that is to be opened

<DynamicWork-
place>

DWC where a new window is to be opened

<Monitor> Monitor on which the new window is to be opened

ADVICE: The optional element <Monitor> allows you to open a window on a 
specific monitor.

OPEN A TRANSMISSION WINDOW
<?xml version="1.0" encoding="utf-8"?>
<root>

<openwindowdwc>
<DwcConsole>0x123</DwcConsole>
<Monitor>2</Monitor>

</openwindowdwc>
</root>

OPEN A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<openwindowdwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>
<Monitor>2</Monitor>

</openwindowdwc>
</root>
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Close a DWC window

You can use the command <closewindowdwc> to close a window at a DWC.

The following parameters are supported:

<DwcConsole> DWC channel whose transmission window is to be closed

<FocusArea> FocusArea that is to be closed

<DynamicWork-
place>

DWC at which a window is to be closed

CLOSE A TRANSMISSION WINDOW
<?xml version="1.0" encoding="utf-8"?>
<root>

<closewindowdwc>
<DwcConsole>0x123</DwcConsole>

</closewindowdwc>
</root>

CLOSE A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<closewindowdwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>2</FocusArea>

</closewindowdwc>
</root>
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Maximize a DWC window

You can use the command <maximizewindowdwc> to maximize a window at a DWC.

The following parameters are supported:

<DwcConsole> DWC channel whose window is to be maximized

<FocusArea> FocusArea that is to be maximized

<DynamicWork-
place>

DWC on which a window is to be maximized

<Monitor> Monitor on which a window is to be maximized

ADVICE: The optional element <Monitor> allows you to maximize a window on a 
specific monitor.

MAXIMIZE A TRANSMISSION WINDOW
<?xml version="1.0" encoding="utf-8"?>
<root>

<maximizewindowdwc>
<DwcConsole>0x123</DwcConsole>
<Monitor>2</Monitor>

</maximizewindowdwc>
</root>

MAXIMIZE A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<maximizewindowdwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>
<Monitor>2</Monitor>

</maximizewindowdwc>
</root>
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Resize a DWC window to the previous size after maximizing

You can use the command <unmaximizewindowdwc> to resize a window at a DWC to 
the previous size after maximizing.

The following parameters are supported:

<DwcConsole> DWC channel whose window is to be resized to the previous size

<FocusArea> FocusArea that is to be resized to the previous size

<DynamicWork-
place>

DWC on which a window is to be resized to the previous size

<Monitor> Monitor on which a window is to be resized to the previous size

ADVICE: The optional element <Monitor> allows you to resize a window on a 
specific monitor.

RESIZE A TRANSMISSION WINDOW
<?xml version="1.0" encoding="utf-8"?>
<root>

<unmaximizewindowdwc>
<DwcConsole>0x123</DwcConsole>
<Monitor>2</Monitor>

</unmmaximizewindowdwc>
</root>

RESIZE A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<unmaximizewindowdwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>
<Monitor>2</Monitor>

</unmaximizewindowdwc>
</root>
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Raise a DWC window to the top display layer

You can use the command <raisewindowdwc> to raise a window at a DWC to the 
top display layer.

The following parameters are supported:

<DwcConsole> DWC channel whose window is to be raised to the top display layer

<FocusArea> FocusArea that is to be raised to the top display layer

<DynamicWork-
place>

DWC on which a window is to be raised to the top display layer

RAISE A TRANSMISSION WINDOW TO THE TOP DISPLAY LAYER
<?xml version="1.0" encoding="utf-8"?>
<root>

<raisewindowdwc>
<DwcConsole>0x123</DwcConsole>

</raisewindowdwc>
</root>

RAISE A FOCUSAREA TO THE TOP DISPLAY LAYER
<?xml version="1.0" encoding="utf-8"?>
<root>

<raisewindowdwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</raisewindowdwc>
</root>
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Mirroring a DWC transmission window in a FocusArea

You can use the command <mirrorwindowdwc> to mirror a transmission window at a 
DWC in a FocusArea.

The following parameters are supported:

Empty a DWC FocusArea

You can use the command <unmirrorwindowdwc> to empty a FocusArea at a DWC.

The following parameters are supported:

<DwcConsole> DWC channel whose window is to be mirrored in a FocusArea

<FocusArea> FocusArea into which the transmission window is to be mirrored

MIRROR A TRANSMISSION WINDOW TO A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<mirrorwindowdwc>
<DwcConsole>0x123</DwcConsole>
<FocusArea>1</FocusArea>

</mirrorwindowdwc>
</root>

<DynamicWork-
place>

DWC at which a FocusArea is to be emptied

<FocusArea> FocusArea that is to be emptied

EMPTY A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<unmirrorwindowdwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</unmirrorwindowdwc>
</root>
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Execute a DWC preset

You can use the command <executepresetdwc> to execute a preset at a DWC.

The following parameters are supported:

Open a DWC layout composition

You can use the command <openlayoutcompositiondwc> to open a layout composition 
at a DWC.

The following parameters are supported:

<DynamicWork-
place>

DWC on which the preset is to be executed

<Name> Name of the preset to be executed

EXECUTE A PRESET
<?xml version="1.0" encoding="utf-8"?>
<root>

<executepresetdwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<Name>PresetTest</Name>

</executepresetdwc>
</root>

<DynamicWork-
place>

DWC on which the layout composition is to be opened

<Name> Name of the layout composition to be opened

OPEN A LAYOUT COMPOSITION
<?xml version="1.0" encoding="utf-8"?>
<root>

<openlayoutcompositiondwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<Name>LayoutCompositionTest</Name>

</openlayoutcompositiondwc>
</root>
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Assign exclusive signals to a DWC channel or a FocusArea

You can use the commands <getanalogaudiodwc>, <getembeddedgaudiodwc>, 
<getusbdwc>, <getgenusbdwc> and <getserialdwc> to assign exclusive signals to a 
DWC channel or a FocusArea.

The following parameters are supported:

<DwcConsole> DWC channel to which exclusive signals are to be assigned

<FocusArea> FocusArea to which exclusive signals are to be assigned

<DynamicWork-
place>

DWC to which exclusive are to be assigned to a FocusArea

ASSIGN EXCLUSIVE SIGNALS TO A DWC CHANNEL
<?xml version="1.0" encoding="utf-8"?>
<root>

<getanalogaudiodwc>
<DwcConsole>0x123</DwcConsole>

</getanalogaudiodwc>
<getembeddedaudiodwc>

<DwcConsole>0x123</DwcConsole>
</getembeddedaudiodwc>
<getusbdwc>

<DwcConsole>0x123</DwcConsole>
</getusbdwc>
<getgenusbdwc>

<DwcConsole>0x123</DwcConsole>
</getgenusbdwc>
<getserialdwc>

<DwcConsole>0x123</DwcConsole>
</getserialdwc>

</root>
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Deactivate exclusive signals of a DWC channel or a FocusArea

You can use the commands <dropanalogaudiodwc>, <dropembeddedgaudiodwc>, <dro-
pusbdwc>, <dropgenusbdwc> and <dropserialdwc> to deactivate exclusive signals for a 
DWC channel or a FocusArea.

The following parameters are supported:

ASSIGN EXCLUSIVE SIGNALS TO A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<getanalogaudiodwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</getanalogaudiodwc>
<getembeddedaudiodwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</getembeddedaudiodwc>
<getusbdwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</getusbdwc>
<getgenusbdwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</getgenusbdwc>
<getserialdwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</getserialdwc>
</root>

<DwcConsole> DWC channel on which exclusive signals are to be deactivated

<FocusArea> FocusArea for which exclusive signals are to be deactivated

<DynamicWork-
place>

DWC on which exclusive are to be deactivated for a FocusArea
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DEACTIVATE EXCLUSIVE SIGNALS FOR A DWC CHANNEL
<?xml version="1.0" encoding="utf-8"?>
<root>

<dropanalogaudiodwc>
<DwcConsole>0x123</DwcConsole>

</dropanalogaudiodwc>
<dropembeddedaudiodwc>

<DwcConsole>0x123</DwcConsole>
</dropembeddedaudiodwc>
<dropusbdwc>

<DwcConsole>0x123</DwcConsole>
</dropusbdwc>
<dropgenusbdwc>

<DwcConsole>0x123</DwcConsole>
</dropgenusbdwc>
<dropserialdwc>

<DwcConsole>0x123</DwcConsole>
</dropserialdwc>

</root>

DEACTIVATE EXCLUSIVE SIGNALS FOR A FOCUSAREA
<?xml version="1.0" encoding="utf-8"?>
<root>

<dropanalogaudiodwc>
<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</dropanalogaudiodwc>
<dropembeddedaudiodwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</dropembeddedaudiodwc>
<dropusbdwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</dropusbdwc>
<dropgenusbdwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</dropgenusbdwc>
<dropserialdwc>

<DynamicWorkplacee>0x123</DynamicWorkplace>
<FocusArea>1</FocusArea>

</dropserialdwc>
</root>
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Listing information about devices and connections

Use the command <list> to list information about devices and connections.

The parameters of the command define the type of information you want to list:

<DviMatrixSwitch> Data about matrix switches

<DviConsole> Data about console modules

<UsbDviConsole> Data about USB console modules

<MultiDviConsole> Data about virtual multi console modules

<DynamicWorkplace> Data about DWCs

<DviCpu> Data about computer modules

<VtCpu> Data about Remote-Targets

<UsbDviCpu> Data about USB computer modules

<MultiDviCpu> Data about virtual multi computer modules

<CcdmCard> Data about CCDM IO cards (for ControlCenter-Digital only)

<MatrixConnectionList> Connections between connected devices

<Workplace> Data about configured Tradeswitch workplaces

<Team> Data about channel groups

NOTE: When connecting an analogue matrix switch via bridging, you can address 
its computer modules via <NeoCpu>
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 List of information about matrix switches

REQUESTING DATA FROM MATRIX SWITCHES
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<DviMatrixSwitch/>

</list>
</root>

LIST OF INFORMATION ABOUT A MATRIX SWITCH
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<DviMatrixSwitch>

<item>
<id>0x11111111</id> <!-- ID -->
<cl>DviMatrix</cl> <!-- Geräteklasse -->
<type>ControlCenter-Compact 80</type> <!-- Variante -->
<name>Matrix1</name> <!-- Name -->
<poweredOn>true</poweredOn> <!-- Status der Stromversorgung -->
<pushGet>yes</pushGet> <!-- Push/Get-Funktion  aktiviert? -->
<tradeSwitching>yes</tradeSwitching> <!-- TradeSwitch-Funkt. aktiviert? -->
<ipSwitching>yes</ipSwitching> <!-- IP-Control-API freigeschaltet? -->
<gridModeCapable>yes</gridModeCapable> <!-- Matrix-Grid aktiviert? -->
<matrixGuard>yes</matrixGuard> <!-- MatrixGuard aktiviert? -->

</item>
</DviMatrixSwitch>

</result>
</root>
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 List of information about a console module

REQUESTING DATA FROM CONSOLE MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<DviConsole/>

</list>
</root>

LIST OF INFORMATION ABOUT CONSOLE MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<DviConsole>

<item>
<id>0x22222222</id> <!-- ID  -->
<cl>DviConsole</cl> <!-- Device class -->
<type>DVI-CON (2.0)</type> <!-- Variant -->
<name>CON1</name> <!-- Name  -->
<ownerId>0x11111111</ownerId> <!-- ID of connected device -->
<ownerCl>DviMatrix</ownerCl> <!-- Device class of connected device -->
<ownerPort>5.10</ownerPort> <!-- Port at connected device -->
<ownerNamet>CCDM 140</ownderName> <!-- Name of connected device  -->
<transmission>1</transmission> <!-- active channel -->
<enable>1</enable> <!-- Console module enabled? -->
<poweredOn>false</poweredOn> <!-- Status of power supply -->

</item>
</DviConsole>

</result>
</root>
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 List of information about a USB console module

REQUESTING DATA FROM USB CONSOLE MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<UsbDviConsole/>

</list>
</root>

LIST OF INFORMATION ABOUT USB CONSOLE MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<UsbDviConsole>

<item>
<id>0x00000133</id> <!-- ID  -->
<cl>UsbDviConsole</cl> <!-- Device class -->
<type>U2-CON</type> <!-- Variant -->
<name>U2-CON</name> <!-- Name  -->
<ownerId>0x11111111</ownerId> <!-- ID of connected device -->
<ownerCl>DviMatrix</ownerCl> <!-- Device class of connected device -->
<ownerPort>5.10</ownerPort> <!-- Port at connected device -->
<ownerNamet>CCDM 140</ownderName> <!-- Name of connected device  -->
<enable>1</enable> <!-- Console module enabled? -->
<poweredOn>false</poweredOn> <!-- Status of power supply -->

</item>
</UsbDviConsole>

</result>
</root>
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 List of information about a DWC

REQUESTING DATA FROM A DWC
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<DynamicWorkplace/>

</list>
</root>
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LIST OF INFORMATION ABOUT A DWC
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<DynamicWorkplace>

<item>
<id>0x22222222</id> <!-- ID  -->
<cl>DynamicWorkplace</cl> <!-- Device class -->
<type>DynamicWorkplace-Console-4C)</type><!-- Variant -->
<name>DWC-Main_1</name> <!-- Name  -->
<poweredOn>true</poweredOn> <!-- Status of power supply -->
<DwcConsole>

<transmission>1</transmission>
<id>0x00000012</id> <!-- ID  -->
<ownerId>0x00000670</ownderId> <!-- ID of connected device  -->
<ownerCl>DviMatrix</ownderCl> <!-- Device class of connected device -->
<ownerPort>1.10</ownderPort> <!-- Port at connected device -->
<ownerNamet>CCDM 140</ownderName><!-- Name of connected device  -->
<enable>1</enable> <!-- DWC channel enabled? -->

<\DwcConsole>
<DwcConsole>

<transmission>2</transmission>
<id>0x00000013</id> <!-- ID  -->
<ownerId>0x00000670</ownderId> <!-- ID of connected device  -->
<ownerCl>DviMatrix</ownderCl> <!-- Device class of connected device -->
<ownerPort>1.11</ownderPort> <!-- Port at connected device -->
<ownerNamet>CCDM 140</ownderName><!-- Name of connected device  -->
<enable>1</enable> <!-- DWC channel enabled? -->

<\DwcConsole>
<DwcConsole>

<transmission>3</transmission>
<id>0x00000014</id> <!-- ID  -->
<ownerId>0x00000670</ownderId> <!-- ID of connected device  -->
<ownerCl>DviMatrix</ownderCl> <!-- Device class of connected device  -->
<ownerPort>1.12</ownderPort> <!-- Port at connected device -->
<ownerNamet>CCDM 140</ownderName><!-- Name of connected device  -->
<enable>1</enable> <!-- DWC channel enabled? -->

<\DwcConsole>
<DwcConsole>

<transmission>4</transmission>
<id>0x00000015</id> <!-- ID  -->
<ownerId>0x00000670</ownderId> <!-- ID of connected device  -->
<ownerCl>DviMatrix</ownderCl> <!-- Device class of connected device  -->
<ownerPort>1.13</ownderPort> <!-- Port at connected device -->
<ownerNamet>CCDM 140</ownderName><!-- Name of connected device  -->
<enable>1</enable> <!-- DWC channel enabled? -->

<\DwcConsole>
</item>

</DynamicWorkplace>
</result>

</root>
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 List of information about a computer module

ADVICE: The optional sub-element <User> restricts the list of the computer 
modules to which the respective user has the right to connect with full access or 
view-only access.

REQUESTING DATA FROM COMPUTER MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<DviCpu>

<User>Admin<\User>
<\DviCpu>

</list>
</root>

LIST OF INFORMATION ABOUT COMPUTER MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<DviCpu>

<item>
<id>0x33333333</id> <!-- ID  -->
<cl>DviCpu</cl> <!-- Device class -->
<type>DVI-CPU (2.0)</type> <!-- Variante-->
<name>CPU1</name> <!-- Name  -->
<ownerId>0x11111111</ownerId> <!-- ID of connected device -->
<ownerCl>DviMatrix</ownerCl> <!-- Device class of connected device -->
<ownerPort>5.10</ownerPort> <!-- Port at connected device -->
<ownerName>CCDC64</ownerName> <!-- Name of connected device -->
<poweredOn>false</poweredOn> <!-- Status of power supply -->
<transmission>1</transmission> <!-- (last) used trans. port
<transmissionOnline>true</transmissionOnline> <!  Connection available?

</item>
</DviCpu>

</result>
</root>
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 List of information about a Remote-Target

REQUESTING DATA FROM REMOTE-TARGET
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<VtCpu>

<User>Admin<\User>
<\VtCpu>

</list>
</root>

LIST OF INFORMATION ABOUT REMOTE-TARGETS
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<VtCpu>

<item>
<id>0x0000016C</id> <!-- ID  -->
<cl>VtCpu</cl> <!-- Device class -->
<type>RemoteTarget</type> <!-- Variante-->
<name>CPU-ID 0000016C</name> <!-- Name  -->
<poweredOn>false</poweredOn> <!-- Status of power supply -->

</item>
</VtCpu>

</result>
</root>
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 List of information about a USB computer module

REQUESTING DATA FROM USB COMPUTER MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<UsbDviCpu>

<User>Admin<\User>
<\UsbDviCpu>

</list>
</root>

LIST OF INFORMATION ABOUT USB COMPUTER MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<UsbDviCpu>

<item>
<id>0x00000A6E</id> <!-- ID  -->
<cl>UsbDviCpu</cl> <!-- Device class -->
<type>U2-CPU</type> <!-- Variante-->
<name>U2-CPU 00000A6E</name> <!-- Name  -->
<ownerId>0x11111111</ownerId> <!-- ID of connected device -->
<ownerCl>DviMatrix</ownerCl> <!-- Device class of connected device -->
<ownerPort>160</ownerPort> <!-- Port at connected device -->
<ownerName>CCDM144</ownerName> <!-- Name of connected device -->
<poweredOn>false</poweredOn> <!-- Status of power supply -->

</item>
</UsbDviCpu>

</result>
</root>
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 List of connections between connected devices

ADVICE: You can restrict the list of connections to a specific console mdoule or 
computer module. To do this, e.g. use the <DviConsole> or <DviCpu> parameter.

REQUESTING CONNECTIONS BETWEEN CONNECTED DEVICES

<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<MatrixConnectionList/>

</list>
</root>

LIST OF CONNECTIONS BETWEEN CONNECTED DEVICES
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<MatrixConnectionList>

<item>
<cpuId>0x33333333</cpuId> <!-- CPU ID  -->
<cpuCl>DviCpu</cpuCl> <!-- CPU device class  -->
<cpuName>CPU1</cpuName> <!-- CPU name  -->
<cpuPoweredOn>false</cpuPoweredOn> <!-- CPU power supply  -->
<signalType>normal</signalType> <!-- Signal: normal | viewonly  -->
<consoleId>0x22222222</consoleId> <!-- CON ID  -->
<consoleCl>DviConsole</consoleCl> <!-- CON device class  -->
<consoleName>CON1</consoleName> <!-- CON name  -->
<connectionOwnerId>0x11111111</connectionOwnerId> <!-- Matrix ID  -->
<connectionOwnerCl>DviMatrix</connectionOwnerCl> <!-- Matrix class  -->
<connectionOwnerPort>1.11</connectionOwnerPort> <!-- Matrix port  -->
<consoleConfigEnable>1</consoleConfigEnable> <!-- CON enabled?  -->
<consolePoweredOn>true</consolePoweredOn> <!-- CON power supply  -->
<userName>JohnDoe</userName> <!--Username  -->
<userRealname>John Doe</userRealname> <!--Realname  -->

</item>
</MatrixConnectionList>

</result>
</root>
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 List of configured Tradeswitch workplaces

The output lists the members of a workplace within a <members> container.

REQUESTING DATA OF CONFIGURED TRADESWITCH WORKPLACES
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<Workplace/>

</list>
</root>

LIST OF CONFIGURED TRADESWITCH WORKPLACES
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<Workplace>

<item>
<id>0x88888888</id> <!-- Workplace ID -->
<name>Workplace1</name> <!-- Workplace name -->
<catcenterId>0x11111111</catcenterId> <!-- Matrix ID -->
<catcenterCl>DviMatrix</catcenterCl> <!-- Matrix class -->
<masterconsoleId>0x22222222</masterconsoleId> <!-- ID of leader console -->
<masterconsoleCl>DviConsole</masterconsoleCl> <!-- Class of leader console -->

<members>
<item>

<id>0x22222222</id> <!-- Member ID (CON  or CPU) -->
<cl>DviConsole</cl> <!-- Member class -->
<keys>1</keys> <!-- Member key  -->

</item>
<item>

<id>0x22222223</id>
<cl>DviConsole</cl>
<keys>2</keys>

</item>
<item>

<id>0x22222224</id>
<cl>DviConsole</cl>
<keys>3</keys>

</item>
<item>

<id>0x22222225</id>
<cl>DviConsole</cl>
<keys>4</keys>

</item>
</members>

</item>
</Workplace>

</result>
</root>
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 Requesting a list of configured channel groups

The list of configured port groups supports four different variants:

REQUESTING LIST OF ALL CHANNEL GROUPS

<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<Team/>

</list>
</root>

REQUESTING LIST OF ALL CHANNEL GROUPS WITH A CONSOLE MODULE AS MAIN 
CHANNEL
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<Team><DviConsole/></Team>

</list>
</root>

REQUESTING LIST OF ALL CHANNEL GROUPS WITH A PARTICULAR CONSOLE MODULE AS 
MAIN CHANNEL
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<Team><DviConsole>0x22222222</DviConsole></Team>

</list>
</root>

REQUESTING LIST OF ALL CHANNEL GROUPS WITH A PARTICULAR COMPUTER 
MODULE AS MAIN CHANNEL
<?xml version="1.0" encoding="utf-8"?>
<root>

<list>
<Team><DviCpu>0x33333333</DviCpu></Team>

</list>
</root>
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This is an exemplary response of the XML service:

Requesting monitoring values

The XML tag <monitor> is used to request monitoring values. As parameter, the 
<monitor> tag expects the class tag (e.g. <DviCpu>) of the device class for which you 
want to request monitoring values.

In addition to the class tag, you can also add the ID or name of the requested monitor-
ing value as shown in the example:

LIST OF CONFIGURED CHANNEL GROUPS
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="list">
<Team>

<item>
<leaderId>0x33333333</leaderId> <!-- Leading device of group -->
<leaderCl>DviCpu</leaderCl> <!-- Class of leading device -->
<members>

<item>
<id>0x33333334</id> <!-- ID of group member -->
<cl>DviCpu</cl> <!-- Class of group member -->
<slotType>KVM</slotType> <!-- Assigned channel type (KVM | USB) -->
<slot>0</slot> <!-- Number of channel -->

</item>
</members>

</item>
</Team>

</result>
</root>

NOTE: If several Members are listed with the same slot and slotType, they are part of a 
device pool.

REQUESTING ALL MONITORING VALUES OF ALL COMPUTER MODULES
<?xml version="1.0" encoding="utf-8"?>
<root>

<monitor>
<DviCpu />

</monitor>
</root>

REQUESTING ALL MONITORING VALUES OF COMPUTER MODULE 0X33333333

<?xml version="1.0" encoding="utf-8"?>
<root>

<monitor>
<DviCpu><id>0x33333333</id></DviCpu>

</monitor>
</root>
ControlCenter-Compact · 270



Controlling the matrix switch via XML
By stating the desired monitoring value, you can limit the list even further.

This is an exemplary response of the XML service:

You can list several device class tags within the XML tag <monitor>:

REQUESTING MONITORING VALUE »TEMPERATURE SWITCH« OF MATRIX SWITCH 
0X11111111
<?xml version="1.0" encoding="utf-8"?>
<root>

<monitor>
<DviMatrixSwitch>

<id>0x11111111</id>
<monitorName>Temperature switch</monitorName>

</DviMatrixSwitch>
</monitor>

</root>

LIST OF MONITORING VALUES OF MATRIX SWITCHES
<?xml version="1.0" encoding="utf-8"?>
<root>

<result type="monitor">
<DviMatrixSwitch>

<item>
<id>0x11111111</id>
<monitorName>Temperature switch</monitorName>
<value>35.0</value>
<alarm>off</alarm>
<acknowledged>no</acknowledged>

</item>
</DviMatrixSwitch>

</result>
</root>

NOTE: In addition to name and value of the respective monitoring value, the two 
flags acknowledged and alarm are always returned as well. With the alarm flags, you 
can check if the monitoring value lies inside (off) or outside (on) of its defined 
range. Acknowledged complies with the Viewed function of the web application.

REQUESTING MONITORING VALUES OF ALL COMPUTER MODULES, CONSOLE MODULES AND 
DWCS
<?xml version="1.0" encoding="utf-8"?>
<root>

<monitor>
<DviCpu />
<DviCon />
<DynamicWorkplace />

</monitor>
</root>
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Tradeswitch function (optional)

The Tradeswitch function optimises the operation of workplaces monitoring 
multiple computers over multiple modules and/or DWCs.

Instead of connecting keyboard and mouse to each console module and/or each 
DWC, the Tradeswitch function provides a central keyboard/mouse for all operating 
tasks of the workplace.

In order to enable this, several console modules and/or DWCs of a KVM matrix system 
are arranged into a group. Only one of the group’s modules is provided with keyboard 
and mouse.

By using a hotkey, users are now able to switch the two input devices to the monitors of 
the other console modules and/or display areas of the DWCs. This makes it possible to 
operate the connected computer modules and computers.

Computer modules can also be integrated into the tradeswitch group and the keyboard 
and mouse signals can be switched directly to them. This makes it possible, for example, 
to operate a laptop that has its own monitor.

IMPORTANT: Using the Tradeswitch function requires the purchase and activation 
of the premium TS-Function.
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Switching keyboard and mouse signals
The switching of the keyboard and mouse signals from a console module or a DWC 
to another console module, another DWC or a target computer is carried out by 
entering one of the configurable key combinations.

How to switch the keyboard and mouse signals: 

1. Press the Tradeswitch key modifier adjusted in the KVM matrix system and the 
Tradeswitch key assigned to the module.

Further information:
 Creating Tradeswitch workplaces on page 274
 Assigning devices to a Tradeswitch workplace on page 277
 Defining the leader workplace of the Tradeswitch workplace on page 278
 Changing the Tradeswitch key and the valid keys on page 275

EXAMPLE: 

 Tradeswitch key modifier: Ctrl+Shift
 Tradeswitch key of a computer module:T

Press Ctrl+Shift and the tradeswitch key t. When the keys are released, the key-
board and mouse signals are switched to the computer module.
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Basic configuration

Creating Tradeswitch workplaces

How to create a new Tradeswitch workplace:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Tradeswitch function entry and press Enter.

4. Press F3 and enter the name of the new workplace in the Add Workplace menu.

5. Press F2 to save your inputs and create the Tradeswitch workplace.

Renaming a Tradeswitch workplace

How to rename a Tradeswitch workplace:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Tradeswitch function entry and press Enter.

4. Select the Tradeswitch workplace you want to rename.

5. Press F5 and change the name in the Name entry.

6. Press F2 to save your settings.

IMPORTANT: The OSD described here is not available on a DynamicWorkplace-CON
(DWC). A DWC is operated via the WindowManager of the respective DWC. 
Further information on operation can be found in the DWC manuals. Informa-
tion on the corresponding configuration options can be found in the separate man-
ual for the web application. Alternatively, you can also use the OSD of an 
additional console module.
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Deleting a Tradeswitch workplace

How to delete a Tradeswitch workplace:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Tradeswitch function entry and press Enter.

4. Select the Tradeswitch workplace you want to delete and press F4.

5. Use the arrow keys to select Yes and press Enter to respond to the prompt for 
confirmation.

Changing the Tradeswitch key and the valid keys

The Tradeswitch keys enable you to switch the keyboard and mouse signals from one 
console module or DWC to another console module, another DWC or to a computer 
module by pressing a key combination.

In the Tradeswitch function section of the Configuration menu, several console modules, 
DWCs and/or computer modules can be grouped to a workplace. You can also 
define the keys to be pressed for switching the keyboard and mouse signals to a 
particular console module, a particular DWC or a particular computer module.

In addition to the Tradeswitch key modifier, you can also define the valid keys for 
the Tradeswitch keys.

How to change the Tradeswitch key modifier or the valid keys:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the Tradeswitch key entry and press Enter.

5. Select at least one of the listed select key modifiers in the Modifier entry by marking 
the respective box using the arrow keys. Press F8.

Ctrl: Ctrl key

Alt: Alt key

Alt Gr: Alt Gr key

Win: Windows key

Shift Shift key
275 · ControlCenter-Compact



Tradeswitch function (optional)
6. Select the Valid keys entry and press F8 to select one of the following options:

7. Press F2 to save your settings.

Num: only numerical keys are interpreted as select keys when pressed in 
combination with the select key modifier

Alph: only alphabetic keys are interpreted as select keys when pressed in 
combination with the select key modifier

AlphNum: alphabetical and numerical keys are interpreted as select keys when 
pressed in combination with the select key modifier

IMPORTANT: Both the selected keymode and the selected tradeswitch key mod-
ifier(s) are no longer provided as key combinations to the operating system and 
the applications on the computer.
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Tradeswitch function (optional)
Detailed configuration of a Tradeswitch workplace

Assigning devices to a Tradeswitch workplace

How to assign console modules, DWCs and computer modules to the Trade-
switch workplace:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Tradeswitch function entry and press Enter.

4. Press F5 to edit the selected Tradeswitch workplace.

5. Select the Members entry and press Enter.

6. The Assign Tradeswitch Function menu opens. The left-hand column displays the 
console modules, DWCs or computer modules names. The middle column 
provides the assigned Tradeswitch key(s).

7. Select the console module, DWC or the computer module to assign a Trade-
switch key to or whose Tradeswitch key you want to change.

8. Press F5 and enter the desired Tradeswitch key.

9. Repeat steps 7 and 8 to create or change the Tradeswitch keys.

10.Press F2 to save your settings.

ADVICE: Giving self-explanatory names refering to the function or the location of 
the device facilitates configuring the Tradeswitch workplace.

Detailed information on renaming the console modules is provided on page 140, 
detailed information on renaming the DWCs is provided on page page 162 and 
detailed information on renaming the computer modules is provided on page 112.

ADVICE: The view filter (see page 21) can be used to either display the console 
modules, DWCs or the computer modules in the list.

ADVICE: Use the menu’s search function or the sort criteria (see page 20 ff.) to limit 
the selection of list entries.
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Tradeswitch function (optional)
Defining the leader workplace of the Tradeswitch workplace

Define a console module or DWC within the Tradeswitch workplace to which 
keyboard and mouse are connected to. 

How to define a leader workplace of the Tradeswitch workplace:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Tradeswitch function entry and press Enter.

4. Select the Tradeswitch workplace whose leader workplace you want to change 
and press F5.

5. Select the Members entry and press Enter.

6. Select the desired leader workplace and press F8.

7. Press F2 to save your settings.

ADVICE: Giving self-explanatory names refering to the function or the location of 
the device facilitates configuring the Tradeswitch workplace.

Detailed information on renaming the console modules is provided on page 140 and 
detailed information on renaming the DWCs is provided on page page 162.

ADVICE: The view filter (see page 21) can be used to either display the console 
modules or DWCs in the list.

NOTE: The active leader workplace is marked with an arrow ().
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Defining FreeSeating members

Define the console modules and DWCs within the Tradeswitch workplace to be 
included when restoring the FreeSeating session (see page 48).

How to define the FreeSeating members of the Tradeswitch workplace:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Tradeswitch function entry and press Enter.

4. Select the Tradeswitch workplace whose settings you want to change and  
press F5.

5. Select the Members entry and press Enter.

6. Select the desired workplace and press F9.

7. Press F2 to save your settings.

ADVICE: The view filter (see page 21) can be used to either display the console 
modules or DWCs in the list.

NOTE: The FreeSeating members are marked with FS.
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Tradeswitch function (optional)
Enhanced functions

(De)activate Tradeswitch frame for a console module

If you purchased the Tradeswitch function, the messages »Forwarding to...« (on the 
Tradeswitch leader) or »FORWARDED« (on the target workplace) can be displayed 
at the monitor of a console module (see (De)activating the Tradeswitch information on 
page 284).

Additionally or alternatively you can activate a frame that permanently or temporarily 
marks the monitor of the module connected via tradeswitch function.

How to (de)activate the Tradeswitch frame for a console module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to (de)activate and press F5.

5. Select the Tradeswitch frame entry and press F8 to select one of the following 
options:

6. Press F2 to save your settings.

off: no Tradeswitch frame

temp: A frame temporarily marks the monitor of the module connected via 
tradeswitch function.

perm: A frame permanently marks the monitor of the module connected 
via tradeswitch function.
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Configure Tradeswitch visualization for a DWC

If you purchased the Tradeswitch function, you can activate a frame that permanently or 
temporarily marks the window of the module connected via tradeswitch function.

How to (de)activate the Tradeswitch frame for a DWC:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the DynamicWorkplace-CONs (DWC) entry and press Enter.

4. Select the DWC you want to (de)activate and press F5.

5. Select the Tradeswitch frame entry and press F8 to select one of the following 
options:

6. Press F2 to save your settings.

IMPORTANT: This function only sets a window frame for active windows if key-
board/mouse operation can take place within a TradeSwitch workplace at the 
DWC.

off: no Tradeswitch frame

temp: A frame temporarily marks the window of the module connected via 
tradeswitch function.

perm: A frame permanently marks the window of the module connected 
via tradeswitch function.
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Customizing the appearance of the tradeswitch frame

You can set the display duration of the tradeswitch frame as well as its appearance 
(color settings, transparency effect and frame width) system-wide.

Each user of the matrix system can use his or her personal profile to change the sys-
tem-wide default by making an individual adjustment.

How to change the system-wide appearance of the tradeswitch frame:

1. Press the hotkey Ctrl+Num (default) to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select System and press Enter.

4. Customize the settings to suit your needs in the respective entries:

5. Press F2 to save your settings.

IMPORTANT: Settings of brightness, transparency effect and frame width have no 
effect at a DWC.

TS frame time (s): Set the temporary display duration of the tradeswitch 
frame between 0.0 (off) and 10.0 seconds.

TS frame color: Select the brightness and colour of the tradeswitch frame.

TS frame transparency: Select the transparency effect (normal or high) of the 
Tradeswitch frame.

TS frame width: Select the frame width (normal to quadruple) of the Trade-
switch frame.
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How to change the appearance of the tradeswitch frame for a specific user account:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the User entry and press Enter.

4. Select the user account you want to rename and press F5.

5. Select Personal Profile and press the Enter key.

6. Select the TS frame settings and press the F8 key (repeatedly) to apply the system set-
ting (see above) or to make your own setting (step 7).

7. Enter the following data when activating your own setting:

8. Press F2 to save your settings.

IMPORTANT: Settings of brightness, transparency effect and frame width have no 
effect at a DWC.

TS frame time (s): Set the temporary display duration of the tradeswitch 
frame between 0.0 (off) and 10.0 seconds.

TS frame color: Select the brightness and colour of the tradeswitch frame.

TS frame transparency: Select the transparency effect (normal or high) of the 
Tradeswitch frame.

TS frame width: Select the frame width (normal to quadruple) of the Trade-
switch frame.
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Tradeswitch function (optional)
(De)activating the Tradeswitch information

If you purchased the additional Tradeswitch function, the messages »Forwarding to...« (at 
the leader workplace) or »FORWARDED« (at the target workplace) can be displayed 
at the monitor of a console module.

How to (de)activate the Tradeswitch information:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Console entry and press Enter.

4. Select the console module you want to (de)activate and press F5.

5. Select the Tradeswitch information entry and press F8 to select one of the following 
options:

6. Press F2 to save your settings.

IMPORTANT: This information is not available at a DWC.

yes: activated Tradeswitch information

no: deactivated Tradeswitch information
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CDS mouse positioning

When moving the mouse cursor to an edge of the active monitor or the active DWC 
window with a second monitor or a second DWC window placed next to the active 
monitor or DWC window, the mouse cursor remains at the position at which the 
switching to the module of the second monitor or second DWC window takes 
place.

In addition, when leaving the monitor or DWC window, the matrix switch can 
position the mouse cursor so that it is barely visible. For this, you can use the set-
tings Right and Bottom.

You can define this setting for the entire system. By default, all CDS modules use the 
system-wide setting. However, you can also individually define the mouse position for 
each CDS module.

How to change the system setting of the mouse position:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Select the CDS mouse positioning entry and press F8 to select one of the following 
options:

NOTE: When using CDS for switching, a mouse cursor may be visible on several 
monitors or DWC windows.

off: The mouse cursor remains at the position at which the switching 
to the module of the next monitor or next DWC window takes 
place (default).

on: According to the CDS mouse hideout setting the mouse cursor is 
positioned so that it is barely visible.

Only during multi-user access, the cursor remains at the position at 
which the switching to the next monitor or next DWC window 
takes place.

on+Multi: According to the CDS mouse hideout setting, even during multi-user 
access, the mouse cursor is positioned so that it is barely visible.

ADVICE: You can activate or deactivate this function for particular modules 
independently from the selected system setting (see below).
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5. If the CDS mouse positioning is enabled, select one of the options under CDS mouse 
hideout:

6. Press F2 to save your settings.

7. Press F2 to save your settings.

How to change the mouse position of a particular computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module you want to configure and press F5.

5. Select the CDS mouse positioning entry and press F8 to select one of the following 
options:

right: The mouse cursor is placed on the right edge of the monitor or 
DWC window so that it is barely visible.

bottom: The mouse cursor is placed on the bottom edge of the monitor or 
DWC window so that it is barely visible.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

System: Use systemwide (see above) setting (default).

Off: The mouse cursor remains at the position at which the switching 
to the module of the next monitor or next DWC window takes 
place.

On: According to the CDS mouse hideout setting the mouse cursor is 
positioned so that it is barely visible.

Only during multi-user access, the cursor remains at the position at 
which the switching to the next monitor or next DWC window 
takes place.

On+Multi: According to the CDS mouse hideout setting, even during multi-user 
access, the mouse cursor is positioned so that it is barely visible.
ControlCenter-Compact · 286



Tradeswitch function (optional)
6. When the CDS mouse positioning is enabled, select one of the options under CDS mouse 
hideout:

7. Press F2 to save your settings.

Adjusting the mouse speed

If CrossDisplay-Switching is enabled, the mouse speed is not controlled by the operating 
system of the computer, but by the matrix switch.

If the cursor moves too fast or too slow, you can adjust the speed in the matrix 
switch.

You can adjust the mouse speed for the entire system or for one computer module 
only.

How to change the system settings of the mouse speed:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the System entry and press Enter.

4. Use the Mouse speed entry and press F8 to choose a setting.

5. Press F2 to save your settings.

Right: The mouse cursor is placed on the right edge of the monitor or 
DWC window so that it is barely visible.

Bottom: The mouse cursor is placed on the bottom edge of the monitor or 
DWC window so that it is barely visible.

NOTE: You can enable or disable the function individually for specific modules 
regardless of the selected system setting (see below).
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Tradeswitch function (optional)
How to change the mouse speed of a specific computer module:

1. Press the Ctrl+Num (default) hotkey to open the OSD.

2. Press F11 to call the Configuration menu.

3. Select the Computer modules entry and press Enter.

4. Select the computer module you want to configure and press F5.

5. Use the Mouse speed entry and press F8 to choose between the following options:

6. Press F2 to save your settings.

ADVICE: Use the menu’s search function, the view filter or the sort criteria (see 
page 20 ff.) to limit the selection of list entries.

System: Apply the system mouse speed setting for the computer 
module

[value]: Use individual mouse speed (level 1 to 10).
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Messages
In some cases CrossDisplay-Switching cannot be used.

In such cases, a message is displayed on the monitor of the console module. The 
messages have the following meaning:

Message Meaning

No CDS: Globally disabled No CDS possible as the function is deactivated for the 
entire system (for detailed information, please refer to 
the separate manual of the web application).

No CDS: Disabled No CDS possible as the computer module uses relative 
mouse coordinates (for detailed information, please refer 
to the separate manual of the web application).

No CDS: No Tradeswitch modifier No CDS possible because no tradeswitch key modifier (see 
How to change the Tradeswitch key modifier or the valid 
keys: on page 275) has been configured.

No CDS: Computer module not found No CDS possible because the computer module was not 
found.

No CDS: Computer module multiuser 
mode

No CDS possible as a user is already connected to the 
computer module and this does not support MultiAccess 
(see Access mode when simultaneously accessing a com-
puter module on page 106).

No CDS: Computer module not  
supported

No CDS possible as the computer module does not support 
switching via CDS.

Contact our support team for more information.

No CDS: Console not found No CDS possible because the console module does not 
exist in the matrix switch database (anymore).

No CDS: Console MultiAccess mode No CDS possible because the console module is included 
in several Workplaces (Tradeswitch configurations) and 
does not support multiuser CDS.

No CDS: Unknown error No CDS possible.

Contact our support team for more information.
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Possible messages and their meanings
There are various messages that can appear on the monitor of the console module in 
certain cases. You have the option of adjusting or deactivating these information 
displays (see Adjusting the information display on page 27 ff.).

Below you find a selection of possible messages and their meanings:

Message Meaning

Forwarding to ... The console module is the leader workplace of the Trade-
switch workplace (see Defining the leader workplace of the 
Tradeswitch workplace on page 278). This message 
appears when the input devices are switched to another 
console module or DWC.

You can switch this message off if you want (see (De)acti-
vating the Tradeswitch information on page 284).

FORWARDED The console module is a target workplace of the Trade-
switch workplace. This message appears when the input 
devices are switched from the leader workplace to this 
console module.

You can switch this message off if you want (see (De)acti-
vating the Tradeswitch information on page 284).

No CDS: Globally disabled No CDS possible as the function is deactivated for the 
entire system (for detailed information, please refer to 
the separate manual of the web application).

No CDS: Disabled No CDS possible as the computer module uses relative 
mouse coordinates (for detailed information, please refer 
to the separate manual of the web application).

No CDS: No Tradeswitch modifier No CDS possible because no tradeswitch key modifier (see 
How to change the Tradeswitch key modifier or the valid 
keys: on page 275) has been configured.

No CDS: Computer module not found No CDS possible because the computer module was not 
found.

No CDS: Computer module multiuser 
mode

No CDS possible as a user is already connected to the 
computer module and this does not support MultiAccess 
(see Access mode when simultaneously accessing a com-
puter module on page 106).

No CDS: Computer module not  
supported

No CDS possible as the computer module does not support 
switching via CDS.

Contact our support team for more information.

No CDS: Console not found No CDS possible because the console module does not 
exist in the matrix switch database (anymore).

No CDS: Console MultiAccess mode No CDS possible because the console module is included 
in several Workplaces (Tradeswitch configurations) and 
does not support multiuser CDS.

No CDS: Unknown error No CDS possible.

Contact our support team for more information.
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Not connected The console module is not connected to any computer 
module (see Accessing computer modules 
(basic functions) on page 41 ff.).

Computer module not available The console module should be connected to a computer 
module. However, this computer module is not available 
in the system.

No user logged in The console module should be connected to a computer 
module. However, no user is logged on (see User login at 
the matrix system on page 3 ff.).

Insufficient access rights The console module should be connected to a computer 
module. However, the user rights do not allow this (see 
Adjusting the access and config rights on page 103 ff.).

No MultiAccess right The console module should be connected to a computer 
module. However, another user is already connected and 
the user does not have MultiAccess rights (see Access 
mode when simultaneously accessing a computer module on 
page 106 ff.).

Unknown route to computer module The console module should be connected to a computer 
module. However, the matrix switch does not know where 
the computer module is connected (see Unknown route to 
computer module on page 49).

No route to computer module available The console module should be connected to a computer 
module. The matrix switch knows how to reach the com-
puter module. However, there is no free line via which the 
computer module can be reached (see No route to com-
puter module available on page 49).

Connection failed The console module should be connected to a computer 
module. However, the router was unable to fulfill its task.

VIEW ONLY Operation of the connected computer module is disabled 
(see Adjusting the access and config rights on 
page 103 ff.).

You can switch this message off if you want (see How to 
change the general settings of the information display for 
computer modules with view right: on page 27).

MULTIUSER If several users are connected to a computer module, the 
number of connected users is displayed.

You can switch this message off if you want (see Display-
ing Multiuser information on page 122).

AUTOSCAN The computer module uses the autoscan function (see 
Auto scanning all computer modules (Autoscan) on 
page 71 ff.).

AUTOSKIP The computer module uses the autoskip function (see 
Auto scanning all active computer modules (Autoskip) on 
page 72 ff.).

STEPSCAN The console module uses the stepscan function and the 
keys to scan the computer modules manually are active 
(see Scanning the computer modules manually (Stepscan) 
on page 74 ff.).

Message Meaning
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Possible messages and their meanings
HDCP content suppressed The connected computer module has detected HDCP-
protected image data that may not be displayed.

Frozen for ... When using freeze mode, the image last received is either 
highlighted by a coloured frame and/or the note Frozen 
and the time past since the loss of connection (see Freeze 
mode on page 197 ff.)

Please reconnect A disconnection has been detected. Check the cables.

Communication was interrupted
Auto-switched to channel ...

A CON-2 console module was automatically switched to 
the specified channel due to a connection failure (see 
Channel auto-switching for CON-2 console modules on 
page 153 ff.).

Stream CPU ... Index of the displayed video stream when switching of the 
video stream (when connected to a DH computer module)

Illegal format Problem with video parameters: Incorrect data format

Pixel clock too high Problem with video parameters: Pixel clock higher than 
supported by the current console module

Resolution too high Problem with video parameters: Image width or image 
hight greater than supported by the current console 
module

Pixel clock too low Problem with video parameters: Pixel clock below the 
minimum clock rate

Resolution too low Problem with video parameters: Image width or image 
height less than required for output

Invalid parameter Problem with video parameters: Image parameters 
inconsistent or incorrect

Message Meaning
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